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DIGITAL PASSION

Createlnstall Free 4.9_
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This software connects to all major
databases and eases SQL editing and
database structure design for a fraction
of the cost of single-database solutions

BrowserBob 4.1.2

Combine the best of desktop and online
world! Create smart applications with
the power of desktop programs and the
usability of a website with ease

Report Sharp-Shooter
Express 2.1

It allows you to create complex
parameterized and side-hy-side
reports, reports with unlimited number
of master-detail relations, columns, etc.
It is possible to design a large number
of reports with the unified layout in
minutes

Banshee

music using Banshee's simple, powerful
interface. Rip CDs, play and sync your
iPod, create playlists, and burn audio
and MP3 CDs

DEVELOPER TOOLS
= DBF Viewer 1.5

= Dev-Pascal 1.9.2

= SWF To Image 1.28

= XMLFox XML/XSD Editor 2.01
= Guiffy 8 build 214

= QF-Test

LINUX
= ArgoUML 0.24

= BitTorrent

= CDRecord (cdrtools) 2.0
= File Ripper 1.0.1

= LimeWire 4.12

= Partition Image

= Showlmg 0.9.4-1

= VLC Media Player
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= SurgeMail Mail Server 38f3

port, organize, play, and share your ‘

DIGITAL TOOLS

VirusBuster
Professional

This software provides
comprehensive virus
protection for every
workstation

React0S 0.3.1

This is an advanced free
open source operating
system providing a ground
up implementation of a
Microsoft Windows XP
compatible 0S

stellarium 0.8.2

stellariumo.s.2

This is a free open source planetarium
for your computer. It shows a realistic
sky in 3D, just like what you see with the
naked eye, binoculars or a telescope

MULTIMEDIA
= Apophysis 2.02
= Foobar 2000 0.9.4.2

= HandBrake

= Juice

= MediaCoder Full Pack 0.6.0-pre9a
= musikCube

= Paint.NET

= XPize 4.6 Final

= Image Assistant

INTERNET

= BadBlue Personal Edition
= Cabos

= Direct Connect

= Email Extractor 2.57

= Gnucleus

= LanDiscovery

= |E Translator 2.2

» X-Chat 2

SYSTEM
= Norton Antivirus Update

= A-PDF Size Splitter

= ExamDiff Pro

= File Security Manager 1.8.1.98
= Open File Manager

= Quick Starter 3.1

= SpeedUpMyPC 3.0

RSS READERS

FeedReader3

= Alertbear v1.10

= Feedreader

= GreatNews 1.0 Beta (Build 381)
= Internet Explorer 7

= KlipFolio

= Mozilla Firefox 2.0.0.3

= Mozilla Thunderbird

= RSS Bandit

Contents Interactive
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EasyResumeCreatorire

With Easy Resume Creator Pro, you can
find, track and apply for position tasks
in seconds, without having to jump
through hoops. You can even follow up
on the application effectively and
efficiently

Dia 0.95

This software can be used to draw
many different kinds of diagrams. It
currently has special objects to help
draw entity relationship diagrams, UML
diagrams, flow charts, network
diagrams, and simple circuits

emoze 1.3

~(@

With emoze receive your emails and
Outlook data anywhere, anytime;
Handle your schedule and meetings via
your mobile device; Enjoy synchronized
Personal Information Management
(PIM); Access information about your
Contacts, anywhere, anytime

Smaato Cost 2.07

L AEIRY

This mobile application allows in-depth
tracking of your accumulated minutes,
your transferred data volume and sent
& received SMS

PRODUCTIVITY TOOLS
= AM-Notebook

= Documentor

= Ganttproject

= Nmap

= Tustena CRM 0S 3.0.2
= AcroPDF 2.00

= DameWare NT Utilities
= WinAudit

MOBILE APPS
= Bubble Shooter

= Videora iPod Converter

= AutoLock v1.0 for S60 3rd edition
= Best Screen Snap

= Hotspot Finder

= Smaato News

= RemoteControl Il 2.12

= Novii Remote Infrared Codes 1.1

Merry Motors

The games and exercises of the Merry
Motors collection help to develop
memory, attention, basic motor skills,
spatial imagination and logical reasoning

Paparazzi

Use your eyes and quick reflexes to
capture photos of strange subjects and
sell them to humorous tabloid
newspapers for valuable cash. Join the
Paparazzi!

Fizzball

Bounce bubbles, rescue and feed the
abandoned animals, and solve a
mystery—all at the same time, in
FizzBall!

SMALL GAMES

= Bug On A Wire
= Crypt Raider
= Zombies 1.0.1
= Blox Forever

mP3
Rhyn: Home Recording Made Easy

K HYN frad

fing Made Easy

01 - Compatibility Test Intro

02 - Nothing In Particular

03 - Skies

04 - Wishing The World Away

05 - Break The Seal

06 - The Only Place

07 - 4-5-6, Go!

08 - Waiting At The Window

09 - Radiotherapy

10 - Dream

11 - Amorphous

12 - Rain Dancer The Calm

13 - Desert Monsoon The Storm

14 - Break The Seal 2004 Bonus Track
15 - Nathan Loves Dan Bonus Track

For any queries regarding the CD or DVD, e-mail help@jasubhai.com with “CD/DVD” as the subject.

If the subject is not mentioned, your mail might not reach the right person.
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By Demand

You get to choose what goes

on Digit Interactive. This
month, you chose:

Far Cry Cumulative

Pack 1.4 FREE
Size: 180 MB

MediaPortal 0.2.2.0 FREE

Size: 30 MB

Whom Do
You Want To

This Month’s Question

1 have an LCD monitor for my PC
O1 have an LCD TV

Subscribe

No more snail-mail! No
need to visit post offices!
All you have to do is log 1K ;
on to www.thinkdigit. 1 HEH
com/subscribe and use
your Credit Card to make
sure you never miss
another issue of your
favourite magazine!

1 have an HDTV

Have you bought an LCD yet?
1 don’t have one, but I plan to buy soon

times and felt guilty

ﬂﬁll.34% I’m not quite-sure how to

download movies and music

To vote Log on to www.thinkdigit.com

Last Month's Question what best describes yourfile-sharing activities?

| 64% A BitTorrenticlient
is in'my startup! No:guilt!

[
20.22% | download a little,.
and I don't feel I’'m doing m

ch.harm

4.44% 1've done it'a couple of

Total: 4811

taste technology at WWW.th i N kd igit.co m

FEATURED TUTORIAL FROM DIGIT FORUM (www.thinkdigit.com/forum)

This month, we feature a member tutorial from the forum here.

ek bere b0 @ badk ba

think[{ /1! .com

Torrenting For Dummies

21-04-2007,
11:30 PM

rakeshishere
SOFTWARE
GUIDE

In The Zone

Join Date:
Jun 2006
Location:
karnataka,
Bangalore
Posts: 882

On Lots of Requests of queries from
different members on Torrents and on
special request by aryayush I have
made this thread from various
sources around the web..Will update
this as fast as possible..I have typed
most of stuff in here and will add
more to this in the meantime

Bittorrent Basics

Firstly get a good client such as utor-
rent or Azureus.Other Clients are not
recommended!

The client handles the torrent
file you download from a tracker.
There are a number of sites where
you can find torrent files. You can
even find them using google, or
read around in forums.

The torrent file is not the file you
aim to download, but a tool in order
to begin downloading it keeps you in

touch with a tracker which sorts out
which users are sitting on which
piece. Seebittorrent sends small bits
randomly between users, who in
turn sends small bits to other users.
Have you ever seen a champagne
pyramid? Principally the sameone
glass gets filled, and that glass in
turn fills up the next glass, which in
turn fills the next, and so on.
Trickling down, filling all glasses.
Bittorrent isn’t linear though, that
that example might implyit random-
ly sends and receives pieces from
random users connected via the
same torrent file.

Terminology

Leecher - that’s the guys that don’t
have the complete file. Observe that
the leecher still is a part of the
process and uploads at the same time

he/she’s downloading. It might do
you good to know that the more you
participate in the uploading process,
the faster you will get the whole file.
Try not to quench the upload speeds
too much, it will pay off for you.

Seeder - those that now have the
entire file, 100%, and therefore only
function to upload to those that
haven’t got the whole thing yet.

Peers - all users connected to
the same torrent. The more peers,
the greater the speeds, providing
there are enough seeders. If there
are thousands of peers and only
one seed, you will have to exercise
some patience.

For the rest of this, and more
tutorials, visit:

http:/ /www.thinkdigit.com/
forum/showthread.php?t=55842




Froogle is gone

Google has rechristened Froogle to “Google Product
Search”. Froogle.com now points to www.google.com/
products, and it looks like they’re putting in a bigger effort to make this for
products what Google is to Web search. It’s still completely US-biased, but it
still serves as a good price indicator for stuff you want to buy.

Froogle

Feisty Fawn Released

Ubuntu’s latest version, Feisty Fawn, was released last
month. So many users were downloading, it was akin to all
of Ubuntu’s 160 mirrors being DDoS-ed. Hooray for the
Torrent network though—some caring souls sat, downloaded
it at pathetic speeds, and then promptly seeded it for us.

Abhijeet sawant WORLD DOMINATION
Singer °
oamer, | MiCrosoft Targets The Poor
winning the Indian Idol
contest. He soon
released his first album, o, this is not another ~ price tag for Windows XP And this is supplemented by
8G Aapka Abhijeet Nanti-piracy story, so Starter Edition, Microsoft the provision that the
(o\f. Eg* Sawant, which stop smirking! Office Home and Student governments have to pay at
Y 4 became a hit. Recently, Microsoft 2007, Microsoft Math 3.0, least 50 per cent of the price
* < Then on, executives were all abuzz Learning Essentials 2.0 for of the PC that MSIS is
E ? "I.“.- there has about their latest plan to MS Office and Windows Live  bundled with. Since this is
wi\ o r e target the 5 billion users targeted at the
& U~ N . who aren’t already using underprivileged,
&&) L ,g)f” tu il back PCs. With a global Microsoft even accepts
D X 3 for the singer. population of over six the purchase of
Technology to you is... billion people, Microsoft refurbished PCs as
An important aspect of life. | is appalled that only eligible for MSIS.
am a singer, and it is used under a billion use its In terms of India,
extensively in my field. products—including this means that our
Thanks to technology, pirated software users. In government now has the
editing, mixing, and retakes a bid to make this a more power to provide students
can be done in a very short Microsoft-dependent and underprivileged
period of time. Technology world (and thus, World families with PCs for half
has now hecome the fourth Domination), the the hardware price and
element of life! company is looking to just $3 for the software.
make deals with Now if only we had plans
What gadgets do you use? governments to provide for such a project in
| have a wonderful audio cheaper versions of its place, we could really
system, an Xbox, a Nokia popular software for see a spurt in the
N73, a Sony handycam, a 7- students and the under- amount of PC users in
megapixel Sony Cybershot, privileged. India. It would also
and a Sony Vaio notebook. When you think help cut down the
What would your dream about it, of all the software amount of pirated
gadget be? that Microsoft makes, two Mail Desktop? Unbelievable?  versions of Microsoft
I wish | had a bike or scooter really stand out: the world’s Believe it! Termed the software being used in India.
that could fly... most popular OS, Windows Student Innovation Suite, So what’s in it for
What do you mostly do XP, and the wgrld’s most Gates unv'eiled Microsqft’s Microsoft? Well, Miq‘osoft
online? useFl ofﬁce. suite, Microsoft pla'ns c!urm'g a sp_eech in does do a lot of_charlty
| check.my mail. hunt for Office. While most of us China in mld-Ap_rll. wo.rk., as dpes Bill GaFe§, and
=] T WeI; sites privileged users might have to  Although the Ml.crosof't this is theuj way of giving
<ocialise on Orkut ana spenq several months’ Studeny Innovation Suite bgck to society. O_K fine, we
check for games o’nline if salaries to afford these. (MSIS) is meant for students, d1dr}’t buy that either. It’s
T ma | d. to sgftwarg, therg are entire it doesn’t apply only to OI?V}ous that one more
fan mail ’ villages in India that simply ~ schools and colleges— billion people depending on
: cannot affored them. The students can use this at Microsoft products will
Any instance where world (a lot of Digit readers home, and Microsoft knows result in a lot more business
technology has really included) has been crying that the entire family will sales because employees are
helped you? out for Microsoft to consider  probably use the same PC. already versed with
A year ago, my friend met that their software costs as So is Microsoft selling all ~ Microsoft. However, one
with an accident at 3 AM. much as five times the these great products for $3 can’t blame Microsoft, it is
Thanks to the mobile, we hardware that it runs on, to everyone? Not on your life, after all a company that has
were able to reach a helpline. and it seems Bill Gates as always, there’s a catch. to do business. For
As | said earlier, technology finally listened. Remember, the software is underprivileged Indian end-
has now become a part of us. The offer? How does $3 (a  being sold to governments, users, however, it’s a win-
We cannot ignore it. mere Rs 135) sound as a not the students themselves. ~ win situation.
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Security Watch

More Windows Woes

The Problem

Two serious vulnerabilities have
been reported in most Windows
versions, including XP Home
and XP Professional.

The first has been rated by
security firm Secunia as
Extremely Critical, their highest
rating for threats. The
vulnerability can be exploited to
take control of a user’s system. It
is caused due to a certain error
within the handling of animated
cursors, and can be exploited via
a specially-crafted animated
cursor file. Arbitrary code can be
executed if the bad guy takes
over, and this can happen when
you visit a malicious site using
Internet Explorer or open a
malicious e-mail.

The vulnerability was being
actively exploited at the time of
this writing.

The Solution

Microsoft has released
patches for this; the patch for
Windows XP SP2 is at
http://tinyurl.com/2fu9gc.
The full list of patch URLs (for
other Windows 0Ses) is at
http://tinyurl.com/2qymgy.

The second vulnerability is
only a notch lower—"Highly
Critical”’—and that means you’ll
just have to apply the patches
for this one as well. The
description of the danger is the
same as for the first
vulnerability, except, of course,
that it works in an entirely
different way.

The XP SP2 patch for the
“Agent URL Parsing Memory
Corruption Vulnerability” is at
http://tinyurl.com/26qvsn, and
the full list of patch URLs is at
http://tinyurl.com/2gge2q.

“It’s a dog.”

HERE COMES GOOGLE

Almost 70%
Profit

Increase For
Search Giant

pril is the time when
Acompanies take stock
of their Q1
performance, and take steps
to enhance growth or reverse
losses over the rest of the
year. This year, investing in
Google looks promising,
thanks to their 69 per cent
rise in profits from Q1 2006.
It’s still search and the
advertising it brings that
powers Google, but their
whole strategy of
diversifying, acquiring and
hiring seems to be paying the
dividends it’s supposed to.
We reported earlier that
Microsoft CEO, Steve
Ballmer, thought Google’s
growth strategy was
“insane”. At a talk in
Stanford, Ballmer said,
“They (Google) are trying to
double in a year. That’s
insane in my opinion.” He
was careful enough to add
that this didn’t mean that
Google wouldn’t do well. He
also pointed to Google’s
work ethic of allowing
people “to do their own
thing”, and said that it
wasn’t proven to create
“value”. For those who don’t
know, Google demands that
engineers spend 20 per cent
of their work hours working
on projects of their own, no
matter how weird. This is
perhaps why some of the

Gavrav Dutta

coolest things online are at
Google Labs.

With Google going from
a 10,000+ employee
company to 12,000+ in
under a year, and posting
huge increases in profits, it
seems to us that they have
got their business model
right. Acquiring smaller
companies with ideas that
fit into the Google way of
life also seems to be paying
off. But most of all, it’s the
public perception and
Google’s image as an
innovator that’s not afraid
to try new and fun things
that’s helping them. We all
want jobs at Google, and we
all want to use their
products—come to think of
it, maybe 69 per cent is
nothing compared to the
things to come.

We’re just dying to hear
what Steve Ballmer will say
next, after all, it was he
who predicted in 2005 that
Google would be dead
before 2010!

Related

Apparently, it’s not always
fun at Google. Breaking the
myths we’ve had about
Google being the ideal
place to work, are two
founders of Dodgeball, a
mobile social networking
site that Google took over
back in 2005.

Dennis Crowley and
Alex Rainert quit Google in
mid-April—Crowley said on
a blog, “The whole
experience was incredibly
frustrating for us, especially
as we couldn’t convince
them that Dodgeball was
worth engineering
resources, leaving us to

L]

DRM Dead?
An agreement
between EMI
and Apple
allows the
Apple iTunes
store to sell all
songs owned by EMI Music
completely DRM-free, at 256
Kbps AAC—much better
quality than was earlier
available.

C e

A TR A
Three To Go
It’s only EMI; the
rest of the Big
Four—Sony BMG,
Universal and
Time Warner have

T F F
LA

=

adopted the wait-and-watch,
money-grub-while-you-can
attitude. They’re not even
interested in getting a higher
price per non-DRM-ed song.
Distressing, this.

watch as other startups got
to innovate in the mobile +
social space.”

Google’s response was
posted on the Google blog
on CNET:

“Google understands
the important role social
networking plays in today’s
mobile ecosystem, and we
are constantly looking at
ways to provide a great user
experience in this area.
Dodgeball was an early
attempt at understanding
user needs in this space
and we are continuing to
evolve our thinking and
our offerings. However, we
have nothing to announce
at this time.”

But it’s clear, business is
business to Google, so don’t
think it’s all just fun and
games, especially if you're
being bought over by Google.

| “Time-pass, o Friend..”
== Bhavesh Bhasin

e

e
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Enter
The Digital World

i

A Round-up Of Technology News From Across The Globe

S

NORWAY
A liberal political party, Venstre, is
pushing the government to ban
DRM and legalise file-sharing.

g They're speaking for the people,
who are disgruntled by the current
restrictions on downloading.

3 A
UNITED KINGDOM

Cyber-bullying of teachers on
video-sharing sites is causing
many teachers to leave their
johs because of the resulting
defamation and humiliation.

S
A rule to fight online gaming o 1
= addiction has been passed by 7 ‘J
the government: there’s now a

limit on the game score of any ]
under-18s playing online games
for more than three

consecutive hours a day!

5 [ |
THAILAND

Access to YouTube was
blocked by the government
after Google refused to pull
down video clips poking fun
at the Thai King. Criticising or
defaming the royal family is a
crime in the country.

UNITED STATES

The Department of Defense will
launch a satellite with an

Internet router in 20009. It will
enable voice, video, and data
communication for US troops, as
part of the Internet Routing in
Space (IRIS) project.

BRAZIL
In the virtual world of Second Life, the
Brazilian airline TAM has actually }
announced free virtual flights from L ]

Berrini Island to England, Milan, New ’
York, and Paris. Avatars get free flier

points and gifts such as virtual aircraft.

18

CRAPWARE AND XP

XP Makes A
Comeback,
Crapware
Kills The Joy

es, that is a word.
YCrapware stands for

anything that’s
bundled with your PC that
you don’t want. When you
buy a branded PC, it comes
preloaded with an OS and a
really big bundle of junk
software. This includes anti-
virus and security software,
multimedia tools, system
tools and a whole load of
Internet related rubbish.
Sure a lot of the software is
good, but all we get are the
trial versions. Why buy the
full versions when there are
so many free alternatives
floating around?

Consider this: you get a
brand new PC, the glint
from it is hurting your eyes.
It’s a dual-core CPU with 2
GB of RAM and a rather
large hard drive, but switch
it on and it starts up
laboriously. Anyone who’s

ever formatted and
reinstalled Windows will
testify to the speediness
with which it starts up
before you install all your
software. Branded PC
buyers, however, get tonnes
of software pre-installed.
They don’t ask for it, they
don’t want it, but it’s
provided anyway. Why?
Simple: PC manufacturers
try and cut costs everywhere
they can. One way is to
bundle trial versions of
popular paid software, pick
up some money from these
“advertisers” and bring
prices down to a point
where PC brands and
assemblers are fighting over
a small price difference.
Sadly, since everyone
uses OEM bundling of
Windows, it’s not like you
can get your own Windows
CD and format to get rid of
this crapware. God forbid
you have an OS crash and
have to load from the
backup drive—you get those
trial applications installed
again, and have to spend
time cleaning up the mess.
Here in India, the
solution seems to be: keep
your bill safely, format,
install a pirated version and

Stat Attack
It’s all in the numbers
The world’s favourite desktop resolution
Europeans on
average get their
first phone at 8.
They’ll spend
$28K (Rs 13 lakh)
on handsets and
services during
their lifetimes.

The typical office worker is interrupted
every 3 minutes by a phone call, e-mail,
IM, or other distraction. But it takes 8
uninterrupted minutes for a brains to get
into creative mode.

Staying Connected:

use a mobile phone.
use a smartphone.

use a laptop.

31,842 PS3s donated is most used
to
folding@home; (24%
do ). In North
making each PS3 | America: And in

worth about Asia:
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Photograph Gaurav Pranshu Garg

live happily ever after. In the
US, however, stricter laws
lead to people having no
choice. In fact, some PC
vendors actually charge extra
to give you a cleaned out
Windows. Yes, you actually
pay more for less with that
solution! For now, you
should get the PC Decrapifier
from www.pcdecrapifier
.com, and clean up your PC.
Good news from PC
vendors is that Dell has
decided to bring back
Windows XP, so you can get
cheaper versions of high
end hardware. Of course,
since Dell is doing it, all the
others will follow suit.

Search Giant
Will Now
Know More
About You

ecently, Google
Rannounced plans to

buy DoubleClick, the
digital marketing giant, for

3.1 billion dollars (about

ach month Digit wi ry a captio
Each month Digit will car £
and beat the Digit team at their own

Rs 13,950 crore) in cash! For
Google, which already has a
booming business that
garners advertising revenue,
this will make them a
formidable force for online
advertising. End users,
however, seem to be more
worried about how much
information Google will
now have on each of us.
They already know what
we’re looking for, those
with Gmail have already
agreed to let Google
computers read their mail,
and now they will know
what sites we visit, and
decide what ads we see.
Thus far Google has been
behind the text ads you see
when you search, while
DoubleClick is behind a lot
of the banner | fixed ads
you see on sites. With this
merger, soon we might see
Google controlling every
single ad you see online!
Microsoft was quick to
condemn the move: Brad
Smith, general counsel for
Microsoft said, “This
proposed acquisition raises
serious competition and
privacy concerns. We think
this merger deserves close
scrutiny from regulatory

n for a photo. Com!
game! Entries accept

ething funnier,

e up with som

authorities to ensure a
competitive online
advertising market.” Of
course, rumours doing the
rounds suggest that
Microsoft was beaten by
Google in the bid war to
buy DoubleClick, so it could
just be a case of sour
grapes. Pity.

The news has already
started making top headlines
everywhere at the time of
writing this. There’s even
rumours that three public
interest groups—Electronic
Privacy Information Center
(EPIC), Center for Digital
Democracy (CDD) and U.S.
Public Interest Research
Group—will jointly file a
complaint against the
merger with the US Federal
Trade Commission.
According to what we hear,
the groups will file the case
on behalf of the 1.1 billion
Internet users across the
globe, opposing any merger
until it’s clearer how Google
uses the data it stores, and
makes a public formal
announcement indicating
how it will use all the data
it gathers.

Nicole Wong, deputy
general counsel for Google

Beat

That.

Digit Caption
“Port-a-print”

Last Month’s Winner!
Milind Sarwate,

Chief-HR & Strategy, Marico Ltd
“This is the mouse that

ed by the 20t of this month.

E-mail your caption with the

subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com -
and win

by Jeremy Moskowitz
and Thomas Boutell

Published by

WILEY-INDIA

said, “User, advertiser and
publisher trust is
paramount to the success of
our business and to the
success of the acquisition.
We can’t imagine taking
any actions that would
undermine these
relationships or the trust
people have in using our
products and services.”

With all the hullabaloo
about this merger, we
decided to make a list of
everything Google would
know about any one of us (if
you use all of their services),
and this is what we got:

1. Search: There’s no doubt
that the majority of us use
Google Search. If you're
signed into your account,
Google already knows who
you are and has your email
address. It will now know
exactly what you look for
online. If you’re not signed
in, it still ties your IP to
your preferences.

2. Gmail: What’s the best
way to get users to identify
themselves? Offer them a
really cool new e-mail
service; make it invite only
to raise the “I want!” factor,
and then collect loads of

DIGIT MAY 2007

19



20

Enter

GENDER

Priyanka Mahajan Vs. Omkar Sherade

The Google home page is, of course, what appears when you
type in “www.google.com”, but not everyone knows (or
cares) that you can personalise it by adding “gadgets” after
signing in using your Google or Gmail ID. The gadgets range
from finance to news to jokes to... We got Omkar and
Priyanka going to personalise their Google homepages, with

Stuff”, she went on to add Gmail, a world clock, a calendar, free text messaging,
and “About C/C++” from under “Popular Add-ons”. Under News, Priyanka

Unsure of the task she was, Priyanka, didn’t ask for help.
She found the Personalize link soon enough; entering “Add

selected IndiaTimes Cricket, and Translate from under Tools.
Searching for an Orkut gadget, she added Yahoo! Mail-she
couldn’t locate Orkut. Browsing through Finance and Sports,

she selected Download.com, Music under Lifestyle, and
Wordpreference.com from Tools. Searching through all the
sections again for Orkut, she finally selected GTalk to
compensate for Orkut. Rearranging her home page, she
brought Yahoo! Mail, Google Talk and Cricket to the top. A
rather social person, we surmise, and the cricket bit was
somewhat of a surprise.

selected Automotive News under “Lifestyle”.

Clicking back to the homepage, Omkar didn’t feel the layout was to his
taste. Some dragging and dropping later, he rearranged the page. The top
news stories, automotive news, and Wikipedia now occupied the top slots in his
new homepage. Pretty staid.

Omkar wasn’t sure how to do the personalisation, but
didn’t ask for help either. He dashed to Google, where he
found the “Personalize this page” link. From under
“Popular Add-ons”, he chose BBC News, HowStuffWorks,
and Google Video. Finance interested Omkar—he went
through each and every page of that section—but he didn’t
get what he wanted. Under Sports, he selected Soccer
Way, and Babelfish (the translator) from under
Communications. As we'd sort of expected, he browsed
through all the pages under Technology, but he next

personal information on
them. Google computers
also scan through your mail

to see what it is

dislike, and target you with

more relevant
advertisements.

3. Calendar: If you use
Google calendar, they
know what you’

and when.

4. Docs and Spreadsheets:
With the growing
popularity of Google Docs,

Google now has

what kind of products and
services you like.

6. Orkut: They know who
your friends are...

7. Blogger: They know what
you have to say.

8. Earth: They know your
address—if you entered it
that is...

9. Toolbar: They know
everything you do online.
10. Picasa: They know what
you look like.

11. YouTube: They know
how to entertain you.

you like |

re doing

access to

what you're creating, and

what work you do.

5. Reader: If you use their
services, Google knows
what kind of news
interests you, and thus

First of all, Google
doesn’t collect personal
information from all of its
services, we just painted
the worst case scenario for

each service above.
Secondly, if you’re using all
these services like some of
us are, does it really matter
if they know a little more
about you? Thirdly, what’s
the worst that will happen?
Instead of seeing ads on
sites that bore you, you
might actually be
interested in buying
something. And finally, you
are one of 1.1 billion
people online, and with
that number growing
everyday, do you really
think you are that
important? It’s not like you
have your neighbour
peering through your
bathroom window here...
Besides, your chemist
knows what health
problems you have, your
trash man /| woman knows
what products you use and
what you’ve been eating,
your accountant knows
how much you earn, your
mom knows how much salt
you like in your food...
Google computers know
what you do online, and
try to entice you to spend a
little money.

We need to all take a
step back and relax—until
Google starts asking for
your bank account details,
you have nothing to fear!

THE TECH WAY

A New Way
To Grieve

he Virginia Tech
I tragedy has raised a
lot of questions for

US politicians, college
authorities, and the gun

laws across the states.

People across the world

are grieving for the loss of
loved ones, acquaintances
or just citizens of their
country. The incident
made us realise how we,
as in society, have
changed. The Net has
truly changed the way we
deal with tragedies.

Friends dealt with the
tragedy by sending
condolence messages to
the victims’ social
networking pages.
Facebook seemed to be the
popular choice for
mourners, and numerous
rather large groups were
formed to condone the
incident. Even as the
media was confused, and
reports about the number
of lives lost varied from 10
to the final count of 33,
these groups were being
formed. Initially they
shared information and
updates on the events, and
now are a gathering place
to share experiences and
offer condolences. Some of
the victims had Orkut
pages where condolences
started pouring in.

Instant messengers
were used by Virginia Tech
students to get in touch
with friends and family.
Reassurances and news
spread via e-mail and IM
like wild fire. Even
Facebook and MySpace
were used to share news
and send the “I'm OK”
signals. Because mobile
networks and phone lines
were jammed with frantic
calls being made to and
from the university,
Internet connectivity came
to the rescue, and proved
that it’s a more reliable
service in terms of crisis.

Even while the ordeal
was underway, the student

Centrino Pro

Intel’s new, fourth-generation Centrino platform,
scheduled for release this month, is the Centrino
Pro. It unifies the Santa Rosa platform and their

vPro technologies.

This new platform uses the second-generation Intel
Core 2 (“Merom”) processor, which has an 800 MBps
Front Side Bus, capable of switching to 400 MBps on
the fly. This means the processor will consume lesser
power when not in use, thus extending battery life on

laptops and other portable devices. The Centrino Pro
also supports the latest 802.11n Wi-Fi specification,
which increases range up to 50 metres and has a
maximum data transfer rate of 540Mbps. Another
important advancement is the inclusion of the
Extensible Firmware Interface, which completely
replaces the now-ageing BIOS. The Centrino Pro also
supports NAND Flash memory caching, which will
make for an almost-instant bootup!
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Enter

Red Swoosh

What is Red Swoosh?

Red Swoosh is a company that
has developed a new peer-to-
peer file sharing protocol that
works in a closed user group,
giving download access only to
the intended audience. It uses
bandwidth very effectively and
efficiently while transferring
large files over a network.

Why does one need it?

Red Swoosh can be used to
deploy large presentations,
videos, etc. within a
corporate environment where
individual servers are used to
host the files. The use of P2P
means reduced stress on the
hosting server.

How does it work?

The content seeder adds
“http://edn.redswoosh.net”
before the URL (as in
http://edn.redswoosh.net/ww
w.example.com/sample_movie
.avi) and publishes it on their
Web site. You install the Red
Swoosh P2P client; when you
click on a link that is swooshed
by the site author, the client
intercepts that and downloads
the target file using P2P
instead of the regular HTTP,
thus saving on bandwidth costs
and download time. To the
user, it feels like downloading
from within the browser.

When was it developed?
Red Swoosh was founded in
the dot-com-crash years by a
group of individuals who gave
us Scour, one of the first
multimedia P2P clients.

Which features make it
different?

Red Swoosh targets not the
worldwide P2P community, but
original content developers.
Every Red Swoosh client is
assigned a unique static ID in
order to verify that content is
being delivered to the correct
destination computer.

Where is it moving?

Going forward, Red Swoosh
plans to share download
statistics with end users. It
also plans to share ad revenue
with them!

body leaders set up chat
rooms to try and warn
students and inform them
of what to do, how to stay
safe, and to not leave their
apartments. Others turned
to online forums to
exchange information about
the identity of the shooter
and those he murdered.

Currently, online
services are being used to
create memorials, such as
those that already exist on
Facebook, and e-mails with
prayers and poems written
about the victims are
doing the rounds. People
from other countries are
also getting to express
their sympathy and grief,
thanks to the Net.

It’s very obvious that
the Internet and the
services that are available
have done everything from
save lives of those in
danger, share information
faster, reassure worried
relatives, express
condolences, share
experiences and also given
people from across the
globe a chance to put
forward a united front and
grieve and condemn the
tragic events of April 16,
2007. Thank God for the Net
and the various services we
usually take for granted—
thank you technology!

Related

How sick can people get?
Every time we think
humanity hits an all time
low, a few dig even deeper.
Malware writers were some
of the quickest to respond
to the Virginia tech tragedy,
piggy-backing on the
curiosity that was formed
within most of us after
hearing about the shocking
events. According to anti-
virus software developers
Sophos (www.sophos.com),
the e-mail that’s sent to
users contains a
photograph of gunman Cho
Seung-hui, and links to
what it claims to be a site
that video clippings of the
incident. With camera
phones omnipresent, this e-
mail is quite believable,
and was sent out at a time
when everyone was abuzz
with news of the incident.
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A lot of people on Orkut want to express their condolences to Minal

The site you are directed to
tries to install a screen
saver file that installs a
Trojan that will steal
Internet banking data.

Also, a lot of domain
names that looked like they
were inspired by the
Virginia Tech massacre
were bought up very
quickly. It looks like
technology has brought
both the good and the ugly
of our traits online!

REGAINING LOST GROUND
Everyone

wants An
Intel Inside

arket research
Mshows that Intel is
rapidly regaining

the ground it lost to AMD
over the past couple of
years. Just from the fourth
quarter of 2006 to the first
quarter of 2007, Intel has re-
gained 4.5 per cent market
share (up to 80.2 per cent
from 75.7). AMD lost
ground from 15.7 to 11.1
per cent in the same period.
Many will attribute this to
Intel’s new Core processor
line and their aggressive
marketing.

AMD’s stocks are also
showing the effects of
these results. AMD lost
$611 million in the first
quarter of 2007, which
translates to $1.11 (Rs 50)
per share. When you
compare this to Q1 of
2006, when AMD’s stock

went up by $0.38 (Rs 17),
you get an idea of the
amount of losses they’re
suffering. Currently, Intel
owns the performance
crown, and AMD is having
to resort to a price battle
to compete. So, AMD is
offering chips at rock
bottom prices, while still
trying to compete with
Intel’s relatively huge
advertising spends.

According to market
researchers, Intel has more
than seven times the
amount of cash than AMD,
and is worth well over 15
times as much as the latter
in terms of market value.
So what’s David got up his
sleeve for Goliath this
time? AMD’s upcoming
Barcelona line of chips
might be the sling-shot
that dents Intel.

Whatever the outcome,
we’re so used to the AMD-
Intel see-saw game, we’re
not going to make any silly
predictions. We know AMD
will come back with a
response—they always do.
We also know that Intel
will hit back again, and
the initiative will keep
shifting from one camp to
another. The only way we
see this ending is if the
companies merge, and we
definitely don’t want that
to happen. All competition
between these two giants
is what gets us better
performing CPUs at
reduced costs. May the
Intel-AMD fight continue
with as much fervour
and as many price-cuts
as possible! H

DIGIT MAY 2007




Fuelling The Pursuit Of Technology Knowledge

Nimish Chandiramani

quality time has been spent with The
Three. The moment has arrived for Digit
to speak unto its readers, bearing the Final

Ultim ate
Word on which console deserves that hal-
lowed space upon your TV cabinets. Read very
carefully, for we shall write this only once.
We’ve had the Xbox 360 in our office for

Long we have awaited this day. Much

so long now that it’s become just another fix-
ture. No longer do people trip over them-

selves to have a go at it, except when new
titles come in for review; even so, our fingers
itch for more. We’ve been longing to plaster
our fingerprints on a shiny new PS3 and

break a window or two with that satanic

The Xbox 360 has been available here instrument of death, destruction, and

. . . weight loss—the Wiimote. Long hours in

for a long time now. The PlayStation 3 has just front of HDTVs, eight sore fingers—the little

launched in India. The Wii is rumoured to be fmc%e&l is usufaﬁy spa?ed1 such ftortur_e—

. . . an orror of horrors) plenty of exercise

on its way some.tlme n September. later, we bring you the ultimate battle for
It’s Showdown time! console supremacy...
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The Rules Of Engagement
The winner will need to (these are in no particular order):
1. Prove it’s hardware-worthy
The PS2 is going strong even today for the simple reason that
it’s still possible to create good-looking and complex games
for that hardware which won’t turn it into a brick. A con-
sole’s hardware must be future-proof, and provide gaming
joy for years to come.
2. Not bankrupt you
If you think your monetary woes end with just buying a con-
sole, think again...
3. Be in tune with the Force
This is the most intangible part—the experience. Will it rock
your Casbah? Does it have Mojo? Will it bake you cookies
when you’re depressed?

In the first corner, we have the reigning champion of the
market, M-Dollar’s favourite child after Vista itself, please
welcome...

The Xbox 360
(We reviewed the Xbox 360 back in August 2006, so this will
be somewhat short.)

It must be nice to lead the life of the Xbox 360—take the
market over just by virtue of existing, and while your closest
competitor takes a year to release, spread your word far and
wide to everyone who’ll spare you twenty seconds of their
time. Not that the 360 doesn’t deserve to be at the top.

Powerhouse
With a tri-core IBM CPU and an ATI-built GPU at its heart, the
~ Xbox 360 is capable of incredible visual
2 detail and excellent physics. See the In A
Nutshell table for more on the 360’s
innards; you’ll see why we still
haven’t seen a game that the
360 has trouble handling.
In the HD department,
the 360 supports up to
1080i—one step lower than
the PS3’s 1080p—but it has
a neat trick up its sleeve,
and it’s called Ana. Anaisa
chip that scales game reso-
lutions up to the max-
imum that the TV is
capable of. Play a 720p
game or movie on a TV
that’s capable of 1080p,
and you’ll see the Xbox 360
scaling up to that resolu-
tion. To most eyes, however,
the difference between reg-
ular TV and 720p can be
summed up as, “This is
waaaay better”; the differ-
ence between 720p and
1080p is just barely percep-
tible, and even then, only
| because you know it’s
| there. Ana’s benefits will
become clearer some time
in the future, when all we
¢ see is HD content.

The Adventures Of
The Wallet

You can get yourself the
Xbox 360 Premium
System for Rs 23,000, and

this is the one we recommend. It comes with a wireless con-
troller and a Media Center-esque remote, and most impor-
tantly, it comes with component cables for your HDTV. Good
quality component cables are hard to find, and when you do,
they’re painfully expensive. If you’ve got an HDTV, this is a
godsend.

Speaking of HDTVs, the 360 is wasted on anything but.
On aregular old TV, the most that can be said about the 360’s
graphics is that they are significantly better than the PS2’s.
So when you buy your 360, make sure you’re building up
another Rs 30,000 or so for a decent HDTV. Titles come at
nearly Rs 3,000 apiece, so this is going to pinch a bit too.

Going Online
You get a trial membership for Xbox Live when you buy your
360, but Xbox Live has yet to officially launch in India—this
should happen later this year. You can still access Live, how-
ever—browse content, download game demos and so on, but
you’re banned instantly when you try to enter the Video sec-
tion. Most importantly, you can play your games online. With
our current broadband situation, though, Live will have a
limited Indian audience.

There are plenty of nice things to be said about the Xbox
360, but there’s trouble brewing... or is it?

The Sony PlayStation 3

Thanks to plenty of media hype and CEO Ken Kutaragi’s
obnoxious jingoism, the PS3 seems to have acquired leg-
endary status well before its time—its very presence inspires
awe. The design of the console itself oozes style, and yes, that
shiny exterior is just begging for fingerprints. Put it next to
a sizeable HDTV, and your view of the PS3 is more realistic.
It’s not a Formidable Force™, it’s just a big console.

Roaring Engines

The PS3 is powered by the Sony-Toshiba-IBM (STI) Cell Broad-
band Engine, or the Cell processor as it’s popularly known.
This processing behemoth sports a single PowerPC core,
helped along by a team of eight Synergistic Processing Ele-
ments (SPEs), one of which has been reserved for redundancy.
Paired with NVIDIA’s RSX GPU, the system is theoretically
capable of nearly two teraflops (floating-point operations per
second)—nearly double the overall capability of the Xbox 360.
In terms of raw specifications, then, the PS3 leaves the Xbox
360 in the dust—no worrying about game developers run-
ning out of power on this one. If anything, the biggest chal-
lenge they’ll face is making a game that will truly exploit
the power of the Cell, complete with ultra-realistic graphics
and insanely complex Al.

COming Soon To A Console Near You
When you fire up a title for the PS3, it undoubtedly looks
amazing, but one question niggles—what is this doing that
the 360 isn’t? Today, that answer is “nothing.” Whether the
PS3 looks better than the 360 is a subjective matter, but while
you sit and expect to be blown away by something that is
technologically superior to the 360, all you find is something
that is at par, if not marginally worse (no hardware scaling
chip, remember?).

Read on for our views a couple of launch titles later in
this issue, but first...

Lost In Space

When you first pick up the PS3’s new wireless SIXAXIS con-
troller, it feels, well, cheap—almost like a bootleg PS2 con-
troller. The vibration is gone, making the controller lighter,
but this may not be as good as it sounds—we were to find
this out later. The controller is also motion sensitive, so you
can control games by tilting it in the right direction. In the




R n a Nutshell

Xbox 360 PlayStation 3 Nintendo Wii
Processor IBM PowerPC-based custom-built Sony-Toshiba-1BM Cell Processor IBM PowerPC-based “Broadway” CPU
processor with 3 symmetrical cores, with 8 cores, running at 3.2 GHz
running at 3.2 GHz
GPU Custom-built ATI Graphics with Unified = NVIDIA RSX GPU ATl “Hollywood” GPU
Shader Architecture
Output Resolution ' Up to 1080i, lower resolutions scaled Up to 1080p, no scaling Up to 480p
up
Storage 20 GB HDD (Premium System only) 60 GB HDD, Memory:Stick 512 MB Flash Memory, GameCube
Xbox 360 Memory Unit (Standard and Duo) / Stick Pro, SD, - Memory Card, SD
CompactFlash
Connectors 3 USB 2.0 ports 4 front and 2 rear USB 2.0 ports 2 USB 2.0 ports

Connectivity Wi-Fi, Ethernet

Wi-Fi, Ethernet, Bluetooth 2.0

Wi-Fi, Ethernet (via Ethernet to USB

adapter)
Bundle “Core System: Console, one wired Console, SIXAXIS Wireless Console, Wii remote, Nunchuck,
controller, composite AV cablePremium - Controller sensor bar for remote
System: Console, one wireless
controller, media remote, HDMI cables,
20 GB HDD”
Price “Core System: Rs 19,000; Premium Rs 39,990 Rs 19,000 (grey market);

System: Rs 23,000”

games we tried it out, though, it seemed rather twitchy—its
lightness makes it easy to over-tilt, even when you’re not in
the throes of excitement. We’d have appreciated something
that felt a tad more substantial. Overall, this has potential,
provided game developers are able to use it properly.
Everything about the controller is the same as the PS2’s,
but the L2 and R2 buttons have been replaced with analogue
triggers, and they’re plain awful. They’re convex, for one, so
your fingers are going to slip off them when you apply too
much force—not too palatable when it’s what’s keeping your

FLAavsrATIONRn =

Rs 15,000 (expected retail price)

character alive or your engine revving. They’re also placed
awkwardly, and holding them down is decidedly uncomfort-
able—this was quite obviously an afterthought.

Going Online

You’ll be able to access the PlayStation Network (PSN) free as
soon as you buy your console, so you’ll have access to all the
free content—game demos, HD videos et al—and will be able
to play multiplayer games, but you won’t have access to paid
content till later this year, once some issues with the pay-
ment gateway have been ironed out. Later this year, we’ll see
PlayStation Home, which seems to be a Second Life of sorts.
You’ll be able to create your own avatar, build your virtual
home, buy virtual furniture, play virtual games, die a virtual
death (we’re not so sure about this bit), and so on.

The Gamer’s Burden

As with the 360, by playing with the PS3 on a standard-defi-
nition TV, you're preventing it from fulfilling its destiny. If
you have no qualms about shelling out the Rs 39,990 for the
60 GB unit, we’re assuming you don’t have any hang-ups about
plunging for an HDTV as well. Unfortunately, you’ll have to go
hunting for your own HDMI cables—acceptable ones should
come for around Rs 3,000; better ones, even more.

Titles will release at Rs 2,499 each, and there’s a slim
chance that this number will fall—Sony has already started
replicating PS2 DVDs in India, bringing some prices down to
as low as Rs 999, and we’re hoping this happens for the PS3
as well.

And from the darkness, another emerges...

The Nintendo Wii

Look at this thing. That small, clean white body belies its
cruel black heart. After all, what manner of insolent machine
seeks to get people off the couch and exercise? And then
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Ridge Racer 7

Every Sony platform has had at least one Ridge Racer
(RR) title to enjoy, and RR7 is the latest in the line.
The franchise has long been one of our favourites—
how could you not like a game where most of your
responsibility entails drifting your car around corners
and winning races? This game offers you raw, unadul-
terated fun and beautifully unrealistic gameplay—you
could be in a car that’s moving forwards, but at a 135-
degree angle to the road’s direction!

Naturally, RR7 has gone HD, and can’t help look-
ing good on the PS3. It’s also become a tad more diffi-
cult. In the previous versions, especially those on the
PSP, racking up the drift points for more boost was
quite easy; you’ll have to drift really well for these

points now, and if you botch up, your opponents will
leave you far behind. The only grouse about this game
is that all that drifting can get a little monotonous.

Whether you’ve played an RR title before or not,
this one is highly recommended—no nonsense, all fun.
Rating: 8/10

Lair

Lair isn’t part of the launch line-up—it’s due for release
in the end of July—but it’s the first game we’ll see that
uses SIXAXIS extensively and almost exclusively, and
deserves a mention. There’ll be battling dragons and
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much fire-breathing in a world “torn by conflict
and strife.” You use your SIXAXIS controller to
control the flight of your dragon as you hunt the
skies for enemy dragons, engaging them in fire-
ball-filled dogfights or close-range kick-and-hite
attacks. The first mission is training—getting you
used to controlling your dragon and learning
some basic moves, and even when you consider
the fact that we saw some very raw review code,
we can see that this is asking for trouble. You
have no option but to use the controller’s motion
sensitivity, so if you're uncomfortable with it like
we were, tough. To attack enemy dragons close-
range, you need to go near them, jiggle the
controller (looking like an over-excited idiot),
jiggle some more and finally hit a button combo
to kill the enemy dragon rider. We're hoping for a
cleaner, tighter control system when the game
finally releases. The game has a Lord Of The
Rings-ish feel—it’s set in ancient times, and the

A total of nine games will launch with the PS3, and Milestone
E Interactive (the ones who are bringing the console and its games
?'“ j to India) has many more lined up for the months that follow.

there’s that deadly projectile, the Wiimote—the litres of blood
that it’s drawn from so many innocents... appalling. We had
our go with this satanic device thanks to Yogesh Nagdev, who
owns a popular gaming café called Plugin in Vashi, Navi
Mumbai. You can, too, if you're ever in the vicinity—it’s one
of few places (and the only one we know) that will let you
game on a Wii.

The Mini-console

The Wii’s innards—practically as diminutive as its exterior—
are almost embarrassing: where the 360 and PS3 talk teraflops,
the Wii’s IBM “Broadway” processor and ATI’s “Hollywood”
R520 GPU place it a wii bit ahead (couldn’t resist that one) of
the older PS2 and Xbox in terms of raw performance. It’s not
even truly HD—its 480p resolution will look excellent on a
good standard-definition CRT TV, but is quite likely to die on a
true HDTV—especially when you look at how beautiful games
look with the 360 and PS3. But then, Nintendo isn’t banking
on wiining (couldn’t resist that either) on looks...

All That Hubbub

All Wii-talk is pointless without mentioning the Wiimote—
the TV-remote-shaped controller for the Wii (the official name
is the Wii remote, but we prefer the corruption). It connects
to the Wii via Bluetooth, and detects motion using accelerom-
eters and an infrared sensor bar that you’re supposed to place
above or below your TV. The controller itself is quite simple—
one trigger-like button (B) at the bottom, and a classic NES-
like button set on the top. It also features vibration and a little
speaker that attempts to give you an added sense of immer-
sion—imaging hitting a baseball and hearing the crack of the
shot come from between your hands, and you’ve got the
premise. It sounds a bit tinny, but gets the job done.

little we saw of the environments
suggests the same. Shooting never-
ending fireballs at enemy dragons has its
own promise of fun. 'Twould be a pity
were it to be let down by its controls.

Most importantly, the Wiimote comes with a fairly sturdy
strap to prevent you from chucking it across the room in
excitement—we didn’t have any such episodes, but there are
people all over the world with bruises and broken furniture
that will testify to the need for this strap.

Also part of the package is the Nunchuck, which plugs
into the Wiimote, and is quite obviously built for first-person
shooters. You use the analogue stick to move your character
around, while you use the Wiimote to aim and shoot. The
Nunchuck is motion-sensitive too, and also serves as your
second punching fist in Wii Boxing.

During the first five minutes, we realised that you don’t
really need to stand up or jump around to play on the Wii—
flicking your wrist from the comfort of your couch works
quite fine. A few minutes later, you wonder whether standing
up might actually help, and this is where the trouble begins...

We highly recommend a basic warm-up before hitting the
Wii courts | greens | boxing rings, lest you suffer the pain we did.

Are Those...People?

With the hardware that Nintendo had at its disposal, it’s sur-
prising that they chose simple, skittle-like models for Wii
sports—and surprisingly enough, it’s easier to connect with
your ridiculously unrealistic in-game avatar (or Mii) than it is
when playing any other character! The lack of modelling
detail has almost no effect on your game experience; in fact,
it adds to the light-heartedness of it all, and will no doubt
aid the Wii’s Primary Main Objective™—garnering the
interest of non-gamers.

Wii Sports features Tennis, Bowling, Baseball, Golf,
and Boxing (in order of how much fun they are), and you’re
explained how to work the controls the first time you play
each game.
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One Wii Step At A Time

You don’t have to go through it,
but Wii Sports gives you a Wii Fit-
ness Test, built to “test your skill
and stamina.” It takes you through
a series of mini-games—based on
Wii Sports’ main games, that is—
that will put you through your
paces. You’ll be asked to return as
many balls as possible in Tennis,
score some mildly challenging
putts in Golf, get as many strikes
as you can in Bowling, and so on.
At the end, your scores are tallied
and your Wii Fitness Age is calcu-
lated. The idea is to be as young as
possible (at the very least, get your
own chronological age), and you
should take this test once a week
to see how much progress you’ve
made. This writer started out at a
shameful 54, but after four hours
of Wii-ing, came down to a less
embarrassing 35. Clearly more Wii
time is warranted.

On The Fields

Tennis is easily the most enter-

taining game of the lot—while the rest are simple to pick up
and play, it’s here that you’ll find yourself wanting
to improve continuously. The game is all about timing
and power, and it’s by balancing the two that you control
the direction and speed of your shot—miss your timing,
and you’ll be hitting the ball right out of the court.
Controlling your shot with the Wiimote is much like you
would do in real life, and feels as natural as being there on
the grass.

With some more practice, you can also get some spins in,
though all we were able to accomplish were little more than
flukes. You can also tell quite easily that this is going to be an
excellent game if more people join in.

After Tennis, it’s Bowling that’s quite captivating—you
can either use the simple hold-down-B-and-twitch method
to get your strikes, or practise more elaborate moves like
spinning the ball to nail difficult shots. Here, too, the
Wiimote fits in as naturally as your own arm, and the moves
are similar to the ones you would use in reality. We don’t
wonder why this is the most popular game in Wii Sports
worldwide.

Golf and Boxing are the game’s disappointments. Golf
has some pretty challenging holes, but the Wiimote detec-
tion doesn’t work as seamlessly as the rest of the games, and
isn’t as immersive. Boxing requires you to hook up the
Nunchuck for your other hand, and while the idea of boxing
with the Wiimote in one hand and the Nunchuck in the
other sounds excellent, the execution is quite badly flawed.
For one, we couldn’t really throw punches the way we
wanted to, and there were even instants where the wrong
fist would shoot out.

When you get bored of the games, there’s always
the Training Room, which gives you three levels of chal-
lenges for each game. These challenges are grossly under-
played in all the hype, but can be the best part about Wii
Sports—imagine facing off with a friend to see how
many strikes you can get in a row, and you’ll see the poten-
tial in this.

In the end, Wii Sports makes for ideal party or family
fun—especially Bowling—even though Golf and Boxing aren’t
what they could be.

Budget-friendly

The Wii is the cheapest console avail-
able today—we don’t have the price
for India, but it should be a bit more
than the $250 (Rs 11,250) that it
retails for in the US. On the grey
market, you can get one for as much
as Rs 20,000—that’s just Rs 3,000 less
than a legal Xbox 360 Premium!
We’d recommend conning a visiting
relative into bringing you one, or
waiting for the Indian launch. Titles
cost around $50 (Rs 2,250), which will
quite likely become Rs 2,500 here—
perhaps even Rs 3,000.

However, you don’t need an
HDTV to enjoy the Wii—a standard
TV should do just fine. If you do have
an HDTV, you’ll have to shell out for
the component cables as well.

Endgame

What do you look for in games?
Would you rather see cutting-edge
technology in action or enjoy a new
concept? Do you want to be blown
away by visuals and sound, or do
you just want to have fun? Everyone
has their own philosophy on the ideal gaming experience,
and most are quite hard-headed in that respect. But we dodge
the subject: which console wins?

We’d compare the Xbox 360 and the PS3 on an equal
footing for now—the games that have released thus far bring
nothing to the table that propel the PS3 into its own class.
Unless we see a title that exploits the PS3 in new and unimag-
inable ways, it can be compared to the 360 with no bias, and
the latter takes the podium in that case. The 360’s head start
has given developers time to create games that showcase the
360’s capabilities marvellously, and the number of titles that
are releasing for it is just obscene. Unless Sony can catch up
to those numbers, the PS3 will always lag behind.

We don’t dispute the PS3’s technological superiority, but
games that can truly exploit the Cell will take some time, and
should make the PS3 the flavour of the season a year or two
down the line—just not now.

And then there’s the Wii. Just as we’re bored with the same
old keyboard-and-mouse for gaming on the PC, we’re bored
with the two-analogue-stick-four-button console controller.
Where the Xbox 360 and PS3 redefine games, the Wii redefines
gaming itself. Scoff at the ridiculous idea of getting up and
sweating it out all you want, but there’s no disputing how
much fun it is. We’re just hoping that third-party developers
put their minds to the task and build better control dynamics.

Today’s winner is the Wii. It’s terribly addictive, and this
is one addiction that will actually help you lose a bit of flab.
It breaks away from the old to bring you something so radical
and fun it’ll leave you gasping for more. If, however, you're
not like us and prefer beautiful and more complex games
without having to get off your hindquarters, the Xbox 360 is
for you. It’s cheaper than the PS3, has more titles to choose
from, enjoys a healthy, throbbing community online, and
even makes some games look better. There’s also an embar-
rassment of accessories, and there’s rumour that one of these
will bring SIXAXIS-like capabilities to the 360 as well.

The PS3 loses today, but its time will come. There’s a lot of
technology to be exploited there, and someone will do so soon
enough. Until then, keep your Wii strap firmly fastened and
stand clear of furniture and wayward family members. H
nimish_chandiramani@thinkdigit.com
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Cool Code

What goes into
making
processors that
(literally) don’t
burn holes in
your pockets?

Nimish Chandiramani

with mobile devices. Whether it’s your

old cell phone, a shiny new PDA, or the
upcoming Ultra-mobile PCs (UMPC), the quest
now is to pack in as much PC-like functional-
ity into these gadgets as possible. The chal-
lenges come in when you :realise that the
processors for these devices don’t have the
luxury of living in:a:capacious cabinet with
monster-sized heat-sinks to keep them cool—
with the walls closing:in en them, they must
deal.'with, computation-'in' ai completely
different way.

Nearly 75 per cent'of all embedded proces:
sors .arebased.;on ‘the ARM 'Architecture
(Advanced RISC:‘Machine; ' or -Acorn RISC
Machine), because it meets such requirements
beautifully—it’s half the size of an old 486 CPU,
is almost:as powerful (with'the potential for
more), doesn’t hedt up even under load, and
consumes but: a smidgen of battery power.
How does it doit; and why don’t we have such
features'in’'our desktop processors?

Our lives are now practically infested

History Lesson, I: Less Is More

Today's mobile processors owe their architec-
ture to a division in processor design. philos-
ophy that started somewhere in' the 1970s.
Flashback (in black-and-white, if you like) to a
dark age where no compilers existed, and

processors were hand-coded in ‘their ‘own
assembly language: : instructions. .. These
instruction sets, were quite:simplistic;’and
something ;-as:.simple':as. comparing  two
numbers | could. take ‘ten instructions: to
execute. Imagine trying to write an operating
system with that! But that 'was just half the
problem.

When you'gave an‘instruction to a proces-
sor,you do so as-a hexadecimal op-code, which
was.stored in a register on’ the CPU: itself
before: being: ‘execuited: : This  rTegister: (a
pipeliné of many registers in today’s proces-
sors) is'an expensive resource to waste, and
the number of instructions required for the
simplest operations made that painfully obvi-
ous—more so when processors were getting
powerful enough to do so much more. The
goal, then, was 'to create instructions that
were the same length (in bits, that is), but led
to the execution of many micro-operations.
For example, the 8086’s JPE (Jump If Equal)
instruction loads two numbers from the
system’s memory, subtracts them, uses that
result to determine whether they’re equal or
not, and then jump to a new instruction if
they are indeed equal. Contrast this with its
predecessor, the 8085, with but the humble
JMP instruction, which made the processor
jump to the specified memory location.

This was the birth of Complex Instructfd
Set Computing (CISC)—simple mstructmir?ﬁ
that performed complex tasks. It t waste
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CPU resources as much, and gave programmers
relief while they waited for the rise of higher-
level languages and their compilers.

History Lesson, II—-Enough Is Too
Much

With the arrival of languages like C, program-
ming trends started shifting away from the
ungainly assembly languages to the more
elegant (by those standards, anyway) higher-level
languages—which used compilers that translated
code to assembly language. As it turned out,
these compilers weren’t exploiting the potential
that CISC had to offer—mostly because compiler
designers were at a loss to figure out which
instruction to use when. The 8086 had 32 differ-
ent “Jump If...” instructions to choose from, and
more were added with every new processor. The
time and effort that went into designing CISC
processors started to seem... futile.

The processor design community split into
two schools of thought—one concentrated on
developing better compilers for CISC processors
(notably the Intel x86, which is all-pervasive
today), while the other believed that CISC proces-
sors were grossly overdesigned, and a simpler,
more compiler-programmer-friendly instruction
set was in order. The idea came to be known as
Reduced Instruction Set Computing (RISC), and
came with its own set of advantages and disad-
vantages.

Every RISC instruction takes one single clock
cycle to execute, so the CPU never has to wait for
complex instructions to finish executing; the
time saved is even more prominent when
instructions are sent alternately to multiple
processors. Most operations would take the same
time on both RISC and CISC processors regard-
less, but the hardware required to decode RISC
instructions is less complex, which makes it
easier and cheaper to implement. The most
significant disadvantage of the RISC architec-
ture, however, is that it relies quite heavily on
software—a badly written compiler can have a
devastating effect on performance, as could
badly-written programs.

In a nutshell, the simplicity of implementing
an RISC machine makes it perfect for mobile
processors, so that’s precisely what Acorn
decided to use when they came up with the ARM.

At The Drawing Board

The biggest thing to consider when designing a
mobile processor is power consumption. Every
single decision that follows—architecture, clock
speed and so on—is driven by the need to use as
little power as possible, and naturally so. How
would you like it if you had to keep recharging
your new PDA phone every three hours? Keeping
power consumption low also ensures that less of
it is dissipated as heat—which is good, because
you don’t want to be saddled with a heat-sink in
your pocket. Or worse.

It’s also important that these processors cost
very little, which in turn means that they should
be easy to design.

So in 1983, Acorn Computers designed the
ARM (Acorn RISC Machine), a 32-bit RISC proces-
sor which had a third of the transistors as the

Motorola 68000—which was six years older than
the ARM—and could still actually do stuff.

Taking More RISCs

Consider this bit of code that calculates the GCD
(Greatest Common Divisor) for the numbers i
andj:

while (i = j)

=5
return i;

The premise is that if the lower of i and j is
subtracted from the greater perpetually till
they’re finally equal, the final number is the GCD.

When this code is compiled to x86 assembly,

The most signifi-
cant disadvan-
tage of the RISC
architecture is
that it relies
quite heavily on
software

you’ll have instructions that:

1. Check the equality of i and j; the CPU will
execute the following code if they’re equal, or
will start executing code from another (speci-
fied) memory location if not. This is called
branching—when there two possible outcomes of
the same situation.

2. Once inside the loop, check which of'i and
j is greater and subtract the lower from it—
resulting in another possible branch.

The x86 processor has an instruction
pipeline, which loads instructions from the
system’s memory and keeps them ready for the
CPU to execute. In the above case, let’s say that
while the CPU is performing the first compari-
son, the code for the rest of the loop is already in
the pipeline. Ifi and j are equal, however, all that
code is unnecessary, so the pipeline has to be
cleared, and instructions need to be loaded from
a new memory location all over again. This
wastes the pipeline, CPU time; as we’ve
mentioned before, these are expensive resources,
so wastes are unacceptable. The x86 architecture
compensates for this with a branch predictor,
which does exactly what the name implies.
Today’s predictors are accurate around 99 per
cent of the time, and the overall gains offset the
losses caused by the one percent.

ARM, however, would have none of this.
Branch predictors add complexity, so Acorn
decided to use the last four bits of their instruc-
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tion code as conditional code, which forgoes the
branching issue altogether—for smaller loops, at
least. The ARM assembly code for the same oper-
ation goes thus:

loopCMPRi,Rj
5 "GT (greater than)" if (i > j),
5 or "LT (less than)" if (i <j)

Jif'"GT", i=1-j;

JIf'LT", j=j-1;

; if "NE", then loop

SUBGT Ri, Ri, Rj
SUBLT Rj, Rj, Ri
BNE loop

ARM doesn’t
have to fight a

The result of the CMP (Compare) instruction
is stored as a condition flag in the Current Proces-
sor State Register (CPSR) on the CPU for later
reference.

Of the 32 bits that form the ARM’s instruc-
tion, 28 are used for the actual instruction, and
the remaining four carry the condition flag—
this is ARM’s own way of implementing RISC.

So when the SUBGT (Subtract if Greater
Than) instruction is sent to the CPU, it isn’t
going to waste CPU cycles loading the condition
flag and then checking it—the flag is right
there, and depending on its contents, the
instruction executes.

The final instruction tells the ARM to
branch back to the label “loop” ifi and j aren’t
equal. Notice that at no point here does the

it can get more
done for per

canrunona
lower clock
frequency with-
out too much
loss

ARM have to jump to different memory loca-

tions—saving precious nanoseconds.

This clean, efficient way of going about
things means that the ARM doesn’t have to
fight a Megahertz war—it can get more done for
per clock cycle, so it can run on a lower clock
frequency without too much loss. Lower clock
frequencies translate to less heat generated

within the chip, so the only thing heating up
your ARM is probably the sunlight that you're

basking in.

Jargon Buster

Registers

Every processor has a number of registers built right on to the chip.
These serve as temporary storage for data or instructions that come
into the processor, or for storing important information like the
processor’s current state, or the memory address that it needs to
access next. This is the fastest possible storage in your PC, so
wasting it is a processor design no-no.

Assembly Language
When you give instructions to a microprocessor, you do so in
Assembly Language. The instructions involve very granular

5 operations in the processor—moving a byte of data from the main

memory to the processor’s internal registers, for instance. You write
assembly code in the form of mnemonics—MOV, ADD, DIV and so on,
which are then converted to hexadecimal operation codes or op-
codes, which are finally given to the processor.

Microprograms

Microprograms (written in microcode) take op-codes and convert
them into real processor actions. The ADD instruction, for instance,
will bring numbers from the system’s memory to the processor’s
registers before adding them—it’s the microcode that implements
this part. Microcode is hard-wired into the processor when it’s
designed, and optimising it for performance is right up there with
the designers’ biggest headaches of all time.

;set condition "NE (not equal)" if (i I=j)

Megahertz war—

clock cycle, so it

Coffee With Jazelle

We’ve no doubt talked about how Java works
before, but here’s a refresher anyway: when you
compile a program written in Java, it doesn’t
get converted to the assembly code for the
processor you’re working on. Instead, it’s trans-
lated to Java bytecode, which runs on the Java
Virtual Machine (JVM). The JVM then translates
the bytecode to assembly language for the
processor. The advantage here is that unlike
other languages, where you write different
code for different platforms (very tedious), you
write code just for the JVM. Now you have code
that will run on any platform that has a JVM
built for it!

The problem with Java, as should be fairly
obvious, is that the time taken for the JVM to
translate Java bytecode to assembly causes it to
take a huge performance hit; this cannot do.

Enter Jazelle, ARM’s way of combating this
performance lag. The Jazelle Direct Bytecode
eXecution (DBX) makes a JVM for ARM redun-
dant—the ARM7, ARM10, and ARM11 families of
processors can now run Java code directly! If
you’'ve ever experienced the tedium of using a
Java application on your mobile phone, this is
a ray of hope. To see the difference that Jazelle
makes, watch the video at http://[www.arm.com/
products/esdfjazelle_home.html.

Bells And Whistles

RISC works wonderfully with data that comes in
long, continuous streams—video and music, for
example—making it a natural choice for any
portable multimedia player (PMP). The iPod,
among many others, sits on an ARM7-based
processor, which is built specifically for multi-
media. It’s tiny, fast, and lasts hours on a single
battery charge. Among the other licensees of the
ARM, Freescale Semiconductor builds the i.MX,
based on the ARM9 architecture. These proces-
sors feature on-board Multimedia Card (MMC)
and Memory Stick controllers, a Multimedia
Accelerator chip and a Bluetooth accelerator. The
architecture supports Windows CE, Linux and
Symbian, and you’ll be seeing devices based on
this in the next few months.

Pocket Powerplants

With the world going mobile and the new
emphasis on performance per watt, we've
started seeing new developments in processor
design, which now permit even the good old
x86 processor to be plonked into a mobile
device. Samsung’s Q1 Ultra runs a low-voltage
Intel Core 2 Duo, and runs Vista Home
Premium with no problems at all! The three-
and-a-half hour battery life is disappointing,
but the fact that a desktop-class processor can
run in this environment is an indication of
things to come.

But does that mean that the ARM will
become obsolete? For a long time, no. There’s
hardly a competitor in the battery life depart-
ment, and even when it is muscled out of the
PDA | UMPC market, portable media players and
smartphones will ensure that the ARMs still
have punch. B

nimish_chandiramani@thinkdigit.com
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Information
and objects
interwoven with
what you see
and hear?

Overlay Mode

Ram Mohan Rao

can be distracting. But they’re useful when

you’re using the app for the first time. You
see “Speaker Mode,” and the balloon says “Click
this to change output settings.”

On TV, you've doubtless seen those arrows and
circles overlaid on and around players in a cricket
match. “Now this fielder here,” says Boycott in his
loovly Yorkshire accent, and a red circle appears
around the fielder. “Cooms oop to long-on,” he
continues, and an overlay arrow appears, pointing
in the direction of the shift.

So here you have two silly examples of a field
of research we’ll soon name. But a not-so-silly ques-
tion: what do the balloons and the arrows have in
common?

Figuring the answer requires no great stretch
of the imagination. In both cases, information to
augment your visual focus is being brought in:
information to aid you in understanding what
you're looking at.

Now let’s stretch our imaginations a bit: if
information can be overlaid, why not other things?
Take your favourite FPS around with you in the
real world! Overlay the game—with all its
monsters—on what the “real” world is providing
your eyes—buildings and all! So as you’re walking
to work or college, monsters abound—one on the
road, one behind your office building...

Pop—up information balloons in applications

Notice we said “real” in quotes. That’s because
the lines are getting blurred—the lines between
reality and virtuality. We’re going to talk about
“Augmented Reality,” where you'’re in the real
world and your experience of it is enriched in a
useful way. Embedding virtual objects in reality—
as in the FPS example—could be called Augmented
Reality as well, but it’s more like “mixed reality.”
Or should that be “Augmented Virtuality”?

The Terms-And-Definitions Mess

This is not a textbook, and we hate terms and defi-
nitions as much as you do. But we do need to get
some things straight. Real Reality (hopefully) needs
no explanation, but when it does, a professional
philosopher needs to step in. We don’t have one
in-house, so we’ll leave that out.

Virtual Reality (VR) is total immersion in a world
divorced from the reality around you. You're
sitting in your room with goggles on, which make
it seem exactly as though you were on Mars. There’s
no overlaying of anything anywhere. Period. And
that’s where we’ll leave it at in what follows.

Augmented Virtuality is concerned with
systems that primarily recreate virtual environ-
ments while introducing elements of reality into
the simulation. It’s a concept not too many folks
are bothered with, so let that be as it is.

Now, there’s Augmented Reality (AR); that
apart, let’s coin a term—Virtual Imagery Superim-
posed on Top of Actuality (VISTA). It’s a nice
acronym, because it does mean new vistas of expe-
rience... and this is a nice place to get started.
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The bowler does his run-up; you see an informa-
tion titbit next to the bowler that states his name.
When he delivers his ball, you see the speed in
kmph. You’re seeing all this with your eyes, because
your goggles are tuned in to various information
sources—and they are displaying the “extra”
information, the primary information being the
plain scene of the ground. (Everything is informa-
tion, right?) That’s AR.

Then, look at the scene below. If you haven’t
been to our Fair City, you might not know the
monument on the left is The Gateway Of India—so
your goggles tell you that bit. You can also see
whether rooms are available at the Taj just oppo-
site, and more... That’s the vision some have for
AR. Well, not the vision; it’s an example applica-
tion that can aid tourists. The actual number of
applications for AR are very, very many.

An aside: we’ve overdone the goggles. AR can
also be done using Head-Mounted Displays—the
way it’s being done in most research labs now. It
could be a cell phone with a camera. It could even
be implants in your eyes.

How?

If you’ve been brought up normally, you're proba-
bly wondering how AR can possibly work. Where
does the extra information come from? How can
it be overlaid? In fact, those happen to be two core
questions. The first is to get the information; the
second is to overlay it so perfectly on what your
eyes see that it becomes one blended scene. Yes,
there can be augmented hearing and smell and
all, but let’s keep it simple and only talk about
augmented vision.

A lot depends on the complexity of what is to
be achieved. Think of a relatively simple applica-
tion, like helping a newbie repair computer hard-
ware. When he looks at a motherboard through
his AR system, it could label the ports, slots,
jumpers, and such. What this demands is an
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information system that knows the motherboard
in its entirety, well enough to label it. Why it’s rela-
tively simple is because the system need not know
where the person is.

Extend this to the picture on the previous
page. What needs to be known? Obviously, your
physical location, and a database of things at that
location. It’s easy to imagine the former being
supplied by a GPS device. (Easy to imagine, but
hard to achieve—imagine GPS to the accuracy of a
millimetre!) It’s also easy to imagine the latter
being supplied by a database created by a tourism
company. An ad agency could supply additional
information to that database—that’s how you’d get
the price of the car and where it’s available.

Things could get more advanced: picture some-
one walking down the street wearing Guess jeans,
and an ad popping up telling you what store is
discounting them! Now that does sound far out,
but it’s not impossible. Think, for instance, of a
world where everything had RFID tags on them.

What is called “registration,” however, is a
rather hard problem. It’s about the extra infor-
mation being properly overlaid on the real scene.
‘When you move your eyes to the left, the tags need
to shift appropriately so they still point to the
correct objects—and that requires a complex head-
tracking mechanism. We cannot here go into the
details of how that is achieved; in any case, we’re
trying here to tickle your imagination, not go into
boring technical details!

AR At Work

Although AR has not been entirely ignored,
science fiction writers tend to emphasise the VR
experience. It’s cooler. But AR is as much of an
exciting possibility, if not more so, than VR. With
an appropriate technique, AR can enhance any
scene. Scour the Web and you’ll see what countless
people have envisioned. Here’s a little sampler.

[H A mechanical engineer is working with a piece
of machinery he’s never touched before. As he
wields his gas cutter, he sees, neatly labelled,
the parts of the object he’s not familiar with.

[ A doctor needs to make a cut in an open brain,
and his AR system shows him precisely where it
is safe to make the cut.

[M A road is being dug up, and water pipes are to
be avoided in the process. Say there’s a database
of the pipes in the city. You can then imagine a
camera-based AR system that allows the diggers
to “look” at the pipes under the road.

We haven’t even begun to scratch the surface.
Those examples were just to get you thinking.

Who’s Doing What

At the University of Cambridge Department of
Engineering, they're developing what they call
“Robust Model-based Tracking for Outdoor
Augmented Reality.” You point the AR device at an
object, and the device detects the edges. Any
labelling—as in augmenting—can be done only
after the edges have been determined.

Edge detection—seem simple? Actually, the
technicalities are way too heavy to go into here!
Even for this starting point—detecting edges—you
need gyroscope measurements, measurement of
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gravity and magnetic fields, and more!

Nokia’s Mobile Augmented Reality Applica-
tions (MARA) project uses camera-equipped mobile
devices for “video see-through mobile AR,” mean-
ing that it can overlay information right on the
cell phone’s screen, depending on what the
camera is being pointed at. We learnt from
http:/[tinyurl.com/32tmkx about such a prototype
phone: it is equipped with MARA software, and
hardware including a GPS, an accelerometer, and
a compass. Conceptually, it’s simple. As the phone
captures a video stream, MARA collates informa-
tion from the aforementioned hardware to
pinpoint the location and orientation of the
phone. It then looks in a database to determine
what objects should be visible when the camera is
at that location. (The database could be on the

If AR broadcasts
are to be
received from
some kind of
central agency—
either a govern-
ment, or a large
corporation—it
could result in
the ultimate in
mind control
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Just one aspect of the AR problem. User points AR device at object; device

collates lots of measurements; edges are detected. Even this is hard!

phone, or accessed remotely.) Some pattern match-
ing is involved here, and once it’s been established
what objects are being viewed by the camera,
MARA highlights them and provides information
about them (and hyperlinks, if available in the
database). You can imagine the rest: if a restaurant
is being viewed and is also in the database, MARA
could (potentially) display the menu and wait
time. If there were a hyperlink as well, you’d be
able to visit the restaurant’s Web site!

Watch the videos at http://tinyurl.com/y883yj.

VISTA: The Middle Ground

What we were calling VISTA (Virtual Imagery
Superimposed on Top of Actuality)—the infusion of
virtual elements into a real scene—is, as we said,
something like mixed reality. Strictly speaking,
according tomany people’s definitions, this is AR—
because it’s all about augmenting a scene. We’ve
coined the term VISTA because we think AR
enhances the reality you're experiencing, while
VISTA is adding virtual elements that shift focus
away from the “reality.”

Consider these useful applications:

[} An interior designer can have a view of the
before-and-after scene: He sees a room as it is,
and when he presses a button on his Head-
Mounted Display, his planned additions—like a
sofa—appear as though they were in the room.

[0 Here’s a gem of an idea we found on the Net:
“Don’t like your office environment? Add
plants, waterfalls, and hummingbirds to
your office with the ‘sounds of nature’ soft-
ware module. Is your significant other
unbearably ugly? Overlay their natural face

with any character using the ‘augmented
people’ module.”

Then, from http://tinyurl.com/35jpxo, we
learn that a system has been developed for tourists
at sites such as Pompeii to be able to see the people
who lived there before the eruption of Vesuvius
destroyed the city. They're calling it a “break-
through prototype AR system”; it can add “digital
people” and other computer-generated, animated
elements in real-time to what you “actually” see.
Again, “actually” is in quotes, because... oh, well.

Turns out someone’s actually designed an AR—
read VISTA—version of Quake, in which the
monsters are overlaid on the real scene in front of
you. Read about the ARQuake Project—and watch
the videos—at http://tinyurl.com/c6459.

We said it, and we’ll say it again—the applica-
tions are limitless. The US military has been doing
VISTA-oriented research for many years now. The
possibilities? How about this one: there is data on
the construction of a building, with its entrances
and exits; a soldier with a Head-Mounted Display
would see all these at once instead of just the one
entrance he’s facing. Then, think about training:
soldiers could “face” troops and tanks and all,
while actually situated on real ground, and
perform the appropriate actions.

Closing Thoughts

Some aver that AR is a potentially dangerous
technology. When it becomes commonplace,
you’d have to get your “broadcasts” from some-
where—for example, we said ad agencies could
send their information to the information
servers so that the ads get displayed along with
tourist-aiding tags. Now if those broadcasts are to
be received from some kind of central agency—
either a government, or a large corporation—it
could result in the ultimate in mind control. The
reality you perceive would be controlled by some-
one else! If the idea is not clear, think about how
much of our minds is controlled by Google today.
With that as a real-life example, think about
“subscribing” to AR channels, and how they’d
influence your perception of reality.

Continuing along the lines of “subscribing to
channels,” think of how exactly you could use AR.
As a tourist in Kenya, you’d subscribe to the
Kenyan tourism broadcast. On a trek, you’d tune in
to “Nature”—and trees and shrubs and little furry
animals could get tagged with their names. Just
for fun, at a high-profile business meeting, you’d
be able to figure how expensive the business suits
around you are. Talking to someone who doesn’t
speak English? Use translation AR, and you’d
“listen” to the person in English.

We’ll leave the fantasising to you. But we need
to reinforce that AR and VISTA aren’t fads;
research is red-hot and people are dead-serious
about it. (Please remember, only we coined
“VISTA”!) But it might just lead to nothing much,
going the way of VR—if you remember how wild
people were about VR a decade and a half ago.

Ultimately, it’s about potential. To use a cliché
and an obvious phrase, we’ll end by saying that
Augmented Reality has the potential to funda-
mentally change our life-experience. B

ram_mohan@thinkdigit.com
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/" Canon A710|s

~ Michael Browne

Day 1

She lay nestled inside q soft-foam bouch, al] alluring tones
of silver and steel-.grey with dark 8ray highlights. The
A710IS is g beauty! j

optical zoom (35 ~ 27
2.54inch LCD viewfinder.

Day 2
The A7101S is compact for the featyyres. The ergonomic
contours allow

Day 5
I replaced the default screen Protector with g transparent

of my office
urroundings at the Ayt setting. Shot
1y 800d even with ng tweaks—good detailing,
and very good coloyr rendition,

Day 8
Based
has

Day 11

The large optical zoom on the A7101S (6x) is &reat. An S3IS
) oting modes, but I styck to
brogrammed mode—halfway betweer,

manual and auto modes.

individually tweaking reds, greens, and blyes,
The AF light is q Tite intrusive. Upon being the test
subject I muyst say it’s very bright, and very
red. The flash tones down really nicely for
shots where it jsn’t needed much,

Day 16
There’s a custom White balance setting,

where you can Dboint the camerq gy ¢

white object and set the white balance.

This setting is remembered even if the

camera is turned off. For outdoors, stick

With auto white balance settings; indoors means
Switching to manyql.

Day 20

Shot a few videos. It’s capable 0f 640x480 videos at.
30 fps—very 800d. You can also d 320x240 clips qt
60 fps. Overall, SmMooth videos JSree from most
compression artefacts. Yoy, can use the

optical zoom on the camera while

shooting, and the IS kicks in to give

You jerk-free movies,

Day 25

4,500 (street Dbrice). For those
looking for q boint-and-click with a good dose of
manual settings and lot of goodies like image
Stabilisation: get the A7101S!

michael_browne@thinkdigit.com
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abletkiosk’s latest entry into the ultra-micro-PC
market is the eo TufTab v7112XT which, quite frankly,

isn’t meant for business executives sitting in air-
conditioned offices. It’s suited for what people at tabletkiosk
like to call "non-traditional” working. The entire device is
packed in plastic and rubber, but it’s not just cosmetics: what
you get;is:a:7-inch screen with a resolution of 1024 x 600, 1
GB of RAM, a 1.3-megapixel camera, and a 40:GB hard drive.
That’s not all=security is taken
care of by the biometric
fingerprint reader: No
keyboard here—just a‘fancy
stylus and a touch-screen.
You can choose 'to run
XP, Vista, or Open SuUSE
onit, and pick
between black and
white models. Cost?
About $1,700 (Rs
76,500).

tabletkiosk eo TufTab v7112XT ¢

Novint Falcon
he Novint Falcon:is a pioneer in a
completely new dimension of interaction
with PC applications. It lets you feel
virtual objects. Sure, there were mice with a little
bit of rumbling when you moved your cursor over

toolbars and scrollbars, but this isa lot more
than that. It uses three motors which move three
separate arms, pulling:and pushing, a thousand
times a second!

This makes for a very realistic feel of objects
and-the action. The possibilities are endless—
imagine the recoil of a‘railgun, the weight of
balls, and the sensation of swinging a bat. The
motors move the handles such that you feel
various resistances and textures of objects. The
device also lets you click, select, and feel objects
in 3D game spaces...

Expect to see the Novint Falcon in the
market in the next couple of months.

The good stuff.
Stuff to lust after.
Stuff for the well-moneyed.

MOTORAZR maxx Ve

Motorola’s
T MOTORAZR range
of phones'has

evolved into this new j
phone they’ve called the /#
MOTORAZR maxx VE. It /|
has external and
internal screens and
touch-sensitive
illuminated media
player keys on the
outside. It comes

with 60 MB of
memory, which can

be enhanced to 2 GB via

the expansion slots. Wireless connectivity is via
Bluetooth and EvDO, which offers blazing fast data
transfer rates. It has'a 2 MP camera with 4x digital zoom
for still images. Videos can be played, recorded, or
shared using MPEG4 or H.263. What it really is, more
than anything else, is a fashion statement. Due out soon,
there’s no price tag yet.
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Nokia Aeon

two touch-sensitive areas, separated by a solid:divider that
will house the fuel cell. Also, thanks to the two touch-screen

Digital Passion | Droolmaal

eyl
»
“a

- Xbox 360 Elite

color scheme—far better than that white

chocolate thing they had going earlier. They’ve
even replaced the minuscule 20 GB hard drive
with a much more substantial 120 GB external

drive. This new version has HDMI'and IPTV.

ost people may think of the new Xbox 360
EIite as just another stupid gaming

console for stupid gamers. It is, actually,
but now it comes with a far more attractive black

support. It has a wireless controller and headset,

and is a limited edition. If you want an Xbox but
want to be different, this is the only choice you
have. It will cost.you $479.99 (Rs 21,500) and will
have been released by the time you read this.

.°§'.

he Nokia Aeon is definitely one of the sleekest-
looking phaones we've come across—perhaps only
rivalled by Apple’s iPhone. The surface is split'into

areas, you can switch control to either one for a different

sort of application, such as a media player or a text pad, for

example. Rumours say this phone can also monitor your

health:

details pending. It’s still a concept phone being

developed by the Nokia Research and Development
department, so there is no release date...

yet. It would be a shame if such a

concept.were to be
dropped. We

sure

hope
Nokia'is
listening!
Write them a
mail and express
your interest...

W .% LY
g B
N i
.. .. ..
00000 00000 00000
() () ()

“%* sony VAIO TP1

he Sony VAIO TP1 is a cool-looking Media Center PC. At
first glance, you might mistake it for another Apple
product. We actually wish Apple had used this design for
their Apple TV! HDMI support means you can hook this baby up
to your HDTV. Wi-Fi support is inbuilt, and the memory card
reader and USB ports will let you hook up your camera and
memory cards to upload media to the Internet using the wireless
connectivity. You can navigate the Sony VAIO TP1 using the
laptop-style touchpad, less cumbersome than the boring
trackball on some cheaper Media Center PCs. As features and
horsepower go, this is no lightweight: a Core 2 Duo, a whopping
2 GB of DDR2 RAM, IPTV support, and a DVD-Writer. It should be
out anytime soon, with a price tag of around $1,600 (Rs 72,000).
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How would you boot into
Windows XP via your dust-
covered floppy drive?

Send in your solution with
the subject “Take a Crack”,
and your postal address, to
takeacrack@thinkdigit.com

LAST MONTH’S CHALLENGE [

Take a Crack
and win

PC Upgrade & Repair
Street Smarts
by James Pyles

Published by

WILEY-INDIA

LAST MONTH’S WINNER

Abhishek Kumar
Tamoli
Hathras, UP

Rules and Regulations

[H Readers are requested to
send in their answers by the 15"
of the month of publication.

[ Employees of Jasubhai
Digital Media and their relatives
are not permitted to participate
in this contest.

[ Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

[E Jasubhai Digital Media is
not responsible for any damage
to your system that may be
caused while you are trying to
solve the problem.

DIGIT MAY 2007

THIS MONTH’S CHALLENGE

Boot Into XP
Using A
Floppy!

Create A Special Folder In Windows Explorer

Last month’s solution
How can you create a folder like My
Documents—one that will appear as a
system folder in XP?

Here’s how to create a custom folder in
My Computer, one that can’t be deleted or
renamed.

Step 1

In the Registry Editor, navigate to
HKEY_CLASSES_ROOT\CLSID. Create a new
key with a Globally Unique Identifier
(GUID). The GUID is a 128-bit identifier that
is usually generated by Windows. This can
be a random number that is used to
uniquely identify COM objects. Create a key
using this random GUID:
{FD4DF9EO0-E3DE-11CE-BFCF-
ABCD1DE12345}

Step 2

Set the value of the “(Default)” setting for
this key to the name of the folder, say “My
Personal Data”. Create a new sub-key under
the main key and call it “Defaultlcon”. That
is, create a key called:
HKEY_CLASSES_ROOT\CLSID\ {FD4DF9E0-
E3DE-11CE-BFCF
ABCD1DE12345}\DefaultIcon

Set the value of “(Defaultlcon)”to the
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= 53,

Edit the Registry to make the changes

filename and path of the icon file you want
to use for the folder, for example,
“C:\Topsec.ico”, without the quotes.

If you don’t specify a path to an icon

file, Windows will use its default folder icon
instead.

Step 3
Create another sub-key under the main key
called “InprocServer32”, that is, create the
key called
HKEY_CLASSES_ROOT\CLSID\ { FD4DF9E0Q-
E3DE-11CE-BFCF-
ABCD1DE12345}\InprocServer32

Set the “(default)” setting here to
“shell32.d11”. Create another string value
called ThreadingModel and set its value to
“Apartment”. There’s one more: create
another sub-key called
HKEY_CLASSES_ROOT\CLSID\ { FD4DF9EO-
E3DE-11CE-BFCF-
ABCD1DE12345}\Shell\Open My
Folder\Command

Set the “(Default)” value here to the
command that should be executed when
the folder is clicked. In this case, it would
be “explorer [root,c:\My Personal Data”.

Step 4

There’s more keys to be created:
HKEY_CLASSES_ROOT\CLSID\ { FD4DF9E0-
E3DE-11CE-BFCF-ABCD1DE12345}\ShellEx\
PropertySheetHandlers\ { FD4DF9EO-E3DE-
11CE-BFCF-ABCD1DE12345} and
HKEY_CLASSES_ROOT\CLSID\ { FD4DF9E0-
E3DE-11CE-BFCF-
ABCD1DE12345}\ShellFolder. Under this
key, create a new binary value called
“Attributes” with the value “00 00 00 00”.

Step 5
To place the folder in My Computer, add the
original key to
HKEY_LOCAL_MACHINE\SOFTWARE\Micro
soft\Windows\CurrentVersion\Explorer\
MyComputer\Namespace\
So the key value will be
HKEY_LOCAL_MACHINE\SOFTWARE\Micro
soft\Windows\CurrentVersion\Explorer\
MyComputer\Namespace\ { FD4DF9E0-
E3DE-11CE-BFCF-ABCD1DE12345}

Now go to My Computer, and you’ll see a
new custom folder! m
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One day everything’s fine and dandy;
the next, poof! Bye-bye data...

Agent001

en or 12 years ago, when I got my first '

taste of Windows 95 and Windows 98,

using a computer was a privilege. Today,

it*s almost a right. The way Fuse a com-

puter has changed as well. What was
once a tool to work on Excel files and send official
e-mails to the four people I knew who
had e-mail addresses is now like a
life-support system I cannot live
without. I have about 10 GB of e-
mail in Outlook, everything I've ™
ever written for Digit, over 40 GB of
MP3s (no, they’re not pirated, I own
the CDs), and hundreds of GBs of movies
ripped from my DVDs. Apart from this,
there’s pictures of every vacation I've ever
taken, some funny things I found online, and an
entire 120 GB hard drive dedicated to software I
like—freeware and shareware. The software is,
obviously, expendable, and is the first thing I start
getting rid of when I need space, but everything
else is irreplaceable!

Now this is my home computer. My office
computer has a lot less personal data, but a lot
of important documents, e-mails, spreadsheets,
and such.

Recently, two people in the Digit team had
hard drives die, and lost a lot of personal data. Of
more urgent concern was the fact that they lost
work they had just completed, and had to begin
from scratch. Now they’re busy trying to recover
data from their lifeless disks. Whether or not the

Disaster-

data is worth the Rs 10,000 to Rs 20,000 that data
recovery experts will charge to “attempt” to
recover the disks’ contents is something each
one of us decides only after facing the dilemma.
But why do we?

Just yesterday, I got a call from a damsel in
distress. Her laptop just stopped working, and
now gives her the weird error message “Oper-
ating System not found.” It’s a branded laptop,
and still under warranty, so getting another
hard drive and a fresh install of the OS is free.
Recovering 10 years of memories, which she had
stored on the disk in the form of digital pic-
tures? Rs 15,000, and they’ll recover what they
can. I can’t even help her, because if I open up
the laptop to remove the drive, the warranty

Imaging Chaitanya Surpur
Photograph Jiten Gandhi
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becomes void. What do you do in a sit-
uation like this?

Absolutely Nothing!
You take the news like an adult,
remain calm and stoic, and move on. You
still have that horrible feeling—the
kind that feels like someone just
ripped out your intestines—but
hey, when technology goes wrong,
it does so horribly. Life goes on.
What you can do, however, is learn from the
mistakes of others, and try and safeguard your-
self from ever having to be in this situation. My
mind is a lot more at ease now because I've taken
a few steps to prevent such disasters. If you have
data that’s really important to you, you should
seriously consider following in my footsteps.

RAID

You’ve heard it a million times, everyone has
heard about RAID, but how many of us have
found out enough to actually use it?

RAID, or Redundant Array of Inexpensive
Disks, can either be used to improve performance
or to back up your data. The most common forms
are RAID are 0 (Striping) and 1 (Mirroring).
Striping improves performance, because it uses
two disks as one. Basically, it breaks up data into
two and writes one part to one disk and the other
to the second disk. This results in faster perform-
ance, which is great because the hard drive is the
bottleneck in all current-generation PCs. Of
course, this also doubles your risk of losing data,
because even if one disk dies, you lose all the data
on both disks. Only gamers and those who need
faster hard drives usually use RAID 0.

RAID 1, or Mirroring, may even result in a
performance hit, but creates redundancy. Say
you have two 250 GB hard drives, and set them
in Mirroring mode. Windows will see them as
one 250 GB hard drive. RAID 1 works by writing
all data twice—once each to the two drives. What
this does is create two copies of everything, so
say if one hard drive dies, your system will just
continue running like nothing ever happened.
Beautiful, isn’t it?

Most of us don’t use RAID because it requires
you to have two hard drives, preferably identical.
So you end up spending double the money, and
end up with a quite ridiculous cost-per-GB figure.
However, after the three recent incidences of hard
drives playing foul that I came across, an extra Rs
4,000 to mirror my existing 250 GB drive is worth
it for the peace of mind I now have.

If you decide to use RAID 1, I suggest you
keep your operating system on a third drive, so
that formatting and reinstalling or virus attacks
cannot threaten to wipe out your data. For
example, I have an 80 GB drive that holds my OS
and download folders, while my dual-250 GBs
are in RAID 1, and hold everything that’s dear to
me. The advantage is that I find the perform-
ance of my PC to be a little better, since the OS
just reads and writes to my 80 GB, and mainly
reads from the mirrored drives (when I'm
playing audio or video or viewing pictures), and
sometimes writes to both (when I back up
important stuff). This helps to ensure that both

disks last me a long time.
Stuff to remember: Check if your moth-
erboard has RAID controllers—most
motherboards made in the last two
years will. Next, go out and buy two
identical drives—although not neces-
sary, it will save you from the poten-
tial headaches of mismatched sizes.
"% Checkyour motherboard manual for
instructions on how to set up RAID,
or if you're buying a separate RAID
controller, follow the instructions given in the
manual that accompanies it. Remember, for
{ motherboards with onboard RAID controllers,

you will need to enable it from the BIOS.

Power Problems

Most people think of a UPS (Uninterrupted Power
Supply) as a backup source of power. Being a res-
ident of Mumbai, I can literally count the number
of times I've witnessed power outages on my fin-
gers—I can actually use just one hand to count
the times the power’s gone out and my PC was
on. Like everyone else, I used to think I just don’t
need a UPS. About two years ago, the local trans-
former blew up—literally, with sparks, flames and
the works; quite exciting that, and really pretty
because it happened at night... Anyway, getting
back on track, I was working on a write-up, had
some downloads running, and had my regular
applications running—anti-virus, image editor,
MS Word, MS Excel, a media player, a few IM appli-
cations, etc. When everything went black, I was
actually relieved, because I figured I'd take a long
overdue break from writing, and went out to see
what all the commotion was about.

A few hours later when the transformer was
repaired | bypassed | <whatever they did to fix
it>, the power supply resumed. The first thing
I noticed was a dark patch around the back of
my SMPS. Pressing the power button on my PC
confirmed my fears—a blown power supply. A
day or two later, I went out and bought a new
SMPS, only to come back and find that the
motherboard also seemed to be fried. Appar-
ently, just before the transformer blew up, it
sent out way over the normal 240 volts for a
split second, and that seemed to have fried a lot
of my components.

One by one I replaced fried parts,
swearing to never buy a cheap power

i id

iy I supply again, or connect my PC directly

4 to the mains without a spike board in

: the middle. Three days later, I got
TtaupS. everything working again, only to

find that Windows refused to load.
Apparently the power surge
had scrambled data on
my hard drive as well,
because although it was
being detected in the
BIOS, it refused to admit
to having Windows XP.
A re-install later, I
realised I’d lost all my
downloads, my work,
and all the settings and
programs I’d arranged
the way I like it.

UPS’ aren’t just boring old boxes anymore. See the
Bazaar section for more on this product!
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However, the most irritating bit of this inci-
dent is, when my neighbour found out, and just
had to boast of his foresight when buying his PC—
he’d bought a spike guard and a surge-protected
UPS. Very reluctantly,  have to admit he was right.

If your PC is more than just something you
use to check e-mail (in my case it’s actually the
tool I use to earn a living), you need to make sure
it’s safe in every way possible. If you don’t have a
surge protector (UPS, spike guard, or both)
between your PC and the electricity mains in your
house | office, cease, desist, and go and get one
right this instant!

Back It Up

Once I decided that Iwould do everything pos-
sible to safeguard my data, I started looking for
even more redundancy. Although I now use RAID
at work, I decided that at home, since I already
have multiple hard drives—80 GB, 120 GB, and 250
GB—there’s really no point in buying a fourth
drive of one of those capacities and setting up
RAID. If you have only one hard drive, and your
data is vital, getting another drive and setting up
RAID is still the preferred option though.

The next-best solution to RAID is to use
backup software. With RAID, you can safeguard
everything, including your Windows installa-
tion, from drive crashes. Backup software, how-
ever, cannot protect Windows, but will help
make sure all the data you want protected is
backed up. Apart from just making another copy
of your valuable data, backup software has
become a lot smarter.

Any half-decent
backup software
should offer
incremental
backups

For just basic use, you can use Windows’ own
backup utility. Go to Start > Programs > Acces-
sories > System Tools > Backup. You will see the
Backup or Restore Wizard. Just follow the easy
steps to back up your data regularly. If you want
a few advanced features, when the Wizard starts,
uncheck the “Always start in wizard mode” box
and click on the Advanced Mode link. Here you
will find advanced options that will let you
specify the folders to back up, and even set a
schedule for backups. It’s really easy to do, so 'm
not going into the details. There is a lot of third-
party backup software also available, most of
them paid, that will let you do more. If you
choose to buy such software, you should look for
the following features.

Incremental Backups: Any half-decent soft-
ware should offer incremental backups. This

means that if you set

e ~#*  the software to back up,
TR :;ﬂ"'“"“ e say, the Documents and
e - — — 7|  Settings folder—instead
T3 RS of just copying the
Bz tms B entire folder to your
SHIIA, (O backup drive, it should
O15 BCOOS R -
DB st E%E‘:;‘;‘:”" only look for new or
2 e )
'{%_.:wvm 0 Fedeimiduin -l changed files and copy
R Egi}f.;}l“:‘" those. This helps reduce
losmmssmss 0 30 s | the time that the
El— premon e | Dackup takes.
TS Scheduled Backups:
If you have to manually

For simple backup jobs, use the Windows Backup tool
and use Scheduled Tasks to automate them

take every backup, why
do you need software?
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Scheduling will help you forget about the task
and let the PC do the dirty work by itself.

Multiple Jobs: You may need your Program
Files folder backed up only once a month, docu-
ments once a week, and e-mail every day. Make
sure the software will let you create multiple
backup jobs.

Restore: Backing up is fine, but what about
when you need to restore files? If you have set
various folders from various drives to be backed
up, manually restoring them will be a pain.
Make sure the software does it for you.

Registry Backup: This is obviously a feature
you want.

Compression: It’s pointless if you use the
same amount of space for your backups, in which
case you might as well use RAID 1. Look for good
compression of backups, which will use more
CPU power, but save on drive space.

Versioning: You deleted an important file,
and unfortunately, your scheduled backup has
taken place and now the file is deleted from the
backup as well. If you had software with ver-
sioning, it would have kept the past five revisions
of the file, or versions of the last couple of
backups (user-configurable; depending on your
backup size and frequency, you can set this to 100
versions or even “never delete”).

Burning to media: This isn’t very important,
but backing up to DVD is advisable every so often.

Operating as a service: For those of you who
just want to use the backup software to restore
(after installation and configuration), and would
rather not keep looking at it in the Taskbar, run-
ning as a service is a good feature to look for. It
will also prevent you from not remembering
what it was and accidentally disabling it from the
list of Start Up programs.

Real-time: If you have data worth millions,
look for software that takes real-time backups
of files and folders that you specify. This means
that there is a backup of every change made.
These are usually business-oriented software,
and can cost a bundle.

Whoops!
How many times have you said that? I have. Quite
often actually. One of the problems of being a tech-
nology enthusiast is that I just cannot leave well
enough alone. I just have to tinker and try new
things. Most of the time, I'm trying new software,
fiddling with hardware, and playing with my OS.
The Windows Registry is my favourite toy, and I
can’t even count the
number of times I've
had to reinstall Win-
dows because I made a
Registry boo-boo.
Thankfully, System
Restore ended most of
those problems when I
got to Windows XP.
Software, however,
is still the bane of my
PC, because if I find
something even
remotely interesting
online, [ just have to try
it. With an increasing
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Software,
however, is still
the bane of my
PC, because if |
find something
even remotely
interesting
online, I just
have to try it

You can use Altiris to see what progfams do to your PC
when they install themselves

number of applications bundling adware and
spyware, this results in my having to do a
formatreinstall cycle at least once in two
months. IfI try and take the geek’s way out, and
clean up all those extra files and data that are
left behind even after you uninstall an applica-
tion, I usually end up getting over-excited and
deleting something I shouldn’t have from the
Registry—format-reinstall time again!

However, it’s thanks to this very desire that I
have found the perfect solution. I stumbled
across Altiris Software Virtualization Solution
(ASVS). Altiris is now part of Symantec, and you
can download this gem of an application from
www.svsdownloads.com. It’s free for single, non-
commercial use, and I use it at home religiously.

Basically, what ASVS does is form a layer
between Windows and any software installer and
then track exactly what changes are made to the
system when the installer runs. So from Registry
entries to files that are written, everything is
recorded. You can choose to leave the new layer
enabled and run the software, or just disable it
and voila! Your PC is restored to exactly the state
it was in before you installed that software. If you
decide that a software might be malicious, or are
just plain get fed up of'it, delete the layer and bid
farewell to any changes it made while installing.

In order to use it, just download the latest ver-
sion, register, and get your license key. Once
installed, ASVS asks you to restart your PC. Start
ASVS, go to File > Create New Layer... (or press
[Ctr]] +[N]), and a Create New Layer dialog box will
pop up. By default, the radio button next to
“Install application” is checked; just click Next.
Now you will be prompted to provide a layer
name—a good practice is to provide a name
indicative of the software you’re installing. So, if
it’s, say, IrfanView you’re installing, put in “Irfan-
View” as the name. Of course, you're free to put
“Best damn image software on the planet,” or
“irfi-baby” if you like, just so long as you can easily
identify what application that layer refers to.

Now you can either choose to do a “Single pro-
gram capture” or a “Global capture”—the differ-
ence is that when you do a Single program
capture, ASVS looks only for changes made by
that particular software, while Global settings
look at all changes made in the system during the
period of capture. When installing software, just
choose “Single program capture” and choose the
installer EXE. Now go about installing the soft-
ware as you usually would. Once the installation
is done, ASVS stops capturing, returning only to
track any more changes that the software
makes.When you want to get rid of the applica-
tion, or even hide it, just start ASVS, select the
layer in question, and choose Deactivate Layer to
hide the installed software, or Delete Layer if
you’re done with it and want to completely
remove it from your system. Using ASVS, you're
sure to keep only the software you need, or even
hide applications you don’t use very often.

This brings me to the end of the paranoia I've
faced in the past few weeks. I hope these simple
things will be of as much help to you as they were
for me. I know I can now sleep better at night,
without fear of PC disasters.

agent001@thinkdigit.com
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the Nokia 5300, can neither be held comfortably
nor can it be easily carried in the pocket.

At first glance, the heaviest phone in
this category at 130 grams, the jet-black
Nokia 3250, appears to be the most
ruggedly-built, but once it’s turned
around, the flimsy plastic flap is
revealed. The MotoKRZR K1 and the
colourful Nokia 5300 are extremely
rugged. The W710i is built well with a
pearly white plastic body, but the hinges
seem weak.

The Nokia 6131 has a spring-action, but-
ton-activated lid; it is rugged as long as it is
closed, but once opened, it reveals its internal
LCD without any glass protection, and you
need to take special care of it.

Ease of use was a difficult parameter to
gauge: each phone has its own interface, and
ease of use just means getting used to it. We
tried to gauge this from the point of view of a
person handling the phone for the first time.
The Nokias have the familiar Symbian-based
interface, which is as easy as using Explorer in
Windows. SE has its slick interface, which is also
pretty easy to handle. Motorola’s interface is not
as intuitive as those of SE and Nokia.

K550i

BESTBUY
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Sony Ericsson CyberShot

A Camera-mobile or a
Mobile-camera?

The candybars are generally the most easy to slip Therefore, a dual-band phone is good enough
into a pocket. The W710i is designed to be to be used here. But if you travel abroad, you
strapped to your body, and has applications that need a tri-band or even a quad-band. The
monitor parameters such as speed and distance Nokia 3250 and 5300 only support tri-band,
covered while jogging. The lone slider phone, while the rest support all four bands.

The SEs and Motorolas have a display reso-
lution of 176 x 220; the Nokia 5300 and 6131
have higher resolutions of 240 x 320. Even
with a large display, the Nokia 3250 still has
an (odd) lower resolution of 176 x 208, which
makes images look a bit pixelated. The Nokia
6131 is the only handset with 24-bit colour.

GPRS with EDGE are standard on all the
phones, and allow you to connect to high-
speed Internet (you can expect somewhere
between 100 and 200 Kbps) while on the move.
Nokia’s 6131 and 5300 as well as the SE K550i
boast of HSCSD (High-Speed Circuit-Switched
Data), which allows up to 50 per cent higher
throughput. This may not be important now

with current speeds, but it could become
significant as the offered speeds improve.

Expandable memory is the norm in

mobile phones these days, and all the
phones support some kind of memory
expansion. microSD was the popular for-
mat with most phones, while SE prefers to
go with Memory Stick M2. Only the Nokias fea-
tured hot-swappable memories, which lets
you replace the memory card without the
need to switch off the phone. Of these, the
6131 needs to be opened to access the memo-

The SE K550i is, concept-wise, similar to
the hugely-successful K750i, but the keypad
has been revamped, and not for the better.
The K550i’s keys are narrow bars which makes
them not only uncomfortable, but also
painful, as we experienced after typing in a
few SMSes. The MotoKRZR has the flat keypad
of MotoRAZR fame, a delight to use.

Basic Features
In India, GSM mobile signals are broadcast on
two frequency bands, 900 MHz and 1800 MHz.

Cell phone tests are amongst the most subjective because there
are fewer measurable parameters. For instance, would you
choose a phone with hard-to-press keys and nice earphones, or
vice-versa? It’s therefore mostly about features. We divided the
features into sub-sections:

1. Design and Ergonomics, where we looked at form factor, build
quality, weight, ease of use of the Ul, the ergonomics of the
keypad, and such.

2. Basic phone features, such as support for network bands,
display resolution and colours, the OS, support for installing
Java applications, address book capacity, and Internet and
connectivity options.

3. Memory: internal capacity, expandability, type of card slot, hot-
swappable or not, etc.

4. Camera: still image resolution, auto-focus, flash, lens
protection, available modes, etc.

5. Multimedia: Audio player characteristics such as different
formats and whether equalisers are supported, audio formats
supported, FM Radio, and such.

6. Other, extra features such as voice recorder, voice dialling,
speaker phone, talk / standby time.

ry slot, which takes away the convenience of
hot-swappability. As has been the case with its
predecessors, SE phones require a driver to be
recognised as removable USB drives when con-
nected to a PC.

The Camera

2-megapixel cameras were common—not so
during our previous mobile phone shootout
in this price category. Only the Nokia 5300
and 6131 came with 1.3-MP cameras and 8x
zoom. The Nokia 3250 has a 270-degree rotat-

3 § How We Tested

7. Accessories: Hands-free, data cable, memory card, and more.

Under Performance, we looked at aspects such as signal
reception, voice clarity from the earpiece, speakerphone, and the
hands-free microphone, processing speed, and quality of
captured images and video. For the signal reception test, we
chose three locations in our building: one with maximum signal
strength, the second with medium signal strength, and the third
with almost no signal. We noted the ability of the phone to hold
on to the signal in these three zones, and rated them accordingly.

For the voice clarity test, we chose a location with maximum
signal strength. The hands-free microphone test gauged the
ability of the mic to separate the user’s voice from the ambient
sound. The response of the menus to key-presses was noted, and
also the bootup time of the phone without a SIM card; this
constituted the speed test. Photos and videos were shot in well-lit
locations for the photo and video quality test; zoom was not used,
and the default settings were maintained. The quality of captured
photo and video was, naturally, a subjective test. We did,
however, consider the opinions of multiple reviewers.

52 DIGIT MAY 2007




Digital Tools | Cell Phone Test

ing camera. Zoom is an attractive feature for
many, but more is not always better. The
Nokia 3250 comes with an impressive-sound-
ing 20x zoom, but the fact is it requires a pair
of very steady hands to shoot at anything
above 4x without motion compensation.
Further, this is digital rather than optical
zoom, which means image quality rapidly
degrades as the zoom increases.

The SE K550i is branded “CyberShot”,
which is the brand name of Sony’s camera
line-up. As you might expect, it has the best
camera, and the auto-focus feature only serves
to enhance the already good photo quality.
The lens is protected by a sliding cover (it’s the
only phone with such lens protection). The
W710i also gives good photo quality, followed
by the Nokia 3250 and the MotoKRZR. The SE
K550i is also the only camera in this range
that comes with a flash.

Multimedia

The most notable of multimedia features is
the media control buttons that let you easily
access music without having to navigate
slowly through the menus to the media play-
er. The SE Walkman phone W710i and the
Nokia 5300 have rubber-coated, large media
buttons—very comfortable.

MP3 was not the only music format sup-
ported; AAC, too, is supported by all the
phones. The Nokia 3250 even supports other
formats such as WMA. FM radio is common on
all the phones.

Extras
We didn’t actually test battery life, and we’ll
state them as the manufacturer did. The Nokia
3250 has the lowest talk time of three hours, and
the 6131 has the lowest standby time of 200
hours. The SE W710i has the highest talk time of
10 hours and a standby time of 350 hours. The
Nokia phones probably drain the batteries faster
because of their larger display sizes.

The MotoKRZR, Nokia 6131, and SE W710i

il Enhance your low budget mobile

have external LCD displays that let you
keep track of things such as time, missed
calls, etc. Other features such as Organizer,
Calendar, Alarm, etc. were standard fare with all
the phones. V'B'EST BI.IY‘Y
Accessories

Premium phones come with premium acces-
sories. The Nokia 3250 XpressMusic comes
with a hands-free, which has media player
controls in addition to the basic hands-
free buttons. It also has in-ear type
earphones, which effectively cut e
off surrounding sound (by passive
noise reduction), and gives a more
immersive music experience. To
store music, photos, and videos,
these mobiles (except for the Nokia
6131) come with memory cards. The
MotoKRZR, Nokia 3250, and the SEs
come with 512 MB cards, though
you’ll probably soon require a larger
card. The SE K550i comes with a pal-
try 64 MB card, as good as nothing
these days. The Nokia 3250’s hands-
free has a 3.5-mm stereo jack through
which you can connect regular (better)
earphones, while the Nokia 5300 is pro-
vided with a 3.5-mm stereo adapter.

MAY 2007

Performance
Signal Reception
As we’d anticipated, the Nokia mobiles
boasted of the best signal reception. While
the Motorola and SE phones lost signal when
we entered the basement of our building, the
Nokias held on.

Nokia 5300
All about music and colour

Voice Clarity

Through the earpiece, voice clarity was not
much of an issue with any of the phones, though
in noisier environments, the MotoKRZR, Nokia
3250, and SE W710i will prove to be a better
choice. The speaker-phones of the Nokia 3250
and SE W710i have the best audibility. The SE has

orange is a mobile application for J2ME-based phones.

It can unleash new possibilities for a budget phone.
Note that you require a working GPRS connection, and with
that taken care of, you can enjoy the following features with
Morange on your phone.
Push Mail: Morange retrieves mails from your e-mail
accounts and “pushes” them to your mobile: your e-mails
follow you wherever you go, and you’ll never miss any.
Generally, you can only get to know about new e-mails when
you check for them, but with Push Mail, the mails are sent
to your mobile as soon as they arrive on the mail server.
Attachments are also supported, and you can send and
receive mails using both POP3 and IMAP.
Chat: After you register for free on Morange.com, you can
start chatting with contacts on Google Talk and MSN
Messenger using your mobile. Yahoo! Messenger and 1CQ
will shortly be supported.
Remote Desktop Access: By installing the desktop client
from Morange on your computer, you can remotely access
your computer and browse the files and folders on it using

= your mobile phone. You can also
view document in formats such as
Word, JPEG, text, and Excel.

% You can transfer these files to

the 5 MB of free space offered by

Morange.com. Furthermore, you can

even access your PC's Webcam.

MORARCE
T Hobile Edge

Push RSS: Enjoy RSS on your
mobile phone: get the latest updates on news, stocks, etc.
PIM Synchronisation: Using Morange, you can synchronise
wirelessly with your Desktop or laptop, and extend this
facility to the address book, Calendar, and Tasks in
Microsoft Outlook.

Morange can be downloaded from www.morange.com,
and is currently free. Check www.morange.com for pricing
details when it goes paid! The only cost you incur (as long
as it is free) is the data charges for mobile Internet use,
which will be levied by the mobile service provider as
applicable.
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a problem: its hands-free microphone picks up
too much ambient sound, and it seems it does-
n’t filter noise.

Speed
The Nokia 3250 takes very
long to boot—23 seconds to be
precise, though this is not,
of course, a major irritant.
The SEs boot the fastest, in
as little as 5 seconds. The
user interface of the Nokia
5300 is amazingly fast;
that of the Nokia 3250 is
slow, probably because of
its ageing processor. The
SEs have their tried and
tested interface, which is
pretty fast, too.

Imaging Quality
No prizes for guess-
ing this one: the SE
CyberShot K550i
has the Dbest
photo  quality.
This can be
attributed to
its auto-focus
and protected
lens (meaning
fewer scratch-
es) in addition
to better optics.
In video mode, the
Nokia 3250 exhib-
ited better quality,
though it slowed
down significantly every time the zoom level
was changed.

TALK AND CLICK

The phones in this category are not too
expensive, and at the same time, they come
with many of the features of their more
expensive brethren, such as a camera and
multimedia capabilities. These present the
best of both worlds.

For this test, we decided to test some new
entrants into the mobile market. We left
out some of the more popular brands—
those generally perceived as the best—and
we’d like to see if these newer players can
beat what we’ve seen earlier on the more
popular brands!

The phones we reviewed that fell in this
group were the E61 and CL71 from BenQ-
Siemens, the bleu 550X, 551X, 651X and 651Z,
and the Intex AURA 11224 Black.

Sony Ericsson Walkman W710i
A sporty mobile

Featu res .

Design And Ergonomics

The BenQ-Siemens CL71 and the bleu 651Z are
the only slider phones and are the most styl-
ish. The slider makes them look smaller
because the keypad gets pulled in, but these
are, in general, thicker and not easy to carry
in a pocket. The rest of the phones were can-
dybars; of these, the Intex AURA 11224 Black

was the sleekest and thinnest. The bleu 551X
was the lightest phone at 71.4 grams.

The BenQ-Siemens held the edge with bet-
ter build quality, while the user interfaces of
all the phones were equally easy to use. The
keypad of the BenQ-Siemens CL71 was a little
difficult to use because, they are caved in to
accommodate the slider mechanism. All the
bleu phones have a plastic body with a glossy
piano-black finish.

The phones in
the “Talk and
Click” category
are not too
expensive, and
present the best
of both worlds

Basic Features
Barring the BenQ-Siemens E61, bleu 550X and

551X, which had a 128 x 160 display with 65 K

colours, all the rest had a display resolution of

176 x 220 with 256 K colours. The BenQ-

Siemens CL71 can store up to 1,000 numbers

in its phone book, while the E61, bleu 651Z

and the Intex, which were next-best, can

each store 500.

Frequent SMS-ers will love the predictive text
feature which is featured on all these phones.
This feature allows you type in your SMS in a
fewer number of key-presses by
predicting the word as you type, using an inbuilt
dictionary.

The BenQ-Siemens and Intex phones support
Themes that let you alter the looks of the display
interface. All these phones have MP3 ringtone
support.

Java applications are supported on all the
phones, and you can either connect to the
mobile Internet to download and install these
(all the phones support this too), or use
Bluetooth, IR, or USB, as applicable. The BenQ-

Siemens CL71, bleu 551X, and the - .
Intex AURA support Bluetooth, which \"‘BES‘[ Buvr
is already a connectivity norm with

most phones these days. Bluetooth

allows you to exchange data at a rate

faster than infrared.

In addition to having internal
memories, all the phones
supported memory
expandability. The BenQ-
Siemens E61 and bleu 651X
support miniSD, while the
rest support microSD.
Except for the BenQ-Siemens |
E61 and bleu 550X, all sup- |
ported the convenient hot-
swappability of memory. All
the phones connected to a PC
and showed up as removable
USB drives without the need to
install any drivers.

MAY 2007

The Camera
The 651X and 651Z from bleu are
the only two in this category with
2-MP cameras. The rest have 1.3
MP, while the BenQ-Siemens E61
comes with a VGA camera. The bleu
550X, 651X, and 651Z also have a
flash. This is interesting: in the fea-
ture-rich category, there is only a sin-
gle phone with a flash. In this catego-
ry, the BenQ-Siemens E61 is the lone
phone without support for video capture.

bleu 651X
A phone or a webcam?

54 DIGIT MAY 2007




BESTBUY

MAY 2007

BESTB

MAY 2007

i@ Scoreboard The Upper Crest (Rs 10,000 - 17,000)

BRAND Motorola Nokia Nokia Nokia Sony Ericsson Sony Ericsson
MODEL MotoKRZR K1 3250 XpressMusic 5300 6131 CybersShot K550i Walkman W710i
Features (Out of 55) 34.84 38.83 39.20 34.69 39.73 38.30
Design and Ergonomics
Form Factor Clamshell Candybar Slider Clamshell Candybar Clamshell
Dimensions L x W x D (mm) 103 x42x16 103.8 x50 x 19.8 92.4 x 48.2 x 20.7 92 x 48 x 20 102 x46 x14 88 x 48 x 24.5
Weight (gm) 102 130 106 102 85 101
Build Quality (S010) 8 7 8 6 75 7.5
Ease of Use of User Interface (5010) 6 7 7 7 7 7
Keypad Layout / Comfort (S010) 7/7 7/7 7/6 6/6 6/5 7/7
Basic Phone Features
Support for Network Bands Quad-band Tri-band Triband Quad-band Quadband Quad-band
Display Resolution (Pixels) 176 x 220 176 x 208 240 x 320 240 x 320 176 x 220 176 x 220
Display Colours (K) 256 256 256 256 256 256
Operating System Proprietary Symbian 0S v9.1 Symbian S40 Symbian S40 Proprietary Proprietary
Predictive Text (Y/N) ] ] 0 0 O 0
Number of Profiles 3 6 5 6 7 7
Themes Support (Y/N) 0 n] 0 0 0 0
MP3 Ringtones (Y/N) u] ] 0 0 O 0
Support for Installing New Applications / [ 0 0 0 a 0
Games (Y/N)
Internet: GPRS/HSCSD/EDGE 0/0/0 a/o/a 0/0/o 0/o0/o 0/0/o 0/0/0
Connectivity: IR/Bluetooth/USB/Wi-Fi o/o0/0/o 0/o0/o/o 0/0/0/0 0/o0/o/o 0/o0/o0/0 0/0/0/o
Memory
Memory Type(s) Supported microSD microSD microSD microSD MS M2 MS M2
Hot-Swappable (Y/N) ] ] 5] ] O 5]
Works as USB Mass Storage Device (Y/N) [ ] 0 0 a 0
Camera
Zoom (X) 8 20 8 8 4 4
Image Resolution (MP) 2 2 1.3 1.3 2 2
Image Resolution (Pixels) 1600 x 1200 1600x1200 1280 x 1024 1280 x 1024 1600 x 1200 1600 x 1200
Autofocus/Flash/Lens Cover (Y/N) 0/o/o 0/o/o 0/0/0 0/0/0 0/0/o 0/0/o
Multimedia
Audio Formats MP3, AAC MP3/AAC/WMA MP3/SpMidi/AAC MP3/MP4/AAC MP3, AAC MP3, AAC
Media Player Button(s) (Y/N) O O O O 0 O
FM Radio (Y/N) ] ] u] ] a 0
Extra and Miscelleneous Features
Voice Recorder / Dialling (Y/N) 0/o0 o0/o 0/0 0/g o/o 0/o
Talk Time (Minutes)/Standby Time (Hours) 360/300 180/245 190/223 240/200 420/350 600/350
Other External Colour LCD  Rotating keypad NA External Colour LCD NA Ext. LCD, Motion sensor
Accessories
Data Cable / Hands-free/Charger (Y/N) 0/0/o 0/0/o 0/0/o 0/a0/o 0/0/0 o/o/o
Memory Card Provided (MB) 512 512 256 O 64 512
Drivers and Software 0 0 0 0 a 0
Performance (Out of 35) 21.79 22.22 21.72 19.51 22.40 2293
Signal Reception (S010) 6 7 7 7 6 6
Voice Clarity from Earpiece (S010) 7 7 6 6 6.5 7
Voice Clarity from Hands-free Mic (S010) 7 7 7 5 6 6
Voice Clarity from Speakerphone (S010) 7 8 7 6 7 8
Bootup Time Without SIM (sec) 18 23 11 10 5 5
Processing Speed (So010) 7 6 8 6 7 7
Quality of Captured Image / Video (S010) 7/5 6/7 5/5 5/4 8/6 7/6
Price Index (Out of 10) 8.47 6.05 7.49 9.00 8.40 6.73
Overall Score (Out of 100) 65.09 67.10 68.41 63.21 70.53 6796
Price (Rs) 11,898 16,639 13,439 11,191 11,995 14,963
+ Gorgeous looks + Good for music + Responsive Ul +Sleek design + Excellent camera + Music, Camera
- No music buttons - very expensive - Poor imaging - Unprotected LCD - Sub-par reception - Sub-par reception
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{ Talk And Click (Rs 6,000 - 10,000)
BRAND BenQ-Siemens BenQ-Siemens bleu bleu bleu bleu
MODEL E61 CL71 550X 551X 651X 6512
Features (Out of 50) 26.57 29.86 24.63 27.36 30.89 28.27
Design and Ergonomics
Form Factor Candybar Slider Candybar Candybar Candybar Slider
Dimensions (mm) L X W X D 101 x 44 x 17 97 x 46.5 x 17.8 108.4 x 45.6 x16.6  105.5 x 44 x 12.2 100 x 46 x 159 95 x 47.2 x18.2
Weight (gms) 88 115 90 71.4 93 96
Build Quality (So10) 7 7 6 6 6 6
Ease of Use of User Interface (5010) 6 6 6 6 6 6
Keypad Layout / Comfort (S010) 5/4 7/5 6/6 6/6 6/6 5/6
Basic Phone Features
Support for Network Bands Tri-band Tri-band Dual-band Dual-band Dual-band Dual-band
Display Resolution (Pixels) 128 x 160 176 x 220 128 x 160 128 x 160 176 x 220 176 x 220
Display Colours (K) 65 256 65 65 256 256
Address Book Capacity 500 1000 300 300 300 500
Operating System Proprietary Proprietary Proprietary Proprietary Proprietary Proprietary
Predictive Text (Y/N) O 0 0 ] O O
Number of Profiles 5 5 5 1 1 1
Themes Support (Y/N) a 0 0 0 a 0
MP3 Ringtones/Vibrations (Y/N) o/o 0/0 0/o o/o go/o 0/o0
Support for Installing New Applications/ [ 0 0 0 a a
Games (Y/N)
Internet: GPRS/HSCSD/EDGE 0/o/o o/o/a 0/o0/0 a/o/o 0/0/o 0/0/o
Connectivity: IR/Bluetooth/USB/Wi-Fi 0/0/0/0 o/o/o/o 0/0/o0/o o/o/o/o 0/o0/0/0 0/0/o0/0
Memory
Memory Type(s) Supported miniSD microSD microSD microSD miniSD microSD
Hot-Swappable (Y/N) g 0 0 0 O O
USB Mass Storage Device (Y/N) a 0 0 0 a a
Camera
Zoom (X) 5 4 4 4 4 4
Image Resolution (MP) VGA 13 1.3 1.3 2 2
Image Resolution (Pixels) 640 x 480 1280 x 1024 1280 x 1024 1280 x 1024 1600 x 1200 1600 x 1200
Flash (Y/N) a 0 0 ] a a
Multimedia
Audio Formats AAC/MP3/MIDI/WAV/XMF MP3/AAC/WMA MP3 MP3 MP3 MP3
Media Player Button(s) (Y/N) 0 O O 0 0 0
Audio Equalizers (Y/N) a 0 0 ] a O
FM Radio (Y/N) a 0 0 ] a a
Extra and Miscelleneous Features
Voice Recorder/Dialing (Y/N) a 0 0 0 a a
Speaker Phone (Y/N) O 0 0 0 O ]
Talk Time (Minutes)/Standby Time (Hours) 215/200 170/140 240/120 240/120 240/120 210/120
Other NA NA NA Webcam Webcam Webcam
Accessories
Data Cable/Handsfree/Charger (Y/N) 0/0/o 0/0/o 0/0/0 0/0/o 0/0/o 0/o/o
Memory Card Provided (MB) 128 u] 0 ] d O
Drivers and Software a 0 0 a a
Performance (Out of 35) 19.69 22.49 19.95 21.18 21.53
Signal Reception (S010) 6 5 6
Voice Clarity from Earpiece (S010) 6 7 6
Voice Clarity from Handsfree Mic (S010) 6 7 7
Clarity from Speakerphone (S010) 6 7 6
Bootup Time Without SIM (sec) 9 12 5
Processing Speed (S010) 6 6 5
Quality of Captured Image / Video (S010)  6.5/NA 5.5/6 5/4
Price Index (Out of 15) 13.50 9.10 13.29
Overall Score (Out of 100) 59.76 61.44 57.87
Price (Rs) 6,200 9,200 6,299

+Good for music
- No video capture

+ Good voice clarity + Decent performance + Webcam, Bluetooth +2 MP camera

- Expensive

- No FM radio

- Poor imaging

- No Bluetooth

+ Stylish looks
- No Bluetooth
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Intex
AURAI1224 Black
30.48

Candybar

107.6 x 46.6 x 11.8
90

6

5

5/6

Dual-band
176 x 220
260

500
Proprietary
u]

6

0

0/o

5]

0/0/0
0/0/0/o

microSD
5]
5]

5

13

1280 x 1024
O

MP3
O
O
O

0
u]
150/200
Webcam

0/0/0
1024

]
19.78

+1 GB memory card
- Sub-par performance

Multimedia

The BenQ-Siemens phones support the most
audio formats, with the CL71 even supporting
WMA. The BenQ-Siemens E61 sport media play-
er buttons on the top; good because they won’t
get accidentally pressed when in a pocket. The
bleu 651X and 651Z also had media player but-
tons, along with a good-looking media player.
The BenQ-Siemens E61 and bleu 550X do not
have an FM receiver, which is an important
component—while being just too inexpensive
to be left out!

Extras

There is voice dialling on the BenQ-Siemens
CL71 and Intex AURA. Voice dialling lets you
record a voice command and associate it with
a number in the address book, so you can just
speak the command to dial that number.

We didn’t test the battery life of the
phones; in what follows, we’re mentioning
what’s been specified by the manufacturer.
The talk time of the Intex AURA 11224 Black is
the lowest, at two and a half hours. Strangely,
its standby time is the highest (along with
that of the BenQ-Siemens E61) at 200 hours.
All the bleu phones have a low standby time of
2 hours, while the talk time is comparatively
higher at 4 hours.

The bleu 551X, 651X, and 651Z, along with
the Intex AURA, had a special feature which
we hadn’t anticipated on any phone in the
test: when these were connected to a PC, the
phone gave us a choice of whether to use
them as mass storage devices or as webcams.
When Webcam Mode was selected, they began
working as regular webcams. The best thing
is, these don’t need any drivers, and the video
quality is better than that of most of dedicat-
ed webcams!

Accessories

All the mobiles in this category come with
the required data cables, hands-frees and
chargers, so you won’t need to spend extra on
these—as used to be the case earlier (especial-
ly for non-premium mobile phones). The
Intex AURA comes with a 1 GB microSD card,
something we’d have liked to see in the
Premium category.

Performance

Signal reception

This was decent in most cases, though not as
good as we had seen with the Nokias in the
Premium segment. The BenQ-Siemens CL71
and Intex were weaker in this test, though
only marginally.

Voice clarity

The BenQ-Siemens CL71 and Intex AURA
seemed to us to have better earpiece clarity
than the rest. The speakerphones on the
BenQ-Siemens CL71, bleu 651Z, and Intex pro-
duce clear and sufficiently-audible sound. All
the hands-free microphones seemed to have
some sort of noise reduction that cut off
ambient sound.

NBESTBUY

BenQ-Siemens CL71
The stylish slider

Speed

The BenQ-Siemens phones had a faster
response time in regards the user interface.
Once again, this is only marginally better
than that of the other phones.

Image quality

The BenQ-Siemens E61, even with its VGA
camera, did a commendable job as far as still
image quality was concerned. The photos
were sharp, and colours, vibrant. The bleu
651X and 651Z were also good with their 2-MP
cameras. The BenQ-Siemens CL71 and the
bleu 651X and 651Z were the only ones with
acceptable video recording quality: all the
rest brought up choppy videos.

JUST A PHONE

Mobile phones meant just to provide the
basic function of communication feature in
this category. Value-added features are not
expected, though they certainly earn brownie
points. The mobiles in this category cost
below Rs 6,000. The bleu 250X and 450X, Intex
infi and King, Motorola MotoFONE F3 and
W220, and the Nokia 2310 and 2626 com-
prised this segment of our test.

Features .

Design And Ergonomics

The Motorola W220—a clamshell—is undoubt-
edly the most stylish. This is the phone that
has been heavily advertised on TV as the low-
cost RAZR. The other Motorola phone is the
MotoFONE F3: it is the thinnest at just 9 mm,
but is also the longest (11.4 cm)—it’s therefore

DIGIT MAY 2007
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a little uncomfortable to carry it in the pock-
et of your jeans. The Intex phones were the
lightest at 68 grams each. The Motorolas and
Nokias seem extremely rugged, good enough

bleu 450X have easy-to-use interfaces. The
MotoFONE F3 has a monochrome alphanu-
meric display, and navigating the phone i
is quite difficult because there’s no
graphical interface. Thankfully,
there is voice help that narrates to
you what button to press to achieve
a certain task (and believe us, this is
critically essential with this phone).

The Intex phones have tacky key-
pads, and this could be tiring if you
SMS a lot. The Motorolas have their
trademark feather-touch keypads, which
are a joy to use. The keys also happen to
be placed well apart. The 4-way rocker on
the Nokia 2310 seemed flimsy; that on the
2626 seemed a little better.

Basic features
All the mobiles with colour displays have a reso-
lution of 128 x 128 with 65K colours. Both the
bleu phones and the Intex infi have better-look-
ing displays. The Intex King has a monochrome
display. The most interesting was the MotoFONE
F3 with its alphanumeric monochrome display,
which is based on a new technology known as
“electric ink” or EPD. The display offers high con-
trast and is easily visible even in bright sunlight.
The Intex infi has the largest phonebook,
specified as 1,000 entries, while unofficially, the
bleu 450X has the largest phonebook, only limit-
ed by the phone memory. In contrast, the bleu
250X can store only 100 numbers. Predictive text

bleu 450X
Trendy and feature-rich

is supported by all the bleu mobiles, Intex infi,
Motorola W220, and also the Nokias.

MP3 ringtones are supported by the bleu
450X, Intex infi, and both the Nokias. The rest of

to survive some falls. A BEST BUY. the phones can only use inbuilt ringtones.
The plastic lid of the bleu 250X is one of Vibrations are supported by all the phones

the most difficult to open, so much so that we excluding the Intex King.

once felt we might end up breaking it! GPRS connectivity has been provided with the
The Motorola W220, the Nokias, and the MAY 2007 bleu 450X, Intex infi, Motorola W220, and the

Nokia 2626. Java applications are supported by

the bleu 450X, Motorola W220, and Nokia 2626.
The bleu 450X is the only phone here that has

expandable memory (by means of a microSD slot).

Camera and multimedia
There were only two camera phones in this
category: the bleu 450X and the Intex infi.
Naturally, these are more expensive, but we
included them in this category because the
price difference isn’t too much.
The bleu 450X has a VGA camera, while
the Intex infi is a step ahead with a 1.3-MP
L camera. These were also the only two phones
that support MP3 music playback. FM radio
\ is present on both the Intex phones, both
. the Nokias, and the Motorola W220.

Extras
. The bleu 450X, Intex infi, and Nokia
2626 have voice recorders, which can
. serve as makeshift memo devices and
also record phone conversations.
Again, we didn’t test battery life:
we’ll only state what’s been men-
tioned by the manufacturers. The
Motorola W220 has the longest talk
time of 6 hours; the MotoFONE F3, just
4.5 hours. The Nokia 2310 has the longest
standby time of 6 hours.
The Motorola W220 even has an external
indicator display that alerts you about missed
calls and SMSes.

any of you are probably shocked each time you receive your

mobile bill... no matter how hard you try to curb your bills,
you invariably end up in the same situation month after month,
wondering where you went wrong. Worse, the bills come with
much technical jargon and fine print, and that only adds to the
confusion. A close study of your bill is your first step out of this
predicament, and we have a few tips for you.

Billing Plans: Choose your billing plan according to your
usage pattern. Most mobile service providers have a one-month
starter pack that lets you analyse your usage, and service
providers even recommend plans that suit you. You can then
choose whether you should go with pre-paid or post-paid.

SMS or call? A common misconception is that SMS is always
cheaper than a call. with certain talk plans, calls are actually
cheaper. Most service providers have mobile-to-mobile plans of
50 paise or less per minute at a nominal monthly rental. This
makes it cheaper to make short calls rather than exchanging
four to five SMSes that cost a rupee each. Also, a minute’s
conversation is more effective and efficient than sending even a
single SMS!

Whom do you call? Scrutinise your bill to see if you make a
lot of calls to subscribers to a particular service provider. If this
is the case, it makes sense to switch to that provider; most

Control Your Spending

providers have subscription plans that provide discounts on
same-service-provider calls.

SMS Addicts: If you believe that mobile phones were
invented so you could send SMSes, take advantage of special
SMS packages, some of which let you send SMSes at just 10
paise each.

Roaming: If you are a frequent traveller (or even if you
aren’t), it’s a good idea to activate national roaming, since this
has recently been made rent-free by many providers (check with
your provider). Calling landlines while roaming is more
expensive than calling to mobiles. Calls are generally cheaper
than SMSes in this case as well-SMSes generally cost around Rs
3.50, while calls can cost anywhere between Rs 1.40 and 2.40
depending on the plan.

Here’s a note about service providers while you’re roaming.
For example, if you are a BPL Mobile subscriber in your
hometown, manually select the BPL Mobhile network in your
mobile phone’s network settings when you are in a different city.
In case that network is unavailable, select an allied network
(which you can find on your service provider’s Web site). If you
use a different network, you could end up paying heavy
interconnect charges.

Mobile Internet: Indispensable to many on the move, but it
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The Intex and Nokia phones have support
for sending as well as receiving SMSes in
Hindi. The MotoFONE F3 has a speaking tutor
that can not only guide you through
the phone setup, it can also
help you achieve basic
phone tasks. And this #
localised version of the §
phone has these voice
instructions in Hindi
and Punjabi too!

Performance
Signal reception
Unlike in the other cate-
gories, we found that here,
there were quite a few
mobiles that were able to
catch the signal as good as
the Nokias. The Intex infi and
the bleu 250X were the only
exceptions.

Voice clarity
All the models had decent audi-
bility from the earpiece except for
the bleu 250X, which was sub-par.
With the hands-free plugged in,
the Intex King was the only phone
which posed audibility problems for
the listener at the other end. The
speaker-phone clarity of the Nokia
mobiles was exceptionally good. Motorola MotoFone F3

A good first-time purchase

Speed

The Nokias were the only ones with a
sophisticated OS (Symbian Series 40). But
these have a slower processor, and the OS
seemed to overwhelm them—resulting in slug-
gish response to key-presses. The Intex infi
was much faster; marginally behind it was the
Motorola W220.

can drain your wallet in a big way if used
unwisely. If you do not need to download stuff,
WAP is the way to go, because most mobile
service providers offer it at just Rs 49 per
month, while GPRS starts at Rs 199. Some service
providers charge for data transfer at a rate of 10
paise per 10 KB. While this may seem
insignificant, you should realise that you'd
almost never realise how many pages you surf
during an Internet session. You can reduce the
amount of data transfer by disabling images and
sounds in the Internet settings of your mobile
phone. Better still, you can go with certain
service providers who do not charge for
downloads at all, though the Internet speeds will
be slower. If you are a heavy Net user and need
GPRS, it’s better to go with a flat-rate, unlimited
subscription.

Value-Added Services: Be careful when you
subscribe to Value-Added Services such as
Horoscope, Dating, Cricket Updates, Contests,
etc. You might well end up not knowing how
much you’re paying.

Specialize in
Networking
& Securily
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gl Scoreboard Just A Phone (Below Rs 6,000)
BRAND bleu bleu Intex Intex Motorola Motorola
MODEL 250X 450X King infi MotoFONE F3 w220
Features (Out of 50) 15.22 33.01 1598 32.18 14.31 25.11
Design and Ergonomics
Form Factor Candybar Candybar Candybar Candybar Candybar Clamshell
Dimensions (mm) L x W x D 105.3 x 44 x 15.8 108 x 44 x 15.2 99x44x18 100 x 43 x12.5 114 x 47 x 9 95 x 46 x 16.7
Weight (gms) 80 920 68 68 70 93
Build Quality (5010) 5 6.5 6 5 8 8
Ease of Use of User Interface (5010) 5 6 4 5 3 6
Keypad Layout (5010) 6/6 6/6 5/5 5/4 7/6 7/7
Keypad Backlight (Y/N) a 0 0 0 5] O
Basic Phone Features
Support for Network Bands Dual-band Dual-band Dual-band Dualband Dualband Dual-band
Display Resolution (Pixels) 128 x 128 128 x 128 NA 128 x 128 2 X 6 chars 128 x 128
Display Colours (K) 65 65 Monochrome 65 (Monochrome) 65
Address Book Capacity 100 Depends on memory 300 1000 NA 600
Operating System Proprietary Proprietary Proprietary Proprietary Proprietary Proprietary
Predictive Text (Y/N) a 0 0 0 0 a
Number of Profiles 1 1 4 5 1 1
Themes Support (Y/N) ] 0 0 0 0 a
MP3 Ringtones (Y/N) O ] 0 0 0 O
Vibrations (Y/N) O 0 0 0 0 a
Support for Installing New Applications/ [ 0 0 0 0 a
Games (Y/N)
Internet: GPRS/HSCSD/EDGE 0/o0/o 0/0/0 0/0/0 0/0/0 0/o0/a 0/o/o
Connectivity: IR/Bluetooth/USB/Wi-Fi o0/o/o/o o0/o/o/o o/o/o/o o0/o/o/o 0/0/o/0 0/0/o/o
Memory
Expandable Memory (Y/N) 0 O 0 O O 0
Memory Type(s) Supported NA microSD NA NA NA NA
USB Mass Storage Device (Y/N) NA 0 NA 0 NA NA
Camera
Zoom (X) NA 2 NA 2 NA NA
Image Resolution (MP) NA VGA NA 1.3 NA NA
Image Resolution (Pixels) NA 640 x 480 NA 1280 x 960 NA NA
Multimedia
Audio Formats NA MP3 NA MP3 NA NA
Media Player Button(s) (Y/N) NA 0 NA 0 NA NA
Audio Equalizers (Y/N) NA O NA O0 NA NA
FM Radio (Y/N) O 0 5] ] 0 a
Extra and Miscelleneous Features
Voice Recorder (Y/N) O 0 0 0 0 a
Speaker Phone (Y/N) a 0 0 0 0 a
Talk Time (Minutes) 120/150 240/150 180/300 150/150 270/300 480/290
Accessories
Data Cable/Handsfree/Charger(Y/N) 0/0/0 0/o/o o/o/o 0/0/o 0/o0/0 o/o/o
Performance (Out of 30) 9.24 16.29 13.58 16.65 1290 15.55
Signal Reception (S010) 5 6 7 5 7 7
Voice Clarity from Earpiece (S010) 4 6 5 6 6 6
Voice Clarity from Handsfree Mic (5010)  NA 7 6 5 NA NA
Clarity from Speakerphone (S010) 5 6 6 6 6 8
Bootup Time Without SIM (sec) 7 7 4 6 3 1
Processing Speed (S010) 4 4 4 7 5 6
Quality of Captured Image/Video (S010)  NA/NA 5/4 NA/NA 5/6 NA/NA NA/NA
Price Index (Out of 20) 12.38 5.60 14.49 5.45 18.00 7.22
Overall Score (Out of 100) 36.83 54.90 44.04 54.28 45.21 47.87
Price (Rs) 2,399 5,299 2,050 5,450 1,650 4,114

+Sleek +1.3 MP camera

- Expensive

+ Good performance
- Poor performance - Expensive

+ Good reception
- Mono display

+Innovative concept + Stylish design
- Difficult interface - No MP3 Player
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Nokia Nokia
2310 2626
24.57 26.90
Candybar Candybar
1054 x 439 x19.05 104 x 43 x 18
85 91

8 8

6 6

6/6 6/6

0 ]
Dual-band Dual-band
128 x 128 128 x 128
65 65

200 300
Symbian Symbian 540
] ]

6 6

5] ]

] ]

5] ]

5] ]

0/0/o 0/0/0
0/0/0/0 0/0/0/0
0 ]

NA NA

NA NA

NA NA

NA NA

NA NA

NA NA

NA NA

NA NA

5] ]

0 ]

0 ]
400/360 300/180
0/0/0 o/o/0
15.75 15.00

+Good Ul
- Flimsy 4-way rocker

+Good Ul
- Expensive

REll Contact Sheet

Company
BenQ-Siemens

BenQ-Siemens India Pvt Ltd

Cell Phone Test

9810718821

Sales.EnquirylIn@BenQ.com

bleu Pratham Telecom 022-28769381 avinash@sagemindia.com

Intex Intex Technologies 011-41610190 amitsaxena@intextechnologies.com
Motorola NA NA NA

Nokia Nokia India 0124-41990000 www.nokia.co.in

Sony Ericsson Sony Ericsson Mobile Comm. Int. AB

022-39011111

questions.in@support.sonyericsson.com

Image quality

Of the two contenders here, we found the
still image quality similar, while the video
capture quality of the Intex infi was better
than that of the bleu 450X.

The Winners!

The SE CyberShot K550i is the only phone that
specialises in the camera department, with fea-
tures such as a 2 MP camera with flash and
auto-focus. This was reflected in its imaging
scores. It supports high-speed Internet stan-
dards such as HSCSD and EDGE. This sleek
phone with its equally sleek interface, in addi-
tion to good performance and at a decent price
of Rs 11,995 has been adjudged the winner of
the Digit Best Buy Gold award in the The Upper
Crest category.

Close behind was the colourful slider, the
Nokia 5300, which has one of the fastest
interfaces. It has media control buttons to
enhance accessibility to your music, and also
comes bundled with a good pair of in-ear ear-
phones which sound really good. Voice clarity
is good, and signal reception, excellent. We
award it the Digit Best Buy Silver in the The
Upper Crest category.

The candybar bleu 651X has almost every-
thing you’d expect from a multimedia phone.
It has a 2-megapixel camera with flash, and a
good-looking media player that can be con-
trolled via the media control buttons. It even
doubles up as a webcam when plugged into a
PC. And good signal reception, good looks, and
a not-too-heavy price tag of Rs 8,299 means the
bleu 651X takes the Digit Best Buy Gold in the
Talk And Click category.

The beautiful BenQ-Siemens CL71, a slid-
er, is the only one with a large address book
capacity (1,000). Good keypad layout, speed,
and superior audio clarity mean the BenQ-
Siemens CL71 wins the Digit Best Buy Silver
in the Talk And Click category.

In the Just A Phone category, the two cam-
era phones scored the highest. The stylish
bleu 450X, which is a multimedia phone with
support for MP3, good voice clarity, and a
decent interface, while being the only one
with expandable memory in this category
wins the Digit Best Buy Gold.

The Intex infi, the other camera phone,
has a better camera with 1.3-MP resolution.
Though priced the highest in this category,
this mobile has good voice clarity, and sup-
ports Hindi SMSes. The media player is
decent, and is the only one that has graphics
equalisers. It wins the Digit Best Buy Silver in
the Just A Phone category.

If a camera is not very important, you can

NBESTBUY

MAY 2007

Intex infi
A very affordable camera-mobile

definitely go with either of the two Nokia phones:
they offer almost everything else. They look
decent and have better user interfaces than the
rest of the phones. Built ruggedly, supporting
Hindi SMS and with FM radio, these are definite-
ly worth a look.

A Closing Note

We have left out the creme-de-la-créme of mobile
phones, which will be reviewed in a separate
shootout later. But as has been the trend, it is
only a matter of months before this category
trickles down to mass-affordable levels.

As more players enter the mobile arena,
competition is forcing cuts in subscription costs.
CDMA coming in has served as catalyst to the
already speedy process of plummeting call rates,
which are already rivalling those of landlines.

Landlines are still more affordable than
mobiles, but they aren’t, well, mobile! But they
have started offering services such as ADSL. The
landline will never die, we think, and these
technologies will continue to co-exist for a long
time to come.

We hope we've cleared, in this article, some
of the fog for you when it comes to choosing a
phone. Even if you upgrade your phone often,
worry not-we'll most likely carry a shootout at
about the same time next year! l

jayesh_limaye@thinkdigit.com
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Samsung BD Writer SH-B022A

Ahead Of Its Time?

e got to review

Samsung’s new Blu-ray
writer, the SH-B022A. It
writes the largest-capacity
on discs that Digit has seen
thus far—50 GB Blu-ray discs!
You can back up your entire
hard drive with just a
handful of discs.

The drive looks like an
ordinary IDE optical drive
with the BD marking on the
bezel being the only
differentiator. Build quality
is average compared to the
drives we have tested thus
far, but the tray mechanism
seems smoother, and is quite

RATINGS

noiseless. Going
well with “Blu-ray” is
the blue LED that glows
behind the Eject button.
Blu-ray burning speed is
2x (8.78 MB/sec), a tad faster
than 6x DVD (8.1 MB/sec).
This doesn’t sound too
good, since the much faster
16x (21.6 MB/sec) DVD
writing is common today.
Burning 25 GB to a 2x BD-RE
(Blu-ray Disc Recordable
Erasable) disc took us 47
minutes—agonisingly slow.
But yes, the technology is
still being improved, and
given a few months, we’ll
see faster Blu-ray drives.
Backward compatibility

underruns. Sequential DVD-R
burning took 505 seconds,
while burning to a DVD+R
took more than 8 minutes,
both at 12x. This is slower
than today’s DVD-Writers,
which get the same job done
in not more than 360
seconds.

The drive comes bundled
with CyberLink BD Solution,
a software suite for burning
as well as video editing,
playback, and backup

out of reach of
most of us.
Also, A 25
GB disc is
about Rs
1,500,
and they
aren’t easily
available. But then,
remember that DVD-Writers
were priced at $1,500 in the
early 2000s!

Specifications

Reading: BD-ROM, BD-R, BD-RE:
2X; DVD+R, DVD-R, DVD-ROM:
12x; CD-R, CD-ROM: 40x.
Writing: BD-R, BD-RE: 2x;
DVD+R, DVD-R: 12x; DVD+R DL,
DVD-R DL: 4x; DVD+RW, DVD-
RW: 4x; CD-R: 32x; CD-RW: 24x.
Buffer: 8 MB; interface: IDE

Performance % % % has been taken care of, with ~ software. Sadly, the suite lags  Contact: Samsung India Electronics
Features Yk kY support for writing to CD as behind Nero by miles. Pvt Ltd

Build Quality  * % % well as DVD recordable Ultimately, the price Phone: 011-41511234

value for Money % % ¥ media of all kinds—except takes the fun out of E-mail: hari.pandey@samsung.com
Overall e DVD-RAM. The 8 MB bufferis everything: an obscenely Web site: www.samsungindia.com

sufficient to preclude buffer =~ high Rs 22,000, keeping it Price: Rs 22,000
Transcend T.sonic 630
. not require computer. The partitioning

Feature-rich function allows creation of

he T.sonic 630 is trendy-

looking and small
enough to carry around. It
is being targeted at college
students on the lookout for
a feature-rich music player.
It is available in three
flavours—1 GB in orchid,

2 GB in pod white, and 4 GB
in black. The bright white
four-line OLED display is
clearly readable in diverse
lighting conditions.

The menu is simple to
navigate, but the keys have
a hard tactile feel. There
are six inbuilt equaliser
profiles and a five-band
customisable equaliser. The
player supports one-touch
recording, which is one-
touch even when the power
is off. WAV recording can
be from three sources—
radio, microphone, and
line-in, and the recordings
are automatically stored in

three different
folders.
Recorded files
are named in
month | date
order. Two
recording
environments
are provided,
meeting and
memo; the
former is
more sensitive.
The voice i
activation
detection works A
well only in silent
surroundings, and

allows for gapless
recording.

Playback quality is
definitely not the best in
its class. The earphones
have good overall response,
but bass lacks depth. The
FM tuner stores up to 20
stations. The player does

proprietary
software to load
songs: simply drag
and drop. It
supports USB 2.0,
but in our tests, it
took five minutes to
transfer 600 MB of
data—very slow.
There’s bundled

utility software as
well: the boot-up
function
makes
the
music
¥ player
-~ USB-
bootable, and the PC-lock

makes the player an
access key to your

RATINGS

Performance % % % 5

Features Ik Kk
Build Quality Y k&
Value for Money Y % % %
Overall Y%k ke

a partition with password
protection. The recovery
function allows you to
reset the player to factory
settings.

The 2 GB white model
retails at Rs 4,500. Though
the player lacks great
playback quality, it’s good
enough for the price.

Specifications

Size: 73 x33x12.5 mm (L x W
X H); weight: 30 gm;
compression rate: 32 Kbps—
320 Kbps; supported music
formats: MP3, WMA, WMA
DRM -10; charging and data
transfer: USB mini port; 15 hrs
playback when fully-charged

Contact: Mediaman Group of
Companies Pvt LTD.

Phone: 022-23823100

E-mail: sales@mediamangroup.com
Web site: www.transcendusa.com
Price: Rs 4,500
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Integral USB 2.0 Flash Drive

About Average...

ntegral’s (1 GB) USB 2.0

Flash Drive is encased in a
flashy sky-blue rubber
exterior. This means it’s not
only rugged enough to be
reasonably shock-proof, it’s
also splash-proof. One
problem: the rubber coating
tends to attract dust.

Performance was slow

compared to that of other 1
GB Flash drives. Writing 700
MB of assorted data to the
drive took 5 minutes, and

RATINGS
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reading the same data from
the drive took a minute. (As
a comparison, the Corsair
Flash Voyager 1 GB, which is
similarly rugged, writes 700
MB to the drive in 34 per
cent of the time we’ve
mentioned, and reading
takes 37 per cent of the
time.) Random access time,
though, was 5.2 ms, which
is quite good.

The drive comes with
SecretZip, a compression
software that compresses
data with password

Contact: Goldstone Imaging Pvt. Ltd
Phone: 011-41530501

E-mail: integral@goldstoneltd.com
Web site: www.integralmemory.com
Price: Rs 1,550

protection.
SecretZip can only

be run on Integral’s
USB Flash drives.

But that’s just about as
much security as the
software provides: the
compressed files can be easily
deleted... If ruggedness is of
prime importance, you’ll like

this drive, else there
are better-performing
products

available
at better prices.

Specifications
USB 2.0; software bundle:
SecretZip

XFX nFORCE 680i LT

680i On A Diet

et’s face it... Sure nFORCE

680i motherboards are
blazing performers, feature-
rich, and future proof (read
1333 MHz ESB support), but
they aren’t exactly wallet-
friendly! Neither is the
nFORCE 650i a very viable
option for enthusiasts.
NVIDIA finally acknowledges
this and coughs up a
“budget” variant of their
top-end 680i, with the “LT”
as a suffix.

XFXs’ 680i LT uses the
reference NVIDIA PCB
layout, which is now
designated “Designed for
NVIDIA.” One major
annoyance: the power pins
are squeezed between the
memory modules, the four
pin auxiliary power
connector, and the IDE
connector. This makes
accessing the pins extremely
difficult, and it’s not a good
idea to have wires around
the memory slots either.
XFX has provided cooling
fans for both chipsets;
however, the Northbridge

heatsink
is quite
large
(which
shouldn’t be
necessary when
actively cooled as in
this case), and as a
result, intrudes upon
the CPU region. This will
probably preclude
installation of larger coolers
like Thermalright’s XP-120
and Ultra 120, or Scythe’s
Ninja and Infinity coolers.

The BIOS on this board is
the same as a regular 680i,
minus a few SLI memory
profiles, and some extra
options like a PCI-Express slot
(the 680i has three, while the
LT version has two).

So what’s different
between the 680i and its LT

RATINGS
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- version?
Three main things.
First, there’s no third PCI-
Express slot between the
two SLI x16 slots. Second,
there’s one Gigabit LAN
instead of two, making
NVIDIA’s DualNet
impossible. And third, SLI
profiles are only supported
up to 800 MHz (the 680i
goes up to 1200 MHz). What
you get in exchange is a
much lower price tag,
taking the 680i LT well and
truly into Intel’s P965
territory price-wise.

Contact: Rashi Peripherals Pvt Ltd
Phone: 022-67090909

E-mail: navinderc@rptechindia.com
Web site: www.xfxforce.com

Price: Rs 12,500

For Rs 11,000, the
680i LT offers very
good value for
money for
the

R

" enthusiast

audience who
wants features,
performance, and decent
overclocking potential—not
to mention SLI. In fact, if you
don’t plan on a physics card
and two 1 Gbps LAN
connects, you can overlook
the 680i altogether and pick
a board based on the 680i LT
chipset. Hardcore
overclockers will still look at
the 680i and Intel’s P965,
while casual users will settle
for lower solutions like
NVIDIA’s 650i and Intel’s
965G, which are slightly
lower-performing options
and sans a few features.

Specifications

NFORCE 680i LT chipset, Socket
775, Core 2 Duo/Quad ready,
1066/1333 FSB, DDR2 800 MHz
support, six SATA 2.0 ports,
eight USB 2.0 ports
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SAHARA MC765124-MK10
Media Center For The Living Room

iding

the Media Center wave
comes Sahara’s MK10.
Finished in luxurious black
with a huge brushed
aluminium dial, it looks
more like a DVD player than
a Media Center PC.

The volume knob has a
bright blue backlight and

could have been designed to
move smoother. A blue-lit
alphanumeric display is
slotted on the front; it
displays the
status when
playing
media
files. A
pull-

down
flap covers
the media
control keys and
also provides access to card
readers and the other
regular PC ports.

The media player has a
functional IR for the remote
control built in the front
panel. An additional two

wire lead is provided which
can be set at convenient
angle allowing the remote to
be used in a wider range

On the media front, the
PC comes bundled with a TV-
Tuner card, FM radio, a DVD
player, and a 160 GB hard
drive. There’s onboard 7.1
audio for connecting a
surround sound system;
however, Sahara has only
bundled an Altec Lansing 2.1
speaker set.

On the PC front, you have
the Pentium D805 processor,
which is good enough for
media and typical PC usage.
There’s 512 MB of RAM, and
a 17-inch LCD. The wireless
keyboard is a cute piece of
hardware with an inbuilt
mouse tracker; we sorely
missed a separate mouse.

Performance-wise, the
integrated 945G provides
playable frame rates in most

RATINGS
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of games -not for serious
gaming. The 16X DVD Writer
dose a fine job of popping
out burnt DVD’s at a decent
pace. The 7200 rpm SATA
hard disk is fast enough for
its intended use as a Media
Centre PC.

At Rs 51,999 is hard to
justify: you can get a
powerful system for the same
price. Still, the form factor is
unique, and will blend well
into the décor of a nice
living room.

Specifications

Processor: Pentium D 805;
motherboard: PIC PTM945G/P;
512 MB 533 MHz DDR2 RAM; 160
GB 7200 rpm SATA HDD, 16x
DVD-RW; 17-inch 4:3 LCD
monitor; 2.1 Altec Lansing 121i
20 W speakers; wireless
keyboard with integrated
tracker ball; IR remote;
Hauppauge (Conexant chipset)
TV-Tuner

Contact: Sahara Computers and
Electronics Limited

Phone: 022-30303838

E-mail: info@saharacomputers.co.in
Website: www.saharacomputers.co.in
Price: Rs 51,999

TOP UPS
Very Functional

n an increasingly “me-

too” product world, the
TOP-UPS stands apart. It
adheres to the “Form
should follow function”
design philosophy
perfectly.

Shaped likea 777
small helmet, iy
the TOP UPS
has nifty
features that
enhance its
usability.

First, it has
slots on top
for storing CD
cases. Second,
there is a little
flap in front \

i "

pupS

with a bright
white LED,
which can act
as a torch
during power
failures. Third,
there is a digital

clock at the front. A small
socket at the front provides
an alternative way of
charging cell phones.
Wipro has provided

six different

adapter plugs
. used by
major cell
_ phone

manufacturers such as
Nokia and Sony Ericsson.

The operating range for
the UPS is specified as 140
to 280V, and with a
transfer time of below 10
ms the UPS kicks in during
power failures. Two power
outlets are driven via the
battery, while other one is
surge-protected and not
driven off the battery. The
colour coded power outlets
eases installation. The
maintenance-free battery is
rated at 12V, 7AH is user-
swappable.

On our test-bed
consisting of a Pentium 4
3.06 GHz, Foxconn
945G7MA motherboard,
and a 17-inch CRT, we got a
backup time of 12
minutes—quite typical.

At Rs 3500, the TOP-UPS
is priced higher than UPSes
with similar specs.
However, considering the
extra features on offer,
i we think the price is
justified, though we’d

have liked to see a better
(read more sober) colour
scheme.

Specifications

Dimensions: 184 (W) x 235 (D)
X 236 (H) mm; weight: 6 kg;
600 VA, 360 W; supports cold
start ;transfer time: <10ms;
input voltage: 140 ~ 280 V;
output voltage: 230 V ffl 5 per
cent (battery); RJ11 port
surge suppression; typical
recharge time 6 hrs to 90 per
cent capacity

RATINGS

Performance Yk k

Features Kk Kk
Build Quality Y Xk %k
Value for Money % % % %
Overall N 0> O o ¢

Contact: WeP Peripherals Ltd
Phone: 1800-4256446
E-mail: top.ups@wepindia.com
Website: www.wepindia.com
Price: Rs 3,500
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HP PHOTOSMART D7368
A photographer’s companion

he HP Photosmart series

is targeted at
photographers who
demand a high-quality
photo printer.
The
Photosmart
D7368 looks
tidy; the
design is
elegant. Build
quality is good,
with sturdy,
neatly-laid out
trays. A
transparent shutter
gracefully covers the
memory card slots,
allowing for easy access
and preventing dust build-
up.

The printer took about
6 minutes to print an A4
size photo at best quality.
The colour prints were
some of the best we’ve
seen with an inkjet
printer! Finer aspects were
reproduced in detail, and
throughout the test

procedure, the prints had
a neutral tone. In addition,
colour

contrast
ratio is
notably good, allowing for
more vivid colour
reproduction. Textures
were reproduced in detail,
and even metallic shine
was rendered with the
proper lustre on photo
paper. In draft mode, black
was reproduced as a dark

shade of grey, but this was
rectified when we
switched to normal print
quality.

The low-resolution
touch-screen is easy use, but
still requires the use of
some discrete keys to
navigate certain menus. All

of the printer’s
.. functionality can be
\ easily accessed via
the touch-screen.
" Basic help for
procedures such as
loading cartridges,
paper loading, and
. paper jam is
provided as
animations. The
memory card slot
allows taking prints
directly from memory card.
Prints can even be taken
from a PictBridge-
compatible digicam via USB.

The software bundle

Performance k& % %k
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makes printing as well as
basic editing a simple
process even for novices.

Notable is Photosmart
Premier: it is a slightly
advanced image-
enhancement application,
and allows for taking
customised prints in
varying sizes.

Photographers and
even photo enthusiasts
who click a lot, and
require a neutral toned,
high-quality printer,
should certainly consider
this printer a good buy to
suit their needs.

Specifications

4800 x 1200 dpi; 3.4-inch
touch-screen; internal
memory 64 MB; dimensions
(W x D x H): 462.5 x 387.3 x
172.9 mm, weight: 8 kg; tray
capacity: 100 sheets

Contact: Hewlett-Packard India Pvt.
LTD

Phone: 1800 42 54 999

E-mail: vibhor.bansal@hp.com
Website: www.hp.com

Price: Rs 10.999

XFX 8600GTS and 8600GT &
Mrs Green just got twins!

DIA’s G84 comes to life

as we present 2 cores
based on it a.k.a the
8600GTS and the 8600GT.

One can immediately tell
these are minnows com-
pared to the colossal
8800GTX. Both cards are
based around a 32-shader
unit core, fed by 256 MB of
GDDR3 memory. The differ-
ence is only in clock speeds,

both core and
memory.
From its look,
the 8600GTS is the
higher-end card,
with a larger
heatsink. Heating
doesn't seem to be
an issue with either
card, at least from
preliminary tests.
Unfortunately, the
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High Detail

Doom3
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XFX

8600GTS
uses elec-

trolytic capacitors in
contrast to the solid-state
ones on the 8600GT. Why
such a backward step? Did
XFX expect users to buy the
8600GT and overclock
beyond GTS speeds?

As features go, these

cards are identical, expect

Performance Yk ok ok ok
Features Kk Kk
Bundle Xk
Value for Money % % %
Overall Y % Kk

the GT version doesn't sup-
port HDCP. Pitched as mid-
range cards, these are
expected to replace the
7600GT and GS Direct X 10
support. Driver support is
spot-on with current-gen
games, we played 10 games
no issues.

Priced as they are
(below) the 8600GTS is
costly for a mid-range solu-

tion, and considering that
clocks aside they’re iden-
tical. The 8600GT really hits
the sweet spot in this regard.

Specifications

8600GTS/GT - 32 shader units;
core speed 675/540 MHz;
memory speed 2000/1400
MHz; shader unit clock -
1450/1180; 289 million transis-
tors; 256 MB GDDR3 memory
(128-bit)

Contact: Rashi Peripherals

Phone: 022-67090909

Web site: navinderc@rptechindia.com
Price: Rs 16,000 (8600GTS)

Rs 10,000 (8600GT)
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Dragon Naturally Speaking 9
Close-To-Perfect Voice Recognition!

S peaking to your com-
puter might seem silly,
but it might just be the
most sensible thing to do
with Dragon Naturally
Speaking 9. Let’s take a
quick look at how effective
it really is.

We installed the soft-
ware on our test bed: an
Intel Pentium 4 HT, 1 GB of
RAM, and a Creative
Audigy2 sound card.

Training is, of course,
required, and it involves a
good amount of patience on
your part—it can take days.
Any mumbling or drop of
quality in your speaking
style can mess it up.

We used the software
for over a week to gauge
performance. The detec-
tion is close to perfect, but
occasional error correc-
tions are needed. Small
words confused it even
during the training ses-

sions. The numerical
voice recognition,
however, was both
fast and accurate.
The application
consumed around
200 MB of RAM, with
some 50 to 60 per
cent CPU utilisation.
Very long sentences
can cause slowdown
and inaccuracy.
Moving on to fea-
tures, the software has
the ability to let you use
voice commands to handle
almost all Windows applica-
tions. There are five modes
for various types of dictation,
such as numerical entry, text
entry, and voice commands.
Making random selec-
tions can be done by saying
“Select” followed by the
words. This is helpful in
fixing mistakes in the text.
You can add custom words
to the database if the soft-

ey
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fails to
recognise them.
The text to speech
conversion isn’t impres-
sive, and sounds like the
Microsoft Speech Engine.

Performance & % %k %k
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Good help is provided
by both the printed
booklet and also the good
number of voice tutorials,
which explain many fea-
tures in detail. The bundle
includes a small headset
which is OK, but very
uncomfortable for long sit-
tings because of its small
size.

Vista support was
recently added in the 9.5
update of the software.

Overall, the voice recog-
nition is effective once
you’ve gone through the
training. We think it could
have been lighter on the
system, and that a better
headset could be supplied.
Overall, highly recom-
mended for people who are
slow at typing or hate

typing a lot.

Contact: M/S ICONS

Phone: 022-26351063/022-26324801
E-Mail: mrg@icons.net.in

Web site: www.nuance.com

Price: Rs 11,542

Symantec Backup Exec System Recovery—Desktop Edition

Wish Backup Worries Away!

Symantec has released an
excellent product to
automate all your system
backup and restoring
tasks—a product that
might well kill Windows’
System Restore!

The main feature is, it
lets you create a backup of
your entire hard drive, or a
partition, to an image. The
inbuilt scheduler
automates the backup
process. You can schedule a
backup for any date and
time.

The software also lets
you create new backups
and only store the last, set
number of updates.

Backed-up disk images
can be restored onto a disk
or partition. You can use
the Recover Files or Folders
task, where only selected
folders and files will be
extracted to a specified
destination. Mounting of
the disk images as a

partition without actually
restoring the image to a
location is also possible.

The software CD can
be used as a recovery
disk. Network services
are enabled as the CD
boots.

A lot more can be
done through the
recovery disk—everything
from altering partitions
to scanning your
machine for viruses
using an external
virus definition
database.

Installation is so
simple, it can be done
by a five-year-old. And if
you’re expecting a
complicated interface,
you’ll be relieved to see
that it’s anything but.

Still, an advanced mode
is in place for those who
want more control. A
sidebar contains the task
list as well as help topics.
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The electronic
manual and the
printed documentation are
the same; overall, the help
is comprehensive and easy
to understand.

Simply set the software
to back up data every day
when you log off, or
whenever new software is
installed on your PC—and
never worry about losing
data any more!

In sum, Symantec
Backup Exec System
Recovery is Norton Ghost

with a few added features
and a non-complicated
interface.

Regular home users
will like it, though the
price tag of $69
(Rs 3,100) is a bit on the
higher side.

Contact: Ingram Micro India (P) Ltd
Phone: 080-26564445

E-Mail: Deenu.m@ingrammicro.co.in
Web site:www.symantec.com

Price: Rs. $69 (Rs 3,100)
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Active WehCam 8.3

The Roving Eye

here are surveillance

applications aplenty,
but Active WebCam is
different. This easy-to-use
application not only lets
you use multiple cameras
to monitor activity. You can
also record the footage for
later use.

Wizards guide you
through the camera setup
process. You can then
choose to send video with
audio to any computer on
your network that has the
app installed, soundless
video to HTTP users, and
screen captures to FTP
servers.

Live audio and video
can be broadcast to the PY
Software Web server
(subscription to Dynamic
IP Service is necessary,
which comes as part of the
30-day trial), and Active
Webcam can be configured
to set permissions for users

and groups, as also the
maximum number of
allowed visitors. For when
the camera(s) detect(s)
motion, it can be
configured to sound an
alarm, or e-mail the video
footage | snaps it records,
or start broadcasting live
images and videos.

So who can benefit?
You can transmit live
videos of your friends’
reunion parties over the
Internet. You can use it as
a surveillance mechanism
at your front door.
Jewellers will benefit from
the multi-camera
capabilities: keep an eye on
multiple customers at the
same time! You can set it
to monitor your children
while you’re away. Record
simple video
presentations... just use
your imagination and
think of more uses!
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In addition to all the above,
you can use the Tools menu
in Active WebCam to create
and design a Web page to
where you post videos and
stills. Two nifty
applications come bundled:
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a video player that can play
captured videos in the
native format, and a video
editor that can convert
captured videos to AVI with
any installed compression,
or to MPEG-1.

Active WebCam works with
any camera detected by
Windows. For $29, this is a
steal—no gripes!

Contact: PY Software
Web site: www.pysoft.com
Price: $29 (Rs 1,300)

VirusBuster Professional 2006
Funky looks, basic functionality

his is an anti-virus

program from
Hungary... but don’t let
that put you off! Let’s take
a look at what it offers in
comparison to other
anti-viruses...

Post-installation, the
first thing you see is the
unconventional interface.
There are no menus, and
the icons are cartoonish! In
addition, you end up going
through multiple windows
and clicks before actually
scanning something.

VirusBuster
Professional has the
standard set of features—
the main file scanner, a
shield that looks at
background processes,
and an Outlook scanner.
There is support for
scanning network shares as
well; the same interface is
used for this.

Different levels of
sensitivity are available for

each feature, and these can
be altered by the user.

The Quarantine feature
lets you scan the
quarantine folder after a
virus database update, and
there’s automated
restoring of cleaned files.
The updater lets you
choose from different
locations such as HTTP, FTP
server, CD, etc.

Security features were
kept in mind as well. You
can set an administrator so
other users don’t tamper
with the settings. The
Rights Management lets
you set permissions to the
various components of the
program.

CPU utilisation spiked
between 30 and 50 per
cent, but the memory
consumption hovered
around the 30 MB mark,
which is pretty OK.

The help file is
detailed, but is low on
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screenshots. The
downloadable PDF manual,
however, has plenty of
screenshots for every
feature and menu.
VirusBuster
Professional 2006 isn’t a
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market leader among anti-
virus software for sure. It
doesn’t come cheap either:
Rs 1,400 for a year. For a
similar price, there are
plenty of other choices
available. Most free anti-
virus software sport
smarter interfaces.

Contact: Karvid Technologies
Phone: 020-27641650

E-Mail: sanket@karvid.com

Web site: www.virusbuster.hu/en/
Price: Rs 1,400
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Of Boredom And Big Questions

Featuring things to do when nothing excites, some community service, and life lessons

Prakash Ballakoor

www.bored.com
So there you are, sitting at your
computer late at night twiddling
your thumbs, and what do you do?
Type in “bored” and press [Ctrl] +
[Enter], of course. Good move.
Bored.com is good enough for such
times. We should warn you, though,
that it’s only good when you're really
bored. It’s quite silly otherwise!

Play games online here—jigsaw
puzzles, tic-tac-toe, Sudoku, and
many others, or get links to hundreds
of online gaming sites. Music (not yet)
on your mind? There’s a section called
“musicmania” to entertain you—learn
how to play music on a cell phone by
punching in numbers, find the lyrics
and meanings of songs and other
such silly pursuits.

Of course there’d be a jokes sec-
tion on such a site. A sampler: the best
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Bored.com: do you really need more?

excuses for being late for school, work,
church, and more. If this weren’t fun
enough, there’s even a separate cate-
gory for fun. Here, “fun” means fun of
the silliest kind—be warned—but then,
you’re bored, aren’t you? Type in a
word or phrase and watch them spelt
out in different fonts or photo col-
lages. Then there’s an age-guessing
game: figure out the true age of the
person in a photo. Challenging, even
mildly addictive.

on the main page. More inane stuff...
but fun in an unhealthy kind of way!

www.scribd.com

his is a free online library where

anyone can publish and discover
documents that are non-copyrighted
and not considered illegal in the United
States. These documents could be per-
sonal documents like school papers,
PowerPoint presentations, research
articles, funny pictures, free online
books, commentaries, spreadsheets...
whatever you can think of. Scribd
started off as a project to share docu-
ments in different file formats residing
on different systems, viewable online
without the need of a particular soft-
ware on the viewer’s system. You can
upload documents without signing up.
This encourages casual users to share
stuff, in turn making Scribd a large
storehouse of information.

Apart from potentially benefiting
the world, why publish? Well, a need to
make public a piece of writing arises
when the subject or document is con-
troversial, when a review is needed for
an article, to promote unpaid work,
and so on. You can publish documents
in the Word, PowerPoint, PDF, Excel,
and PostScript formats (loosely
speaking), and to view the documents,
you just need a Flash-enabled browser.

Scribd also allows you to upload a
document and keep it private. When
this is done, you get a secret URL that
can be shared with whomever you’d
care to include in your privy group.
Only, you need to sign up to be able to
do this, but that process isn’t time-
consuming or difficult in the least.

Other than uploading and viewing
documents online, you can also con-
vert between the Word, PDF, plain-
text, HTML, JPEG, PowerPoint, and
Excel formats—and even convert doc-
uments to audio (text-to-speech)! The
audio format is MP3, allowing you to
put it on a portable player.

If you're up late at night because
you’ve been dumped and are feeling
suicidal, read through funny yet real
“Bad Date Stories.”

About enough of a review—you get
the general idea. The site’s design and
layout could have been better, we
must say. It’s animation-less and not-
so-colourful to boot. Having said that,
the site is constantly updated, and

there’s a section called “Coming Soon”

Scribd: spreading joy to the world and all that

“How to design a good API and
why it matters,” and “Why men won’t
dance.” Those were the two docu-
ments at the top of the list exactly
when we wrote this. It’s as random as
it gets—and it’s not a blog either. You’ll
get a clearer picture when you visit the
site. There’s a search, so don’t worry.

www.lifetips.com
73 L ife tips” sounds vague; it could
sound like the site might lecture
you on how to lead a good life. The
thing is, these are actually tips—as in
“tips and tricks”—for almost anything
you can think of, insofar as you're a
regular human being. The site boasts
of more than 95,000 tips. Advice is in
all the typical topics—like entertain-
ment, events, food and drink, home
and garden, and such. The cool thing
is, you get specific pointers. Did you
know bedrooms at between 20 to 22
degrees C are good for promoting
sleep in people suffering from aller-
gies? If you’re buying a vacuum
cleaner, what exactly should you keep
in mind? Need to understand the signs
of a cheating spouse?

ATicreTsMow
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Lifetips—when you can’t figure yours out!

There are tips on serious stuff like
Business, Employee Management,
Religion and Spirituality, and more, as
also in unheard-of categories like
“Gay Marriage tips,” “Cigar tips,” and
“Body Jewellery tips.” Tips can be
rated and commented upon, too, to
add to the fun. Registering allows you
to submit your own tips, and send tips
on the site to your friends and feed
them to your MySpace, Google,
Yahoo!, and Friendster pages.

The site takes itself pretty seri-
ously, which we can’t fault: you can
compile your favourites to create an
e-book that you can download for
free. You can have this e-book
printed in paperback with your
name and a personalised message
on the cover, and have it sent to a
friend for a fee! m

prakash_ballakoor@thinkdigit.com
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WINDOWS XP

ista has already been released, but
‘ 2 most of us still use XP—and so, we
bring you yet another compilation
of tweaks and tips to enhance your
experience with XP. Do make a backup of
your Registry before trying any tip
involving Registry changes.

Scheduling Connecting And

Disconnecting From Your ISP
With many ISPs using PPPoE-based
connections, and many ISPs having
awkward schemes such as night-
unlimited starting at 2 AM, it’s a good
idea to schedule your dialling process

RAZDIAL ToFTConnSItion Sdisconmect

Gl A whackied  DOANTT
Tawk:

Schedule the dialling to your ISP

rather than staying up late at night.
Once connected, your downloads can
start. You can also schedule to connect
to VPNs.

First we create a batch file. Start
Notepad (or any other text editor). Enter
the following:

RASDIAL <Connection Name>
<Username> <Password>
<Connection Name> should be your
exact connection name. Save the file
using a suitable name such as
“DIALNET.BAT”.

Now create a schedule by clicking
on Scheduled Tasks in the Control
Panel. Double-click on Add Scheduled
Task. Click Next. Browse and choose the
path of the BAT file. Choose the type of
frequency you want the task to run at.
Next set the time and date. Finally
enter the password for the account
running the dialler. You can further
make changes to the schedule by right-
clicking on the newly-created scheduled
task and clicking on Properties.

So why would you want to make
changes? Well, many more settings can
be applied, and multiple schedules can
be allotted. Say you connect between 12
and 8 AM, and then you want it to
connect at 1 PM again. Such options are
available only once you’re done adding
the schedule through the Wizard.

Similar to scheduling a connection,
disconnection can be done in the same
manner. Some alterations in the batch
file creation are needed. First, create a
new text file and enter
RASDIAL <Connection Name>
|disconnect

Save the file as a BAT file, for
example, “DISC-NET.BAT”. Be sure to

enter your exact connection name in
place of <Connection Name>. Once
again, like the connection schedule,
create a schedule in the same manner
only this time choose the Disconnecting
BAT file.

Disable Expiring Of

Windows Passwords
Windows XP Professional’s password
expires after 42 days. You can disable
expiring of Windows passwords if this
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Passwords will never expire again

is a bother. In the Control Panel,
double-click on Administrative Tools,
then Computer Management. Expand
Local Users and Groups. Under Users,
right-click on the account of your
choice and click Properties. Check the
box for “Password never expires”.

Enable “Pin to Start menu”

For Folders
As it stands, it is only possible to pin
programs or shortcuts to the Start
Menu, but no folders. To add this, in
the Registry Editor, browse to HKEY_
CLASSES_ROOT\Folder\shellex\Contex
tMenuHandlers. Create a new key by

[+ k] [ B ' RS-
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Now you can pin folders to the Start Menu

right-clicking in the right pane and
selecting New > Key. Enter “{a2a9545d-
a0c2-42b4-9708-a0b2badd77c8}” as the
key name. Now that that’s done, right-
click on any folder in Windows
Explorer, and you will see a “Pin to
Start menu” option.
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Change The Internet

Key’s Functionality
Almost all keyboards, cheap or costly,
come with special keys including an
Internet key. You can choose to make that
key load another application instead of
the browser. (The keyboard drivers often
provide this capability, but sometimes
they don’t.)

To change this, in the Registry Editor,
go to HKEY_LOCAL_MACHINE\
SOFTWARE\Microsoft\Windows\Curren
tVersion\Explorer\Appkey\7. Create a
new String Value by right-clicking in the
right pane and selecting New > String
Value. Enter the name as “ShellExecute”.
Double-click on the newly-created String
Value and enter the Value as the path of
the file you want to run when you press
the Internet Key. Click OK.

Add Safe Mode to the boot options

A Prettier Volume Control

Few people know that the Volume
Control has a hidden, compact-looking
profile. You can create a shortcut with
the command as “sndvol32 [s” or by
pressing [Ctrl] + [S] with the Windows
Volume Control running. Press [Ctr]] + [S]
again to revert to the original size.

To open a minimal volume control
with only the single slider, you can create
a shortcut by first
right-clicking at
the location you
want to add the
shortcut, then
click New >
Shortcut, and type
in “sndvol32 [t”.

B Master Volume

EEX

A small Volume Control

Cha_rllé-in.g key functions

Enable The Windows ZIP tool

Windows XP comes built in with a
compression tool that reads ZIP files as
folders. When you install Windows, you
can open ZIP files using that tool. Then,
say you install WinZip or WinRAR, and
then uninstall it. You’ll then need to re-
enable the inbuilt ZIP file reader.

To enable Windows ZIP files as a
folder feature again, you can use a
simple command. At a command
prompt, enter “regsvr32 %windir%\
system32\zipfldr.dll”. Press [Enter].

Adding Safe Mode To Your
Boot List

At times you might need to switch to
Safe Mode to fix a problem such as a
virus infection or uninstalling drivers.
You can add an entry to the boot list. To
do this, go to Control Panel > System (or
simply press [Windows] + [Pause/Break]).
Click on the Advanced tab. Then, click on
the Settings button under the Startup
and Recovery section. Click on Edit under
System Startup to indirectly edit the
boot.ini file. Add the following entry:
multi(0)disk(0)rdisk(0)partition(2)\WIN
DOWS="Microsoft Windows XP - Safe
Mode” [fastdetect [safeboot:minimal
/sos [bootlog

You can add more entries if needed to
boot any Windows installations on other
disks or partitions.
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Remove Default Shared Folders

Windows XP comes with a shared
folder called Shared Documents which is
visible when you open My Computer. You
can remove the folder by removing a key
in the Registry. (You might want to do
this because, for example, viruses can
end up there through an infected
network.) Browse to
HKEY_LOCAL_MACHINE\SOFTWARE\M
icrosoft\Windows\CurrentVersion\Exp
lorer\MyComputer\NameSpace\Delega
teFolders\. Here, delete the key with the
name “{59031a47-3f72-44a7-89¢5-
5595fe6b30ee}”. The shared folder will
disappear.

Access Desktop From Taskbar

One of the easiest ways to access
programs is to use Quick Launch. In the
cases of My Documents or Desktop
icons, it’s not possible to copy all these
into the Quick Launch: instead, right-
click on the taskbar, click on Toolbars,
and choose Desktop. Your Desktop will
appear on the taskbar. Now you no
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Access the Desktop from the Taskbar

longer have to minimise all your
windows to access items on the desktop.

Similarly, you can also first create a
folder with a suitable name with
shortcuts for your favourite programs.
Next, right-click on the taskbar and
then on Toolbars > New Toolbar. Point
to the folder containing your shortcuts
and click OK.

Automatically Terminate

Hung Programs
When programs lock up or stop
responding, you are forced to [Ctr]] + [Alt]
+ [Delete] > End Process. This tweak lets
Windows automatically shut down hung
programs. In the Registry Editor, browse
to HKEY_CURRENT_USER\Control
Panel\Desktop. You will find a String
Value called AutoEndTasks. Double-click
on it and change the value to “1”. You can
also set the timeout value by double-
clicking on the WaitToKillAppTimeout
String Value and changing its value to the
time in milliseconds before Windows kills
the task.

Disable The Windows CD

Writing Function
Windows XP comes with CD writing
7= software which
can be used if you
don’t have any
third-party
program to do
that. If you do use
the third-party
software, you can
disable the inbuilt
writing feature.
Go to My
Computer. Right-
click on your CD
or DVD writer and click Properties. There,
click on the Recording tab, and uncheck
the box “Enable CD/DVD Recording on
this drive”.
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Stop XP from writing
your CDs

Disable Sending Of Windows

Error Reports
When a program crashes, it gives you an
error, then asks you to send a error report
to Microsoft—which you usually abort or
ignore. You can disable the popping up of
the option altogether: [Windows] +
[Pause/Break], click on the Advanced tab
and then on the Error Reporting button.
Here, you can click the Disable Error
Reporting radio button, or choose the
programs you want to exclude from
getting the error reporting option. Click
on Choose Programs to do this.

Add Additional Time Servers

Windows lets you synchronise
your system clock with a server on the
Internet. If you didn’t know about it,
double-click on the time and click on
the Internet time tab. Check
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Get your PC to tell time better

“Automatically synchronize with an
Internet time server” to enable it. At
times, the servers may be down. To add
servers, in the Registry Editor, browse to
HKEY_LOCAL_MACHINE\SOFTWARE\
Microsoft\Windows\CurrentVersion\
DateTime\Servers. Here, create new
String Values with names like 3 , 4, and
so on. Double-click on them to enter
the Value(s), and enter the server
address(es).

Windows Hard Drive

Optimisation
Windows has a system idle process that
optimizes your hard drive using when
you're away from the PC. In the Registry
Editor, browse to HKEY_LOCAL_
MACHINE\SOFTWARE\Microsoft\Windo
ws\CurrentVersion\OptimalLayout. Add
a new key by right-clicking in the right
pane and clicking New > DWORD Value.
Name it “EnableAutoLayout”, and give it
the value “1”.

Set Windows To Use Memory

Windows often spills data over into
the page file even when there’s free
memory available, which can cause a
drop in performance. You can’t entirely
rectify this, but you can do the following
to reduce the number of accesses to the
page file. In the Registry Editor, browse
to HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Control\Session
Manager\Memory Management.
Double-click on the DWORD
“DisablePagingExecutive” and change
its value to 1.

Unload DLLs From

System Memory
After a certain amount of time,
Windows starts caching DLLs into
memory, which can be a waste. You can
get Windows to automatically unload
the DLLs. Start the Registry Editor and
browse to HKEY _LOCAL_MACHINE\
SOFTWARE\Microsoft\Windows\Curre
ntVersion\Explorer\. Create a new key
called “AlwaysUnloadDLL”. Change the
(default) string value to “1”.

Hide And Show Accounts

Every account created on Windows
XP will show up on the logon screen. If
certain accounts are inactive, you can
hide them from just the logon screen. In
the Registry Editor, browse to
HKEY_LOCAL_MACHINE\SOFTWARE\Mi
crosoft\Windows NT\CurrentVersion\
Winlogon\SpecialAccounts\UserList.
Here, for every account you want to hide,
right-click in the right pane and select
New > DWORD. Give it the exact name of
the account. Double-click on it and set a
value of “1” to show it or “0” to hide it.
Administrator accounts are usually
hidden; you can enable the Administrator
account in a similar manner.

Limit Logon Hours For Users

Parents might want to limit their
children’s computer usage, so they can
set a time limit only between which
they will be automatically allowed to
log into their Windows account.
Limited usage for particular users for
certain time periods can be set through
commands. The command for doing
this is:
net user <Username> [time:<Parameters>.
For example, “net user DIGIT [time:M-
F,08:00-17:00” will only let the user
DIGIT log in between 8 and 5 from
Monday to Friday.

n Remove Windows Messenger
Most people use Windows Live
Messenger (MSN) instead of Windows
Messenger, and the latter can often be
an annoyance. You can remove Windows
Messenger by typing the following
command at a command prompt:
rundll32 setupapi,InstallHinfSection
BLC.Remove 128 %SystemRoot%\INF\
msmsgs.inf

Assign A Shortcut Key To
Any Program
Any program can
be launched USING| s wobt cosssa,
the keyboard by | j =
assigning a [
shortcut key to it. | o
Right click : :
the program’s
shortcut (the o
program to o
which you want
to assign a
shortcut key). In
Properties,
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under the Shortcuts to anything

Shortcut tab,
“Shortcut key” is, by default, “none”.
Just click in the box and chose an
alphanumeric key to be assigned as the
shortcut key. Windows will assign
[Ctr]] + [Alt] + [(Alphanumeric Key)| as
the shortcut key.
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Shutdown, Restart, And Logoff
Icons On The Desktop
You might want to have shortcuts on the
Desktop for shutdown, hibernation, etc.

Right-click on the Desktop and make a
new shortcut by selecting New > Shortcut.

Then in the Type the location of
the item: box, enter “shutdown.exe -s -t
00”, where “00” is the delay in seconds.
(You can increase it.) You will then be
asked to select a name (call it
“Shutdown”, for example).

After creating the shortcut, you can
change the icon assigned to it by right-
clicking on the shortcut and selecting
Properties. The window that comes up
next has a “Change Icon” option, which
is easy to use.

For a Restart shortcut, use
“shutdown.exe -r -t 00”. Replacing -r by -1
gives the code for logging off:
“shutdown.exe -1 -t 00”. Fast user
switching is also possible; the code for
that is “Rundll32.exe User32.dll,
LockWorkStation”. Similarly one can also
make a shortcut for Standby/Hibernation.
If Hibernation is enabled, the computer
will hibernate, else it will go into Standby.
For this, use “%windir%\system32\
rundll32.exe PowrProf.dll,
SetSuspendState”.

Get Rid Of The Windows Update

“Restart Later”
To get rid of that nag screen, run the
command “gpedit.msc” to launch the
Group Policy Editor. Navigate to Local
Computer Policy > Computer
Configuration > Administrative
Templates > Windows Components >
Windows Update. Select “Re-prompt for
restart with scheduled installations”,
right-click on it, and choose Properties.
Check the enable option, and select the
restart interval (in minutes) to be long
enough not to bother you.

Restore The Show Desktop Icon

Did you know you can “Show
Desktop” by using [Windows] + [D]? That
apart, sometimes, the Show Desktop
icon in the Quick Launch bar goes
missing. The following is the manual
method to re-create the Show Desktop
icon. Copy the following into Notepad:
[Shell]
Command=2
IconFile=explorer.exe,3
[Taskbar]
Command=ToggleDesktop

Save this file as “Show Desktop.scf”,
and then drag it to the Quick Launch
bar. You can even use the Regsvr32
command for the same thing. At a
command prompt, type in the following:
regsvr32 [n [i:U shell32.d11
The Show Desktop icon should now

be visible in the Quick Launch bar.
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ash—an acronym for Bourne-again

Shell, is a Unix shell written for the
GNU Project and is the default shell for
Linux and Mac OS X. The beauty of Bash
scripts is that they let you accomplish a
group of tasks quickly and without
much intervention from the user—much
like batch files in Windows. The syntax is
similar to structured programming lan-
guages like C, and will be easier to under-
stand for people with prior knowledge of
any such programming language. We
assume that you are familiar with
GNU/Linux commands and with the fun-
damental concepts of programming.

Saving And Running Your Scripts
You can use any text editor to write
your Bash scripts—any Unix-based OS
you work on should have Vim installed.
Save the scripts with the .sh extension
anywhere on your computer. After
saving it, open the terminal (as root, if
necessary) and go to the folder where
you saved the file. To run your script,
type bash yourscriptname.sh in the
terminal prompt.

A Very Simple Script
The first thing that anyone new to pro-
gramming learns is how to print “Hello
World” on the screen:
echo Hello World

This is a one line script where the
action performed by the script is to print
“Hello World” on the computer screen.

Variables, Functions and If
Variables can be used in Bash as in any
other programming language. It is sim-
pler here, since there are no data types
to worry about—a variable can be a
number, character or string. They need
not be declared as in structured lan-
guages; they’re created as soon as you
assign a value to them.

Variables are of two types: global,
which are recognised throughout the
program, and local, whose recognition
is limited to a function. If you have a
block of code that you may want to
execute a number of times, you write a
function instead of the entire block all
over again, saving time and resources
in the bargain. Take a look at the
example below:

#1/bin/bash
HELLO=Hello
function hello
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Bash it up!

Get started with writing your own Bash scripts

{

local HELLO=World
echo $HELLO

}

echo $HELLO

hello

echo $HELLO

In the second line, the global vari-
able HELLO is assigned a string value
“Hello”. The third line declares a func-
tion called “hello”, which runs the
code between the braces every time
the function is called. Here a local
variable HELLO is assigned a string
value “World” which is valid only
during the execution of the function
“hello”. Notice that we have used the
common name HELLO for both Local
and Global variables just to show that
this is possible. In the sixth line, the
function declaration is complete. Line
7 displays “Hello” on the screen; in
the next line, the function “hello” is
called which prints “World” on the
screen. The ninth line, however,
prints “Hello” again. The string
“World” is stored in the local variable
HELLO but does not overwrite the
value of the global variable of the
same name.

You can add comments to your
script to make it easier others to
understand—any line starting with a
“#” is interpreted as a comment and is
not processed.

The “if” command lets you decide
the direction in which the script
should proceed depending on condi-
tions you set. The syntax is as below:
if condition
then
#condition is true
execute all commands up to else statement
#The else block is optional
else
#condition is not true
execute all commands up to fi
fi

Some Basic Tasks

1. Renaming multiple files

The following script renames all the
files with extension .txt to .bak.

#Use the “for” structure to run through all
files

for f in *.txt;

do

mv “$f” “${f%.txt}.bak”;
done

Similarly, to remove the prefix
“prefx” from a group of files, the fol-
lowing script is used.

for f in prefx-*;

do

mv “$f” “s{f#prefx-}";

done

Here ${f#prefx-} removes the prefix
“prefx” from the filename.

2. Backing up files modified within
the past 24 hours

Here, we will back up the files created
in the current directory within the past
24 hours in a “.tar.gz” file.

#1/bin/bash

FILEBACKUP=backup-$(date +%m-%d-%Y)
incrback=${1:-$ FILEBACKUP}

tar cvf-"find . -mtime -1 -type f -print* >
$incrback.tar

gzip $incrback.tar

echo “The directory $PWD has been
backed up in archive file
\"$incrback.tar.gz\".”

Line 2 of this script embeds the
date in the backup filename. Line 3
introduces the string variable incrback
as the filename of the archive. Line 4
tar condenses the current directory
into a single tar file, while the fifth
line gzip compresses the resultant tar
file to the final tar.gz output file. The
last line prints to the console that the
current directory has been backed up
to the archive file.

3. Mount and unmount drives as
you please

You may wish to mount and/or
unmount your drives swiftly and at
one go:

# mounting the drives

# This mounts a partition of your hard drive
mount /dev/hda2 /hd -t ext3

# This mounts the floppy

mount /dev/fd0 /mnt/floppy

# This mounts the CD-ROM

mount /dev/cdrom /mnt/cdrom

And for unmounting:
# unmounting the drives
umount /dev/hda2
umount /dev/fd0
umount /dev/cdrom

Ready to Bash?
We hope that you’ve warmed up to
the concept of Bash scripting by now.
This is barely the surface—Bash
scripting becomes more interesting
and powerful as you delve deeper, and
practice is the best way to take your
Bash programming skills to new
levels.ll
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ADOBE LIGHTROOM

dobe’s Lightroom is an amazing new
tool for pretty much anyone with a

o TEnEmE ERLES LT AR e S UFTER TR

Fle . Edit wiew Search Teals  Decuments Help
i = i
Maw  Opan Sava - Pant...

Jrename extensions td ¢

! /binsbash

for f in *+.txt;
do

ny T L
done

B kot A o Ao, Pt i e L LA e s

Configuring the Quick Collection

digital camera, and needs to do post-
processing tasks. It acts like your own
little photo studio and helps handle large
collections of images. It has many of
Photoshop’s features put into an easier-to-
use, smaller package. Here are some tips
that can help unleash its features.

Add/Remove From Quick

Collection
The first step is to import images into the
Lightroom library by clicking on
File > Import Photos. There’s also a
special library called Quick Collection,
where you access your set of important or
favourite photos from. You can access
Quick Collection by starting the Library
module and then clicking on Quick
Collection in the drop-down. To add
photos to your Quick Collection, you can
right-click on a particular photo in the
Library module, or click on “Add to Quick
Collection”. Alternatively, you can move
the mouse to the top right of the
thumbnail or image until a small circle
appears. It acts as a toggle to Add or
Remove images from Quick Collection.

Disable / Enable Panels

To quickly hide and unhide panels
on the screen, click on the arrows at the
edge of the screen. Once they’re hidden,

you can unhide them by clicking on the
same arrow again. Moving the mouse
pointer over the same arrow will
temporarily display the panel.

D Hide All Panels

Export presets to other computers

To completely hide all the panels in a
single move, press [Shift] + [Tab]. It acts as a
toggle, so pressing it again will show all
the panels. Similarly, to hide all the side
panels, press [Tab]. Press [Tab] again to
toggle the hide. The same commands are
accessible by selecting Windows > Panel.

Easily Export Presets

Once you’ve started processing a
certain image under the Develop module
and want to apply the same values to
other images in the future, you can save
the preset by clicking on the Presets panel
on the left. Clicking on the “+” sign will
open up a window asking you to enter a
name for the preset. This newly-saved
preset and all other presets will be saved
in \Documents and Settings\
YourUsername\Application Data\
Adobe\Lightroom\Develop Presets.
Similarly, the settings for some of the
other features are saved in \Documents
and Settings\Administrator\Application
Data\Adobe\Lightroom. You can move
these to another machine for later use.

Remove Red-eye

You can fix red-eye in photos by
using the red eye tool in the Develop
module. Zoom into the area of the eye.
Simply click on the Remove Red Eye
button, and click and draw a box
around the eye. Lightroom will remove
the red-eye effect. You can further alter

Creating Web galleries
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the size of the effect and the darkness
by using the sliders for pupil size and
darkness.

Create Web Gallery Using

HTML / Flash
One of Adobe Lightroom’s features is to
allow users to export your images as
Web galleries to the Internet. To do
this, click on the Web module button.
Choose from one of the Web templates

Upload to an FTP server with ease

available in the templates browser at
the left. Any customisations to the web
template such as colours can be done to
it. Click on “Preview in browser” to get
a preview, and then on Export to
export the gallery to a folder on your
hard drive.

Export To FTP Servers

Exporting of image galleries to an
FTP server can be done directly through
Lightroom. Click
on the Web
module button.
Scroll down the P P —
right panel to the
Out section. Click
on the drop-down
for “FTP server”
and click Edit.
Here you can
specify the
address for the FIP server and the
authentication information. Click the
Upload button to upload the Web gallery
to the FTP server.

Quick Switch To Modules

Lightroom is split into modules—
Library, Develop, Print, Slideshow, and
Web. You can click on the buttons on the
module selection panel on the top, but
there are keyboard shortcuts: [Ctr]] + [Alt]
+ [1/2/3/4/5] to access the modules.

Auto-importing images

Set Up Auto Import

The Auto import feature makes
Lightroom watch a particular folder for
any new images, so you don’t have to
manually keep adding images to your
gallery. To set up Auto Import, go to File
> Auto Import > Auto Import Settings.
Choose a folder to watch, and a
destination for the imported photos. You
can choose to set some effect presets to
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the imported images as well. Click OK.
Then select File > Auto Import > Enable
Auto Import to make Lightroom
monitor the specified location.

D Rejecting And Deleting Images
You’ll often find several bad photos
in your collection that you want to
remove. You can set flags to photos, one of
them being “Rejected”. To reject a photo,
right-click on the thumbnail in the panel
at the bottom or in the library mode, and
select Set Flag > Rejected. The shortcut is
[X]. To delete the rejected images, you can
either go to the Photo menu and click on
Delete Rejected Photos, or simply use the
shortcut [Ctr]] + [Backspace].

Image Filter

Picked images are images you would
like to access at a different time. A filter
for the flags as mentioned above is
available in Lightroom so you can easily
view all the rejected photos or the picked
ones. (“Picked” is one of the flags.) This
can be accessed by clicking on the buttons
on the bottom panel under the Filter
section. The same filter can be used to
display only images above a certain rating.

Full-Screen Mode
You can switch to full-screen mode
to hide the title-bar and taskbar, thus

Quick Develop automatically improves pictures

increasing your workspace. Press [F] once
to hide the title bar. Pressing [F| again
hides the taskbar; pressing it again brings
you back to the normal mode.

Quick Develop

Quick Develop is a feature in the
Library module. It lets you quickly set the
optimum parameters for a particular
image. Click on the Library button. Scroll
down to the Quick Develop section in the
right panel. You can select one of the
available presets, or click on Auto Tone.
Auto Tone will use the best parameters for
your image. The presets are where you can
directly click to make an image greyscale
or sepia, for example.

Keeping Track Of Edited Images

While making changes to multiple
images, without saving them, you can lose
track of which images have been edited.
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It’s quite easy: on the thumbnails of the
images which have had modifications
done to them, there’s a small box at the
bottom right of the thumbnail. You can
reset the modification by right-clicking on
the thumbnail, clicking on Develop
settings, and clicking Reset.

D Apply A Preset On All Images
Once you’ve applied a set of filters
for a single image, you might want to
apply the same effects to a batch of
images. The Synchronize tool can be
used for this. First, in the Develop
module, you select the image you want
to modify. Add effects and filters to it.
You then press [Ctrl] + [A] to select all
the images, or use [Ctrl] to manually
select the images. Next, click on the
Sync button in the right panel. You will
then be prompted to choose—from a
window with checkboxes for all the
parameters—which effects you want to
replicate on the other images. Unselect
the ones you don’t need and click
Synchronize.

Metadata Browser

The Metadata browser lets you easily
browse through photos in a better-sorted
manner. To access the Metadata browser,
enable the Library mode, then on the left
panel, scroll down till you come across
“Metadata browser”. Here you can choose
to access images by categories such as
camera, lens, date, location, etc. Such
information typically comes from the
“EXIF” information that digicams embed
into images.

n Assign And Remove Keywords
Keywords will help improve the
functionality of the Metadata browser.
Most people enter keywords for an image
through the “Keywording” section in the
right panel in Library mode.

Using the Keyword Stamper

An easier and more efficient way
is to click on the Grid View button in
the Library mode. Enable the
keystamping tool by right-clicking on
the arrow pointing down, which is on
the same bar as the Grid View button.
Enable Keyword. A keyword stamper

will appear on the bar. Click on the
text entry box next to the stamper
and enter the keywords. Click the
keyword stamper tool and click the
thumbnails of the images you want to
apply the keyword to. Click on the
keyword tags section in the left panel,
and you can now choose from the list
of keywords to show the corresponding
images.

Virtual Copies

Creating duplicates of an image—
SO you can try out variations—can take
up a lot of space. Virtual copies store
the parameter information and effects
that you add and apply it to the
original image thus acting as a proxy.
This can save a lot of disk space. To
create a virtual copy, right-click on an
image or thumbnail and click on
Create Virtual Copy. A new image with
a little paper-fold tag at the bottom left
of it will appear. Make as many
modifications to it as you like, and
finally, when you’re satisfied, you can
convert the virtual copy into a real
image by exporting it to a file.

Fix Crooked Pictures

Photos sometimes end up a little
tilted. Lightroom helps you fix this
problem very quickly. Switch to the
Develop module by clicking on the
button in the module selection panel.
Click on the Crop Overlay button and
draw a box around the selection you
want to straighten. Use the Straighten
slider to the right to rotate the image.
An even easier method is to use the
Straighten tool and draw a line
between two points on the photo, for
example, the feet of a person,
assuming he’s standing on a flat
surface, and Lightroom will straighten
the image for you.

Compare Results

It’s a good idea to compare the
images you’re working on with the
original to get a clearer idea of
progress. Click on the Before and After
View button to have a real time preview
while in the Develop module.

D Lights On, Lights Off!

Lightroom has a feature that lets
you temporarily mask off the toolbars
so the images being worked on are
prominent. Do this by clicking on the
Window menu and then on Lights Out.
Press [L] will cycle through the various
light modes such as Dim Lights, Lights
On, Lights Off.

Open An Image In

Third-party Applications
In cases where Lightroom isn’t doing
enough for you, or you need a feature
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Rossi Fernandes

0obar2000 has been around for a

while, but people tend to be turned
off by the interface, which looks a lot
like Notepadwith a few buttons. Here,
we’ll give you a gist of the possibilities
and things to do to reduce your Winamp
withdrawal symptoms.

One step closer to Audiophilia
One of things you might hear from users
of Foobar2000 is that it’s far better than
Winamp when it comes to quality of
music. One of the reasons for these
claims could be the 32-bit output depth
ceiling—which, however also needs to be
supported by your hardware. Higher bit
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Set the output depth your hardware supports

depths mean more information can be
recorded and played back. 32-bit is still
pretty far-fetched even now, and most
cards like the Audigy can only do upto 24
bits. Winamp is limited to a maximum of
24 bits as well but foobar2000 works with
32-bit float point, which along with
dithering and noise shaping can give the
tiny advantage that hardcore audiophiles
want. To do this, go to File > Preferences
and click on Output under Playback. You
can alter the output data format to the
bit depth supported by your hardware.

Note: Your sound card needs to support
the bit depths you choose to use.

Equalizer

You also have an 18-band equalizer at
your disposal, as opposed to Winamp’s
10-band equalizer, which lets you get
more accurate audio results. You can
access the equalizer by going to File >
Preferences > Playback > DSP Manager.
Add Equalizer to Active DSPs and click
on Save All. Click on Configure to open
the Equalizer. Once added, you can
access the equalizer from the main
window by clicking on View > Equalizer.

Beyond All Recognition

Start with foobar2000’s Notepad-like interface and work your way up to a media
player that’s right up there with the rest
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The 18-band equaliser

Kernel Streaming
Kernel Streaming skips the Windows
mixer and is supposed to give better
sound results than DirectSound. It also
means that any volume control change in
Windows will not alter foobar’s volume.
The Kernel Streaming plugin does not
come with Foobar2000 any more. You can
download it from the Optional compo-
nents section on Foobar2000’s site—
www.foobar2000.org. To install this
plugin, download the zip files and unzip
them into the components directory:
\foobar2000\components. To enable
Kernel Streaming, click on File >

BT LT [ ea————
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Kernel Streaming: Leave Windows out of it

Preferences > Playback > Output. Click on
the Output Device dropdown and choose
KS: “Your Sound device”. Click on Save AlL

Enhancing The Interface

The biggest drawback of Foobar2000 is
the dull interface. There are plenty of
interface-enhancing plug-ins to give
foobar2000 a complete makeover—one of
the most famous is ColumnsUI.

Columnsul

Get ColumnsUI from http://yuo.be/
columns.php. The installation of the
plugin is as before—unzip the file into
foobar2000’s components directory,
restart foobar2000 and you’ll be
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prompted to choose between the
default foobar2000 interface and
ColumnsUI. Volume control can be
used by clicking on the current
volume on the bottom-right of the
window.

You can get readymade themes from
the foobar2000 forums.

Add a Ul to foobar2000 .

Ty, 1T Gaer 0N A KW

ReplayGain

Normalization is a process by evening
out the differences in volume in either
single tracks or albums. ReplayGain is
a feature to do just this. ReplayGain is
built into Foobar. You can alter the
ReplayGain of tracks by right clicking
on a particular track and clicking on
ReplayGain > Edit ReplayGain Info
(advanced). Here you can manually
enter the amount of amplification you
want. Normalization for multiple
tracks or albums can be done in a sim-
ilar manner.

Keyboard Warrior

It’s best to use the keyboard shortcuts
to quickly change volume or track or
start playing a random track. There is a
default set of shortcuts already, and
you can change or add more in File >
Preferences > General > Keyboard
Shortcuts. Create as many global short-
cuts as possible—they will let you do
tasks even while foobar2000 is min-
imised to the system tray.

There is a lot more to Foobar—a good
place to start finding out is on the
Foobar forums—http://forums.foobar
2000.org. You’ll find plenty of plugins
and customised layouts to try out and
modify for yourself. You can spend
plenty of hours having fun with on
Foobar—all you’ll need is some patience
and a willingness to experiment. ll

rossi_fernandes@thinkdigit.com
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YAHOO! MusIC
JUKEBOX
(MUSICMATCH
JUKEBOX)

usicmatch Jukebox, or Yahoo!

Music Jukebox as it is better
known now, was known as an
alternative to Winamp a long while ago.
Yahoo! has breathed fresh life into
Music Jukebox; we speak about ways to
make the best of its capabilities.

n Set Ratings For Tracks,
Albums, And Artists

To enter ratings, just move your

mouse to the number of stars you
want to assign in the ratings panel at
the top. You can also set ratings by
clicking on the stars next to each track
in the playlists.

Tag Your Music

Often, a lot of our music is never
tagged properly because we are too lazy
to enter information manually for each
of the tracks. Yahoo! Music Jukebox, like
most other media players, has a built-in
feature which first analyses the track
and then looks up a database on the
Internet called Gracenote.

Click on the Playlists tab and then

on one of the playlists. Click on a
particular song, artist, or All, and click
Edit Track Info or Edit > Song
Information. Click on Suggest, and a
suggestion for the track will be
displayed. Click on an appropriate one
and click Accept Selected Tags if it’s
right, or else choose Skip.

Create And Share Playlists
You have the choice of creating

multiple playlists in Yahoo! Music
Jukebox. It can be for the purpose of
separating various genres of music, or
for organising your music. To create a
new playlist, right-click on the Playlists
tab to the left and choose New Playlist
(or press [Ctrl] + [N]). Sharing playlists is
an easy way to tell your friends what
you’re playing, and if they’ve got the
same songs, they’ll be in sync with
you... you get the idea.

Sharing a playlist is simple. Click on
a newly-created playlist, and the upper
panel will display options to share the
playlist with others through e-mail,
instant messenger, or a Web link that
can be mailed to your friends or posted
on your blog. You can also enter a
description for the playlist.

n Enabling Visualisations
Visualisations in Music Jukebox
are disabled by default. You can enable
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them by clicking on the View menu and
then on Show Visualizations. The main
playlist region of the player will be
replaced with the visualisation. It can
be disabled by using the same menu, or
by clicking on another tab. You can
switch visualisations by double-clicking
on the current one.

Encode And Compress Your
Music Collection
Music Jukebox provides you a selection
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Encoding your music collection

of four formats to select from. Other
than MP3, you can choose Ogg Vorbis
for good compression, or FLAC for
lossless compression and highest
quality. You can set your preferences for
encoding by clicking on the Edit menu
and then on Preferences. Click on CD,
and the settings can be found under the
Import Options.

Monitor Your Music Database

You have the option to let Music
Jukebox scan your music collection for
any new entries. Select Edit >
Preferences. Click on My Music, then
on Add, and choose the paths you wish
to add. You can then choose the

My Mo T s

CAMPD,

Bl i Ruwie |

Maonstoeing Optiont
= Pesofcaly scan deeciodss averp |0 | = foated

Sizen Moy

Filu Senrisbons:
Click the butor below 10 set-shool Muasic Jubsbox ay mp defauk music plapes,
Siet i el plager

Ll the Bt ko o 2t peciic ypes. of Ses plapad beYahoo! Mutic Juksbox

Soect Al

St Nirm,

Monitor all the music you have

frequency of scans or manually scan
the folder.

Find Similar Music

Yahoo! Music Jukebox uses an
online feature that lets it suggest songs
and artists similar to your taste. Click

on Y! Unlimited, and enter an artist or
song name. Next, right-click on one of
the results and click Create Similar
Song Playlist. Here, you can hear a
sample of the song, or buy the
complete track or album.
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Share selectively over a network

Share Specific Music Over

A Network
Yahoo! Music Jukebox can act as a
music server on a network. Here you
can choose to only share a couple of
playlists instead of your entire
collection. Select Edit > Preferences.
Scroll down to the Network Music
section. Uncheck “Share my entire
music collection”, and click on “Let
me Choose”. Here you can choose
specific playlists to be shared for
network access.

Compact Mode

You can quickly switch to the Mini
mode by clicking [Alt] + [N], or by going
to View > Mini mode. While in the mini
mode, you can select from one of the
mini skins by right-clicking on the
interface, then clicking on Change Skin
and selecting the skin of your choice.

The Mini Yahoo! Music Jukebox

Quick Shortcuts

Here are some tips to make
manoeuvring around Yahoo! Music
Jukebox a lot easier. H

Yahoo! Music Jukebox

Play/Pause [Ctrl] + [Spacebar]
Stop [Ctrl] + [S]

Next Song [Ctrl] + [Right Arrow]
Previous Song [Ctrl] + [Left Arrow]
Volume Up [Ctrl] + [Up Arrow]
Volume Down [CtrI] + [Down Arrow]
Mute [Ctrl] + [F12]
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Your Questions, Our Answers

PCs restarting
randomly... pen
drives acting weird...
if it is broke, fix it!

Get Help Now!

E-mail us your computing
problems along with your
contact details and
complete system
configuration to
sos@jasubhai.com,

and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Peculiar Ping Problem!
For the past few days, | have faced a peculiar
problem—my computer restarts when I key in
the “ping” command!
Kiran Jambhekar

Either your network card drivers are corrupt

or your network card is damaged. Try to
uninstall and then install the latest network card
drivers to see if the problem goes away. If not, you
will have to get a new network card, which
should cost about Rs 300.

Ilustrations Harsho Mohan Chattoraj

Nokia Know-How

How can I use my Nokia 3230 as a modem to

surf using my PC? What PC configuration do |

require? How can | transfer downloaded games to
a Nokia 6600?

Raj Raj

In order to use your phone as a modem to
surf the Internet, you need to first install the
modem drivers for the Nokia 3230 on your PC.
These drivers are provided on the CD that came
with the phone; if you do not have it, you can
download and install them from
http://europe.nokia.com/A4144325. You will then
have to subscribe to a GPRS plan from your
mobile service provider, who will send you an
SMS message with the required settings—just
open this message and accept the settings, and
they will automatically be saved on your phone.
Connect the phone to the PC using the

DKU-2 cable when the PC Suite prompts you to
do so. After the installation completes, the Get
Connected wizard will launch to help you set
up your connection. A dial-up connection will
be created inside Network Connections. Your
service provider will give you the number you
need to dial. You should then be able to
connect to the Internet.

When you download a game to your Nokia
mobile, it will be saved as a message with
attachment (the game in this case), which you
can install later. You can therefore forward this
message to the 6600, and that user will be able
to install and play the game you downloaded.

Setting It Right
The left and right audio channels seem to be
swapped in my games. | can correct this prob-
lem in movies by custom mapping in Media Player
Classic. But how can I do this in games?
Neyo Kiran

A simple workaround for your problem

would be to simply switch your speakers
around, that is, interchange the right and left
speakers—but if you want to really get to the
root of the issue, read on. Most games allow you
to swap audio channels from within the in-
game audio options. There is no way to do it in
Windows, except in certain cases where the
sound card is bundled with a software utility
that can let you do so. A probable solution for
this problem would be to update to the latest
drivers for the sound card. If the sound card is
an old and obsolete one and no driver updates
are available, then purchasing a new sound
card would be your option.

One Two Ka Four!
I’'m running Windows XP SP2. When | plug my
Transcend 512 MB pen drive into the
computer, a message pops up in the notification
area: “Hi Speed USB Device plugged into a non Hi
Speed USB hub.” Where can I get drivers to make it
Hi-Speed? | have four USB 2.0 ports.

Is there any method to automatically transfer
all the messages I receive in Outlook Express to my
e-mail ID at Yahoo?

Can you mention any freeware or trialware
that converts Real Media files (like *.rmj) to MP3?

Devraj Santosh

The message you’ve mentioned appears
when you plug in a USB 2.0 device into a
USB 1.1 port, so the first thing you should do is
check the motherboard manufacturer’s Web site
to make sure that you have USB 2.0 ports. If
you’re sure about the four USB 2.0 ports, the
problem is probably that Windows does not
recognise the ports as USB 2.0. You should install
the latest drivers for your motherboard from the
manufacturer’s Web site. After this, Windows
should recognise the ports as USB 2.0, and this in
turn will allow it to recognise your pen drive as a
USB 2.0 device. If your ports are USB 1.1, however,
you can install a USB 2.0 PCI card.
Then, do you really need to download e-mail
to Outlook Express? Most e-mail providers let
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Genuine Disadvantage?
I have a Compaq laptop and Windows XP with 512 MB of RAM.
Recently, when | was surfing the Net, a Windows update was
available and I was asked whether to update it or to reject it. |
selected the option of updating it, as it was free of cost. Now the
problem is that every time I start Windows, it gives me a warning
that the Windows what I use is not a genuine one and says that |
am a victim of software counterfeiting, and I will be asked to
either get genuine or to resolve later. What can I do to avoid that
message? Is it possible to cancel that update or delete that?
Dr. Spoorthi

Windows Update installs the Genuine Windows

Component, which verifies whether the copy of
Windows XP you are using is legally licensed. If this is the
copy of Windows XP your laptop came with, contact Compaq
and have them resolve the issue. If, however, it was installed
by someone else or you did so yourself, your copy might be

illegal. This is a common case in India, because
bootleg copies of Windows XP are often
installed by computer “engineers” without the
knowledge of the customer.

The solution to this problem is, of course, to buy a legal
copy of Windows XP. If you did buy a legal copy of Windows,
read on.

On validation failure, you are directed to a page where
you are given the details about why the validation failed
and what are the recommended steps to be taken to fix
the problem. One of the steps lets you check whether you
can use the online Product Key Update Tool. If you have
Genuine Windows, but it was improperly installed using
an invalid product key, this tool allows you to convert
your computer to a genuine status without having to
purchase a new copy of Windows. If this fails, you should
contact the Microsoft Customer Service at
http:/[support.microsoft.com/gp/contactwga.

you forward all incoming e-mail to an address
of your choice, thereby eliminating the need for
Outlook Express altogether. If you do wish to
have Outlook Express in the picture, you can set
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The error is caused by an incompatible

version of a DLL file that was installed on
the system by different programs. Oleaut32.dll,
Olepro32.dll, Asycfilt.dll, Stdole2.tlb are some
of the common DLL files.

The error is most
likely a bad version of
oleaut32.dll. Follow
the directions below
to remove and rein-
stall this file. Since
this resolution
requires you to
modify the System
folder, we advise you
to observe extreme
S Lo caution: one wrong
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Forward your messages in Outlook Express by setting
up rules

up a message rule. Go to Tools > Message Rules
> Mail. Under “Select the Conditions for your
Rule”, choose “For all messages”, and under
“Actions”, choose “Forward it to people”. In the
text box below, the word “People” will be a
hyperlink—click on it and you’ll be able to enter
your Yahoo! e-mail address.

There are quite a few tools that can convert
Real Media files to MP3—for example, SUPER from
www.erightsoft.net/SSFO1.html, and WavePad
from www.nch.com.au/wavepad.

Installation Imbroglio
| have a system with a PIV 2.4 GHz processor,
Intel chipset Mercury board, 128 MB RAM, 40
GB hard drive. I have a problem installing any soft-
ware to Win98 SE; also, while installing from the
mainboard CD, | get the error 0x80070725:
“Incompatible version of the RPC stub.” This
started while installing jetaudio-6.
Sudhan Kum

ous problems.

Download the following DCOM (Distributed
Component Object Model) file: http://support.
installshield.com/kb/files/ Q105810/dcom98.exe
Select Start > Shutdown > Restart in MS-DOS
mode. Enter the following commands at the
command prompt:
CD c:\windows\system
rename oleaut32.dll oleaut32.0ld
exit

Windows will restart automatically. Ignore
the error message “A required .DLL file,
C:\windows\ system\oleaut32.dll, was not
found.” Log in as you normally would, and
double-click on the DCOM file to install the new
version of oleaut32.dll. Restart after the instal-
lation is complete.

Poof!
On pressing [Ctrl] + [Alt] + [Del], I find that the
Task Manager button has gotten disabled.
Arnab Deb

There could be two reasons for this. One of

the reasons: the account you use has been
blocked via the “Local Group Policy” or
“Domain Group Policy”. To re-enable the Task
Manager, run Gpedit.msc. Navigate to User
Configuration > Administrative Templates >
System > Ctrl+Alt+Del Options. Set the
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Make A Torrent Tracker!

Whether you want to start your own pirate empire (we take no responsibility) or
contribute to the community, this is where you start!

Sumedh Phalak

ou’ve been using torrents to down-

load large files like Linux distribu-
tion images and movies from the
Internet, and already know that
BitTorrent is the fastest and best way to
share files among large numbers of
users. But have you considered sharing
home videos, office clips, etc. with your
friends and relatives using torrents?

Most of us know that .torrent files
require a tracker to keep track of who
(peer clients) has which piece of a
particular torrent file. Azureus is a
popular Java-based BitTorrent client
with an inbuilt tracker.

Getting The Basics Sorted Out
You will require the Azureus Vuze client;
get it from the Digit April 2007 DVD, or
download it from http://azureus. source-
forge.net. If you don’t have the Java
Development Kit, you could get it off the
Digit January 2007 CD, or let Azureus
download it for you. Azureus prevents
basic users from creating a torrent
tracker, so you’ll need to switch to the
advanced user mode. Under View, select
Advanced, and then in Mode, select
Advance User proficiency.

Coming Down To It

For your torrent to work, you have to
create a server (tracker). To do so, navi-
gate to Tools > Options > Tracker >
Server. If you have a static IP, key it in.
If you're on a dynamic IP, things are a
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Select a service if you’re using a dynamic IP a
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ratios—beware of leechers!

The Windows XP SP2
Firewall will require you to
forward the ports used by
Azureus. The simplest way to
do it is by adding an excep-
tion for Azureus in the fire-
wall. Switch your Control
Panel to Classic View and
open Windows Firewall.
Under the Exception tab,
select Add Program. Browse
to the directory where
Azureus is installed, select
Azureus.exe, and apply the
changes.

little more complicated—you will have
to use Azureus along with dynamic
DNS services such as DynDNS,
Discoveryvip and No-IP; register with
them free of cost to use them. Once that
is done, key in the dynamic host name
given to you during registration. You
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Creating The Torrent
To create a torrent, use [Ctrl] + [N] or
go to File > New Torrent. Make sure
that “Azureus Embedded Tracker” is
selected; you can also share a direc-
tory in accordance with your require-
ments. On the third page of the “Make

il rw’s i . s

Keep the tracker healthy by seeding it continuously

will also have to keep the
dynamic DNS client running in
the background while your
tracker is up.

Azureus then automatically
checks if the dynamic IP is being
resolved or not. Enable the
tracker using the checkbox, and
let it use the default 6969 HTTP
port. To let others host their own
torrents using your tracker, turn
on Enable External Torrents. You
can even force these external
torrents to use the default port
by selecting the appropriate
option. The tracker also lets you
enable the UDP protocol, which
will trouble your server less than

Remember to select the type of tracker while
creating it

HTTP, but you won’t be able to
control clients’ download

a torrent” interface, don’t forget to
check the option to open the torrent
for seeding when done. Azureus will
then create the .torrent file in the
directory selected.

Distributing The Torrent
Completing all the above steps properly
will make Azureus seed the file. Seed
your file for a long time to prevent peers
from being left with incomplete files.
Finally, you can distribute the torrent to
your friends using e-mail or IM.

If you’re releasing your personal
videos or an amateur film using
torrents, don’t use your PC as a
tracker—it won’t be able to handle the
traffic. Instead, opt for an external
tracker service. H

sumedh_phalak@thinkdigit.com
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“Remove Task Manager” option in the right side

to “Disable” or “Not Configured”. Close
Gpedit.msc. Then run “gpupdate [force”.

The second possibility: the problem could
be because of a change in the Registry settings,
which can be corrected thus:

Open Regedit.exe, and navigate to and
correct the keys as below (you should be
Administrator on your machine):

[HKEY_CURRENT_USER\Software\Microso
ft\Windows\CurrentVersion\Policies\System]

“DisableTaskMgr”’=dword:00000000

[HKEY_CURRENT_USER\Software\Microso
ft\Windows\CurrentVersion\Group Policy
Objects\LocalUser\Software\Microsoft\Wind
ows\CurrentVersion\Policies\System]|

“DisableTaskMgr”"=dword:00000000

[HKEY_LOCAL_MACHINE\SOFTWARE\Mi
crosoft\Windows\CurrentVersion\poli-
cies\system\]

“DisableTaskMgr’=dword:00000000

[HKEY_LOCAL_MACHINE\SOFTWARE\Micr
osoft\Windows NT\CurrentVersion\Winlogon]
“DisableCAD”=dword:00000000

A Shadowy Presence
| have a 256 MB pen drive. When I plug it into
a system with Windows XP—it doesn’t get
detected in other versions—it responds by showing
“New hardware found”, “Installing device”, and
“Ready to use”. Even in My Computer, the drive
appears, but on opening it, it says “Please insert

drive”. How do I rectify this?
Joel Jose

It seems that your pen drive is not format-

ted. Try to format it by opening Windows
Explorer, right-clicking on it and selecting
Format. If this does not seem to work,
try using the HP Disk Storage Format Tool,
which can be downloaded from http://selfde-
struct.net/misc/ usbboot/SP27213.exe. If this
doesn’t work either, your pen drive is probably
damaged.

Driving Me Nuts!
My system configuration is 1.2 GHz Intel
Celeron, 256 MB RAM, 80 GB hard drive with
six Windows partition of 10 GB each, and in the
rest of the space, I'd installed Red Hat Enterprise
Edition. 1 have dual-booting of Windows—
Windows 98 SE on the C: drive and Windows XP on
D:. My BenQ CD-Writer connected as secondary
master, and Samsung combo drive connected as
secondary slave, don’t work in Windows XP, but
work fine in Windows 98. The icons cannot be
seen in My Computer, and when | go to Device
Manager, it shows a yellow exclamation mark.
I’'ve tried uninstalling and restarting the PC, and
also clicking on the option scan for hardware
changes.
Manish Gupta

This problem occurs when the chipset driv-
ers for the motherboard get corrupted. You
can go to www.intel.com and download the
latest version of chipset drivers for your moth-
erboard and install them. You should be able to
access your optical drives on the next boot.

Giving Vista The Boot
| installed the beta version of Windows Vista
on my computer, dual-booting with Windows

XP Professional. How do I it?
Raghu Kolhe

. We’re assuming you installed Vista on a
separate partition with nothing else on it.
Boot into Windows XP. Insert your Vista DVD
into the drive, or load the image in DVD emula-
tion software. Run “X:\boot\bootsect.exe [nt52
ALL /force” (where X is your Vista DVD drive
letter). Restart the computer and you will find
that the old XP boot menu has returned.
Format the partition where installed Vista, and
remove Boot.BAK and Bootsect.BAK.

Got A Minute... Or More?

The default time limit for recording in the
Windows Sound Recorder utility is one minute.

Is there a way to increase this to, say, 15 minutes?
Kallol Das

To increase Sound Recorder’s time limit, you
need to follow this (somewhat tedious)
procedure.

Open Sound Recorder and click on the
Record button. Let it record for a period of one
minute until it stops. Now click on File > Save
and save the file as Blank.wav.
Next, click on Edit > Insert

File.. and insert the
blank.wav file you just
created. You will see that
the recording time limit
increases by one minute. In
this way, if you wish to
increase it to 15 minutes,
insert this file 15 times. If you
wish to make 15 minutes as
the default recording
length, do the following:
save the file you created in
the previous step (this will be
a 15-minute blank WAV file).
Go to Start > All Programs >
Accessories > Entertainment,
right-click on Sound Recorder,
and click Properties. In the
Target box, you will see
“%SystemRoot%\ system32\sndrec32.exe”;
change it to “%SystemRoot%\ system32\
sndrec32.exe C:\Sound\blank.wav” (without the
quotes), assuming you saved the blank.wav file to
C:\Sound. When you start Sound Recorder the
next time, this file will open automatically. After
recording your audio, you can click on Edit >
Delete After Current Position to remove the
blank space after the recording is done. Don’t
forget to save this newly-recorded file with a new
filename, because if you accidentally overwrite
the blank.wav file, the recording limit will
become equal to the time for which you just
recorded the audio.

This is just a workaround; you can use other
utilities such as Nero Wave Editor (bundled with
Nero) or Goldwave from www.goldwave.com, for
making the task easier—or even WavePad from
www.nch.com.au/wavepad. m
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For Fine Footage

Here’s what you should be looking at when you’ve decided to go beyond still photos

hen I was recently packing for a trip
W abroad, my must-pack list included a

handycam (camcorder if you will)—a
piece of hardware I've never owned.

Now as you probably know, a handycam is
quite different from a digicam. Although tech-
nology is blurring the boundaries, a digicam is
for taking great still shots and not for serious
video shooting. Conversely, while all handycams
will take still shots, that’s not what they’re good
at. A mediocre digital camera will outdo a good
handycam at photo shooting.

When shopping for a handycam, look at a
three-CCD sensor, which makes more sense than a
single CCD sensor. One CCD sensor is used for each
colour component—red, green, and blue—resulting
in much crisper colours and true-to-life images.
And make sure to skip the digital zoom specifica-
tion as a decider—look at optical zoom. Now if you
plan on shooting mostly family and friends—that
is, close-range shooting—optical zoom will not be
as significant, and 10x will suffice. For when you're
holidaying, you might need a much longer optical
zoom; in such cases, 30x is the norm.

Handycams that offer as much as a 40x
optical zoom are available, and these don’t cost
too much more, though as a general rule, a
handycam with a lower optical zoom identically
priced to a longer optical zoom model will per-
form better. Another feature is wind-noise reduc-
tion, which, if not present, can render any speech
useless. As with still cameras, look for image sta-
bilisation (IS) and specifically for optical IS. Sadly,
optical IS costs a lot. (The models I came across
featured only digital IS.)

Most handycams around still feature mini-cas-
settes (mini DV tapes). Though models supporting
mini DVD (8 cm, 1.4 and 2.8 GB DVD-RW media)
are also around, they’re quite a bit costlier. Most
handycams will also feature support for additional
memory cards for taking photos. You cannot store
videos on the expansion cards, only photos.

You just shouldn’t buy a handycam without
an inbuilt flash (Night-Shot mode). Also look for
flash rails to accommodate an add-on flash unit;
most handycams do not have very effective flash
ranges on the default unit.

All handycams have some default auto-
exposure modes. They also have manual
settings, which you will have to
explore. Remember, you need to spend
time with a handycam before reaching
a purchase decision. This is truer for
handycams then for digital cameras,
simply because you can click again if your
photo doesn’t turn out right, but you can’t
usually re-enact an entire scene if a video
doesn’t turn out the way you want it to be!

Accessories like shoulder straps and
carry cases are standard with most models,
and some vendors like Canon and JVC also pro-
vide MMC cards, albeit tiny 8 or 16 MB ones.

You will need to invest in the mini DVDs or
DVs—these aren’t bundled.

I stopped by InOrbit mall and later Hypercity
mall, two large ones in Mumbai’s western suburbs.

From what I could gauge talking to the first
attendant, Sony and Panasonic models are hot
sellers, in that order, trailed by JVC. The stall had a
limited range of models—the Panasonic NV-GS180
and the NV-GS47 priced at Rs 31,990 and 20,490
respectively. The man also showed me an impres-
sive-looking Sony DVD-755 for Rs 39,990, with a
touch-screen interface. There was a Samsung VP-
D361i for Rs 21,990—poor on build quality, though.

The second stall I stopped by had many more
options, and I could see I'd be spending a few
hours here. First I saw Canon’s range—the MV880i
and MV850i at Rs 28,990 and 25,990 respectively.
I wasn’t impressed by the 1.33 megapixel sensor
on the MV880i; neither was the 14x optical zoom
enough for me. The MV850i had a more useful
22x optical zoom. The DVD-RW-supporting DC20
and DC100 were also on display for Rs 37,299 and
28,499. The DC20 supports a 2.3 MP CCD sensor
but only 10x optical zoom. It’s been designed for
close range video shooting, and offers very good
quality. The 25x optical zoom on the outdoor spe-
cialist—the DC100—was appreciated, but quality
wasn’t as good as that of the DC20.

Sony was a strong presence; their entry-level
DCR-HC38E retails at Rs 20,500. It’'s newbie-
friendly, with the “easy” button simplifying
shooting under various lighting conditions. Fea-
tures like 40x optical zoom and touch-screen oper-
ation mean the HC3S8E is excellent value for
money. The DCR-SR80 is Sony’s hard drive based
handycam. It costs a staggering Rs 54,500, but
offers a 60 GB HDD. Video quality was, unfortu-
nately, not as good as those of some of the other
models available, especially the Canon DC20.

Finally, I came across JVC, which specialises in
video recorders. The GR-D370 at Rs 23,799 boasted
32x optical zoom. Looking at its performance,
though, I realised this was one of JVC’s value
models. The GZ-MG21 at Rs 38,699 was one of the
smallest models on offer. Performance was better
than that of the GR-D370, though compactness
would definitely be its selling point. The third JVC
on display was the GR-DF570, featuring 1.92 MP
for photos and 15x optical zoom.

After weighing my options, I settled for the
Canon MV850i as a good compromise
between optical zoom and image quality. It
comes bundled with a wide (0.6x) lens, excel-
lent for both indoor shooting and panoramic
» views. I haggled and haggled and got a Rs
1,000 discount. I also picked up a 512 MB SD
card for still shooting, though I'll still be car-
rying my trusty Canon A710IS around. m

Want more of Agent 001? Turn over to read his
answers to your buying questions
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Throwing RAM At The Problem

I’'m assembling a PC with the following speci-
fications:
[ Intel Pentium D945 (3.4 GHz)
[ Intel D965RY motherboard
[ ViewSonic 17-inch TFT Monitor
[ Kingston 1 GB DDR2 533 MHz RAM
[1 320 GB Western Digital HDD
[} 20x Lite-On DVD-Writer
| want a suitable graphics card at Rs 4,000 to
6,500, and have zeroed in on the Forsa 7600GS
which was featured in Digit, November 2006.
Please give me a dealer address in Mumbai. Also,
do | need a graphics card if | have 2 GB of DDR2
RAM instead of 1 GB?
Amit Puri

"f\ Forsa’s 7600GS will cost about Rs 5,500 in
~“= Mumbai. Try Shree Sagarmatha Pvt Ltd,
the official distributors for Forsa cards in India.
The number is 011-26428541, and I'm sure they’ll
be able to direct you to a dealer near you.

A graphics card is essential for a good multi-
media PC, especially if you plan on gaming. This
is regardless of the amount of RAM you have
installed. If you are using integrated graphics
instead of a graphics card, the more RAM the
better, because system memory is utilised as
graphics memory by the VGA controller.

A suggestion regarding the above system: I'd
suggest you opt for a Core 2 Duo E6300 instead of
the Pentium D CPU. The performance hike is well
worth the premium—around Rs 2,500 more.

Double Whammy

I run an AMD64 3000+ (939) PC. My mother-
board is an MSI RS480M2-IL, ATI Radeon x200
based. I'm looking to buy a graphics card in the Rs
4,000 to 5,000 range. I've heard about NVIDIA cards
having issues with this chipset. Should I buy an ATI
card in light of this? More importantly, my primary
0S is Ubuntu Dapper 6.06. | also use Windows XP. Do

ATI’s drivers work well under Linux?
Sudhindra

"f\ Your problem is two- pronged Sudhindra!
= The MSI RS480M2-IL has issues with any
NVIDIA graphics card, so you’re left with ATI as
an option. Now ATI has very bad driver support
for Linux. There are both 32-bit and 64-bit drivers
available, but they are buggy at best, especially
since they are generic Linux drivers. I'm afraid
you will not be able to use Ubuntu 6.06 as an OS
unless you're prepared to change your mother-
board and buy an NVIDIA card. Incidentally,
NVIDIA’s 7300GS and ATI's X1300 Pro should
both be around the Rs 4,500 mark.

Of Cells And Dells

I am going to take up an animation course for

which I have decided to buy a laptop since I will
be travelling. I need something powerful, something
I can use for projects as well as something that will
suffice for entertainment. Right now | am thinking of
Dell’s XPS M1210 and the Dell Inspiron 9400. The GPU
is my main concern, though storage also figures.

Ask Agent 001

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related
questions in this space.
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Also, I am using a Nokia 6630, and am planning
to upgrade. My budget is around Rs 20,000. Should |
buy a Nokia N80 or wait for the N93 to become
cheaper? I am looking for a good camera, music, and
for Web browsing.

Bapan Mazumder

| @y If graphics is a major concern and price
~“=~isn’t, then you should consider the Insp-
iron 9400, which is available with a GeForce
7900GS graphics solution (not available on the
XPS M1210), although this will cost you extra. A
safer bet is a GeForce 7400 graphics solution that
is available on both models, the XPS M1210 and
the Inspiron 9400. Since you’ve mentioned mul-
timedia as a possible use, I'd advise against the
XPS1210 because of its small screen.

The Inspiron 9400 will give you storage
options all the way to 200 GB.

The N80 has a decent camera and good music
playback quality. The real advantage for you will
be integrated Wi-Fi, which means you can con-
nect wirelessly to your laptop and surf.

Notebook Needs

I need to get myself a laptop that will be used to
handle my e-mail, office paperwork, and pre-
sentations at conferences. | also need a webcam. My

budget is around Rs 45,000.
Dr N N Chowdhury

"\ I’d suggest a Dell Inspiron 6400. Not only
==~ will you get one within Rs 45K, you will
also get decent service and support. Dell’s toll-
free number is 1800-425-4026. You can also call
080-2506-8026. In terms of specifications, the
Inspiron 6400 is configurable. A word of cau-
tion—it doesn’t have an integrated webcam. HP’s
DV6000T has the option of a webcam; it offers
similar specs. The DV6000T is also configurable,
so your budget will be easily matched. Even if you
cannot manage a Core 2 Duo within Rs 45,000,
try to go with 1 GB of RAM. The same goes for the
Inspiron 6400.

Nokia Connects

I want to buy a mobile for connecting my PC to

the Internet. My budget is Rs 3,500 to 4,500. |

am considering Nokia’s 6030, referring to your test

last year. But newer models like the Nokia 2626 also

seem attractive. A camera is of no concern, but FM is
a desirable feature.

Anil TK

. Nokia’s 6030 is an old model now. Let’s
~“"—~talk about the 6070, which should cost
you around Rs 5,000. I'd suggest this model
because it has a class 10 GPRS receiver. The Nokia
2626 in comparison has a class 6 GPRS receiver,
and is therefore slower than the 6070. While this
may not be noticeable while browsing the
Internet now, the fact that your cell has a class
10 GRPS receiver may be of importance later.
You’ll also get a slightly higher-resolution screen
and a little more inbuilt memory. You’ll also get
a VGA camera, even if you don’t need it, and the
phone has FM inbuilt. m
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You’ve heard all those terms and seen all those logos—now find out what they mean!

Asfaq Tapia

you don’t really know what

it’s all about! Well, digital
standards for the audio industry
are divided into two distinct medi-
ums, Dolby and THX.

S o many standards, logos, and

Dolby Pro Logic IIx
The era of 7.1 surround sound is
upon us, and the Dolby Pro Logic
IIx helps us come even closer to
replicating original sound quality.
This format is not only reserved to
play movies encoded in the
surround sound format; what it
essentially does is expand any
existing stereo or 5.1 channel
audio to a 7.1 channel output.
There are three distinct listen-
ing modes integrated into this
format—Movie, Music, and Game—
which allow you to tailor the audio
to your listening preferences.
Dolby Pro Logic IIx also comes with
other patented technologies such
as Dolby Center Width, which adjusts
the balance of the main vocals in
the centre and front channels.
Another option is Dolby Panorama,
which creates a complete, wrap-
around surround sound effect,
which gives better audio clarity
to any surround sound media.
Dolby Dimension lets you set a
deeper or shallower surround
sound field depending on the size
of your room.

Dolby TrueHD

This is Dolby’s next-generation
lossless technology developed for
high-definition disc-based media.
It delivers realistic and identical
sound reproduction comparable to

The main features

here are 100 per cent

the studio master copy.

lossless coding tech-
nology; the standard
supports up to eight
full-range channels of

TRU »

24-bit/96 kHz audio, though theo-
retically, it can support more. This
will ensure a better audio
surround sound experience. Since
it uses High-Definition Media
Interface cables, there is no loss of
data between player and speakers.

DIGIT MAY 2007
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The Dynamic Range Control tech-
nology incorporated into TrueHD
allows you to customise audio
output to reduce peak volume
levels, so that there are no loud
surprises.

THX
It’s important to note that THX is
only a measure of quality that
works together with various
surround sound formats (like
Dolby Digital TrueHD) to increase
the quality of the sound presenta-
" tion, to its

B hichest

standards. THX

in itself is not an audio standard;
it’s a quality assurance system.

To ensure the highest possible
audio quality in home systems,
THX defines stringent soundtrack
requirements for audio transfers
from DVD/CD to speakers. Such
DVD/CD albums are labelled “THX
Digitally Mastered for superior
sound and picture quality” or
simply “THX Certified”. THX also
defines these standards for audio
components such as DVD/CD play-
ers, receivers, preamplifiers, power
amplifiers, speakers, interconnect
cables, speaker cables, etc.

For the everyday consumer, the
“THX” label means that the highest
standards have been used, whether
the productis a DVD/CD-Audio title,
or an audio component.

2.1 THX Ultra2
One of the latest benchmark certi-
fications for audio performance in

SELECTZ?2

the home surround sound genre.
This certification is reserved for
receivers that have the power to
deliver sound to a wide viewing
area in large home theaters and
media rooms. The recommended
room size for THX Ultra2 Certified
AV receivers is 3,000 cubic feet or
larger, with a minimum 12-foot
distance from video display to
primary seating positions.

THX Ultra2 uses 7.1 specifica-
tions, and in the newer THX Ultra
2 Cinema mode or THX Music-
Mode automatically converts 5.1
channel sound or higher to be
playable through four surround
speakers—two at the side and two
at the back. The THX Ultra2 certi-
fied receivers and controllers
feature Boundary Gain Compensa-
tion, which improves bass when
the listener is near a wall.

THX Select2
Audio components certified with
this standard are designed for
small-to medium-sized residential
living rooms, approximately 2,000
cubic feet in size with a 10-foot
distance from video display to seat-
ing position. THX Select2 Certified
receivers incorporate product
design and performance specifica-
tions that ensure superior audio
quality, product usability, and
interoperability. Every THX Select2
Certified receiver features THX
playback technologies designed to
compensate for the acoustical
errors that occur when movies,
music, and games are translated
from the professional studio to the
home environment. THX Select2
also has listening modes—THX
Cinema, THX Music, and THX Games
Mode, which allow you to tailor the
audio to your preferences. THX
Select2 addresses the needs of
those who need DVD/CD quality
music and video game experi-
ences, but don’t require a home
theatre surround sound system. m
asfaq_tapia@thinkdigit.com
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UBEST BUY

A 19-inch monitor represents the best possi-
ble price point for someone interested in mul-
timedia, but wanting something larger than a
17-inch panel. The cost difference between an
entry level 17- and 19-inch monitor is as low as
Rs 3,000, and as you’ll see a bit later, there were
17-inch panels that cost much more than many
19-inch ones. Once you go above 19-inches,
prices go haywire as you approach the realm of
20.1-inch and above panels.

A 20.1 inch LCD will cost at least Rs 4,500
more than a 19-inch, though there is hardly a
difference in resolution between the two (note
that 17-inch and 19-inch monitors have the
same native resolution). Also most of the high-
end panels—S-IPS and PVA/MVA—fall in the 20.1-
inch and above size categories—monitors sport-
ing these panels will be costlier still.

If your usage is for multimedia—games,
movies, etc.—skip the 17-inch category and invest
that extra bit in a 19-inch screen; the sheer visu-
al real-estate will be worth the extra cash. In fact,
a 19-inch monitor will benefit even regular office

applications—Excel, most notably. AoC1975

Sturdy, wallet friendly performer

Feature Rich, But Not
Fancy-free
This category had the biggest
price range, so it was natural
to expect a lot of different fea-
tures. If we were to choose a
looker, it’'d have to be the
ASUS PG191—superb build
quality, and a very classy look-
ing buffed metal stand with a
piano-black bezel topping
things off. A pity the thing
weighed about as much as a
hippo. The stand also inte-
grates a dedicated speaker
driver unit, just behind the
panel mount. Sound quality
was very good—not tinny as
one would expect from inte-
grated speakers. Add to the kitty
a good 1.3 Megapixel webcam that’s
better than the generic webcams in the
market. Beauty doesn’t come cheap though,
and the TN panel-based PG191 costs Rs 28,000,
and has touch-sensitive menu controls.

MAY 2007

| How We Tested

The Test Bench

Processor: Core 2 Extreme X6800
Graphics Card: Geforce 8800GTX

0S: Windows XP Professional SP2

All tests were performed at the LCD’s native resolution, and
monitors have been categorised according to panel size.

We calibrated all the LCD’s using Display Mate Video Edition
calibration suite. Once calibrated, no adjustments followed.

Display Test Software
1. DisplayMate Video Edition
2. PassMark’s MonTest

Real World Tests
1. Animated Video file (HD 1080p clips)
2. HD movie clips
3. Game tests
a. Oblivion (game played in three different environments—
dungeon, outdoor and planes of Oblivion)
b. F.E.A.R (fixed length demo)

Parameters Tested

DisplayMate Video Edition

1. Sharpness and Resolution Tests
2. Pixel Resolution Tests

3. Colour and Greyscale Tests

4. Miscellaneous Tests

PassMark’s MonTest

Although most of the MonTest suite is similar to DisplayMate,
there was one important test that it adds—the Pixel Persistence
test. Here, the monitors’ ability to draw and redraw a pixel is
checked, which basically gives us an idea to its response time,
and hence its suitability for gaming and movie-watching.

Multimedia Tests

to multimedia, by testing and judging on parameters like
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Reverse Text Test - DisplayMate

brightness levels, contrast, pixel response, and colour
rendition.

The Game Tests allow us to ascertain the suitability of the
display to playing games. We play identical timed benchmarks
across all the screens and look for input lag, ghosting, brightness
and contrast, rendition of special effects like HDR, explosions, bullet
time effects (in F.E.A.R). Oblivion provides us a good opportunity to

The movie clips give as an idea of the test subjects’ suitability judge these monitors rendition of outdoor scenery as the game has

one of the best environments (graphically) in the business.
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Among the others, the Intex 1904w and = -
both the ViewSonic models looked quite sleek; \ BEST BUY
the latter had better colour combinations
while the 1904w had a slimmer bezel. Another
beauty that caught our eye was AOC’s 1975— MAY 2007

very good build quality and top notch fit and
finish. The quality of moving parts was also up
there. The two big boys from NEC (MultiSync
1990FX and MultiSync 1970NXp) also sport
excellent finish and supreme build quality.

The HP L1940T features height adjust-
ment—a feature all other 19-inch monitors
(besides NEC’s duo mentioned above) missed
out on. One welcome feature on the
MultiSync 1990FX was the presence of por-
trait mode and you can actually tilt the
screen to view web pages vertically, so there’s
less scrolling. The MultiSync 1990FX had one
of the slimmest bezels of all, the only lament
was the finish—while excellent in quality it
looked rather plain.

The NEC MultiSync 1970NXp featured a
very cell phone-like 5-way joystick for menu
selection and navigation. It works very well,
and reduces the time taken to tinker with the
monitors settings—once you get used to it.
Another nifty feature unique to this monitor
is a trick horizontal swivel. The 1970NXp has a

ViewSonic VG921M
A birds eye view

heavy metal base covered with plastic trim.
Now when you attempt to turn the screen left
and right the entire screen turns, while the
metal base remains firm on the table. We say
‘trick’ because it doesn’t appear at first to be
able to swivel horizontally.

Exploring connectivity options the
ViewSonic duo (VG921M and VA1912W) were in
the limelight for the wrong reasons this time—
they don’t have DVI connects—very shocking for
the 19-inch category. Also guilty of this offense
by omission were AOC’s 197S, HP’s L1916,
Intex’s 1904w, LG’s 1952S, and NEC’s own
LCD190V. None of the 19-inchers featured HDCP
support, which means HDCP protected content
will not work on these monitors.

i Jargon Buster

Backlight Bleeding: The surface of an LCD is backlit by CCFLs (Cold Cathode
Fluorescent Lamps). The liquid crystals inside the panel orient themselves to block
out all light when off, and re-orient so to allow light to pass through when on. The
angle of this orientation determines the colour of the light we see.

Backlight bleeding occurs when this light is not completely blocked out,
allowing some it to “bleed” through. It’s noticeable on a black background, where
some areas will have lighter flecks or bands than other areas. It’s a problem that
plagues a majority of LCDs out there. The good thing is that it’s not very visible
during regular work.

Pixel Response Times: This is the time taken for liquid crystals to switch on
and off. Liquid crystals orient themselves to switch on and off by application of
an electric current, and the time taken for this orientation is called Pixel
Response Times.

Dithering: Dithering is nothing but digital noise introduced to simulate many
shades of colour, starting with fewer shades. In LCDs, 6-bit panels (262,144
colours) are dithered to display 16.7 million colours (8-bit). Dithering is, simply
put, interpolation and will never be as effective as true 24-bit colour. However,
6-bit panels are cheaper to manufacture making it a price-performance trade-
off of sorts.

Nits: Nits is better known as candela per square meter. It is a measurement of
screen brightness for all displays. Mathematically, Nits is Cd/m"2.

Of Speed And Visual Quality
DisplayMate may be Jurassic to some, but it sure
helps separate the wheat from the chaff as far as
quality goes. One monitor that left the others
wallowing in its wake with its sheer dominance
in DisplayMate’s colour and gray-
y scale tests was NEC’s MultiSync
1990FX. It was the only LCD based
around an S-IPS panel, and the
difference in colour rendition
shows clearly. If you’re an image
editing professional who wants
accurate colour rendition
when working with
Photoshop or want accurate
point-scaling when render-
ing, the MultiSync 1990FX is
the monitor for you. Gamers
will also notice the differ-
ence in colours, although
S-IPS panels are plagued
with slower pixel response
times, and this may not be the
best solution for games (cost
considered). The 1990FX also
performed commendably in the
sharpness and resolution tests,
just short of the MVA panel-based MultiSync
1970NXp.

Though most people will prefer widescreen
monitors for movie-watching, the wide viewing
angles that S-IPS and MVA panels provide are
much better than TN panels—meaning both
these NECs are capable multimedia solutions.
The bitter pill in both cases is the price.

A (hefty) notch lower in performance are the
offerings from ViewSonic (VG921M) and HP
(L1916, L1940T)—both monitors offered some
very good results throughout the tests. These
were very closely trailed by the LCDs from AOC,
BenQ and ASUS. The PG191 had vivid and crisp
colours, but the intensity of the colours seemed
artificially rich—some tuning was in order. The
dark horse was BenQ’s FP92W. Despite the fact
that it won no accolades it performed reasonably
well in DisplayMate, it really came into its own
with the movie and game tests. The HDR effects
in Oblivion were literally eye-hurting—this
smacks of a good contrast ratio—just what the
doctor ordered for multimedia activities. The
fact that this is a 16:10 (widescreen) monitor just
adds to its appeal for the said audience.

HP’s L1916 despite being a good scorer had
one niggling issue—slight backlight bleeding.
This killjoy makes its presence felt on a dark
background.

There were no “really bad performers” this
time round—all manufacturers are focusing on
capturing the flat panel market, so they would-
n’t dare introduce sub-standard stuff. However,
there were those monitors which had minor
issues, or performed consistently behind the oth-
ers—sometimes both. Jetway’s JM1941DF was one
such monitor. We were unlucky to get a piece
with an eyesore of a dead pixel. However, this is
a one off issue, and dead pixels usually mean
immediate replacements—so peace! There were
also some issues with the black shift test—there
were noticeable differences in the grey-coloured
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BRAND
MODEL
Features (Out of 25)
Contrast Ratio
Type of Panel (TN/IPS/MVA/PVA)
Native Resolution
Response Time (ms)
USB Hub (Y/N)
No. Of Ports
Card Reader (Y/N)
Type of Memory cards supported
Built-in Speakers (Y/N)
Sound Quality (So 10)
VESA Wall Mount
Swivel Base (V/H Axis)
Height Adjustment (Y/N)
Portrait (Y/N)
Power Consumption (Watts)
HDCP Support (Y/N)
Inputs (D-Sub/DVI)
Extra Features
Design & Usability (So 10)
Bezel Thickness
Quality Of Moving Parts
0SD Usability
Performance (Out of 60)

Sharpness And Resolution Tests
Pixel Resolution Tests
Colour And Gray-Scale Tests
Miscellaneous Tests
Passmark MonTest (So 10)
Pixel Persistence Test
Multimedia Tests (So 10)
Movie Clip Pixel Persistence
Colour Rendition
Contrast
Overall Viewing Experience
Game Tests (So 10)
F.E.AR
Pixel Response
Bullet Time Effects
Shadows
Particle Effects
HDR and Contrast
Oblivion
Foilage, Scenery, Texturing On Grass
HDR Effects
Transparency Effects
Viewing Angles (So 10)
Viewable Angle Test (Text)
Viewable Angle Test (Movie)
Features (Out of 25)
Performance (Out of 60)
Price Index (Out of 15)
Final Scores (Out of 100)
Price

Displaymate Video Edition (So 10)

Acer
AL1916
6.85

700:1

N
1280X1024
8

[}

NA

0/0/0/0/0
O

750
6.00
6.75
39.99

6.50
6.13
6.38
6.31

7.25

75

6.5
6.25

75

6.25
6.25
6.5

6.5
6.5
6.5

775

6.85
39.99
10.50
57.34
15,000

BEST BUY

MAY 2007

\t @ Scoreboard 19 Inch LCDs

AOC

1975

8.09
700:1

N
1280x1024
5

NA

NA
6.00
0/0

50

0/0/0/0/0

7.50
7.50
775
40.61

6.50
6.38
6.38
6.50

6.50

7.25
7.25
7.00
7.00

7.00
6.75
6.50
6.75
6.75

6.75
6.50
7.00

7.50
5.75
8.09
40.61
13.13
61.82
12,000

ASUS
PG191
12.19
800:1

TN
1280x1024
2

]

3

]

0/0/0/0/0
Webcam

6.75
8
6.00
40.35

6.50
6.25
6.44
6.25

7.25
75
7.25

6.5
6.75

75

6.5
6.75
6.5

ASUS
Vw192T
8.76
800:1

TN
1440x900
5

NA
NA
O
6.25

0/0

45

;/ﬂ/ﬂ/ﬂ/ﬂ

7.25
7.5
7.25
38.82

6.30
6.00
6.29
5.88

7.25
6.25

6.25

BenQ
FP92W
6.83
700:1
TN
1440x900
5

[}

NA

0

NA

0

NA

O

o/o

)

[}

45

d0
0/o0/0/o/o
O

75
5.75

40.76

6.45
6.13

6.60
6.56

7.25

7.50
7.25
6.75
6.75

HP
L1916
6.34
500:1
TN
1280x1024
NA

[}

NA

0

NA

0

NA

O

0/0
[}

0

33

0
0/o0/o/o/a
a

7.00
7.00
7.25
41.15

6.65
6.75
6.46
6.69

7.00

7.25
7.25
7.00
7.00

7.50
7.25
6.75
6.75
6.75

6.50
6.75
6.75

775
6.00
6.34
41.15
7.88
55.36
19,999

HP
L1940T
11.14
500/700:1
TN
1280x1024
8

]

3

d

NA

d

NA

0/0/0/0/0
O

7.00
7.25
7.25
41.00

6.55
6.63
6.71

6.44

6.50

7.00
7.00
6.75
6.75

750
7.00
7.00
6.75
7.00

6.75
6.50
6.50

775
6.50
11.14
41.00
7.00
59.14
22,490

+Good perform- +good performance i +Good performer,
p : g + feature rich + Looks p . +too costly +good performance
ance, slim bezel and looks - too costly - Lacks decent price o ) -
- Slightly costly - gloss finish performance - None in e very pricey
catches smudges particular
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+ Attractive looks
- Lower
performance

BELBR

+ Good looks, solid
build
- performance

+ Slim Bezel, well
built
- None in particular

+excellent
performance,
build quality
- Costly

ance, looks
- Costly

+ excellent perform- + Sleek looks

- lacks performance

+Good performer,
great price

NBESTBUY

o ]

MAY 2007
Intex Jetway LG NEC NEC NEC ViewSonic ViewSonic
1904w JM1941DF L1952S MultiSync 1990FX MultiSync 19970NXp LCD190V VG921M VA1912W
7.48 8.04 6.28 9.63 9.62 6.21 7.65 7.53
700:1 700:1 1600:1 800:1 800:1 NA 700:1 700:1
TN N TN S-IPS MVA N N N
1440X900 1280x1024 1280x1024 1280x1024 1280x1024 1280x1024 1280x1024 1440x900
2.6 8 8 14 20 8 8 5
O O O O O O O O
NA NA NA NA NA NA NA NA
O O O O O O O O
NA NA NA NA NA NA NA NA
O o O o O O O O
5.25 5.50 NA NA NA NA 6.00 5.75
O O O O O 0 O 0
0/0 0/o 0/0 0/o o/0 0/0 0/0 0/0
O O O O O 0 O O
O o O O O O O O
45 NA 33 40 38 38 55! 32
O O O O 0 0 O 0
0/0/0/0/0 0/0/0/o/o 0/0/0/0/0 0/0/0/o/o 0/0/0/o/o 0/0/0/o/o 0/0/0/0/0 0/0/0/0/0
O O O O O 0 O 0
7.00 6.00 7.75 8.50 8.00 775 6.25 6.00
6.50 6.25 6.50 7.50 7.75 6.00 6.75 6.50
6.25 6.00 7.00 7.50 7.50 7.25 7.00 7.00
38.48 39.42 40.28 44.34 44.24 39.59 41.10 38.85
6.30 6.30 6.40 7.30 7.50 6.80 6.70 6.10
6.25 6.13 6.50 6.88 7.13 6.50 6.75 6.25
6.17 6.37 6.48 7.21 7.06 6.58 6.79 6.46
6.44 6.25 6.44 7.25 713 6.56 6.63 6.38
6.00 6.75 6.75 7.00 7.00 6.25 7 6.75
7.25 7.00 7.25 7.00 7.25 6.50 6.75 6.25
7.00 7.00 7.00 7.50 7.00 6.25 7 6.50
6.50 6.00 6.75 7.25 7.50 6.25 6.75 6.25
6.50 6.50 6.75 7.25 7.25 6.50 6.75 6.25
6.75 7.25 6.75 7.25 7.25 6.50 6.75 6.75
7.00 7.00 6.75 7.25 7.50 6.50 6.75 6.50
6.00 6.50 6.50 7.25 7.25 6.00 6.75 6.25
6.75 6.75 6.75 7.50 7.75 6.50 6.5 6.50
6.00 6.75 6.50 7.50 7.50 6.00 6.25
6.50 6.50 6.75 7.00 7.25 6.50 6.75 6.50
6.00 6.25 6.25 7.25 7.25 6.50 6.5 6.25
6.50 6.50 6.75 7.25 7.25 6.50 6.75 6.25
7.50 7.50 7.50 8 8 6.75 6.5 6
5.75 6.00 6.00 7.50 7.50 5.75 6.25 5.75
748 8.04 6.28 9.63 9.62 6.21 7.65 7.53
38.48 39.42 40.28 44.34 44.24 39.59 41.10 38.85
13.94 12.12 11.67 4.50 5.43 5.63 12.26 12.26
59.89 59.58 58.22 58.47 59.28 51.42 61.01 58.64
11,300 13,000 13,500 35,000 29,000 28,000 12,850 12,850

+ Widescreen,
looks good

- None in particular - Low performance
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MAY 2007
W Scoreboard
BRAND Acer AOC AOC ASUS BenQ Dell
MODEL AL1706 LM725 177V PM17TX FP71G+ 1707FP
Features (Out of 25) 4.87 7.05 8.38 8.14 4.88 5.17
Contrast Ratio 800:1 450:1 800:1 500:1 450:1
Type of Panel (TN/IPS/MVA/PVA) TN TN N TN N N
Native Resolution 1280x1024 1280x1024 1280x1024 1280x1024 1280X1024 1280X1024
Response Time (ms) 8 16 5 3 8 12
USB Hub (Y/N) O 0 O O O O
No. Of Ports NA NA NA NA NA NA
Card Reader (Y/N) 0 O u] ] 0 0
Type of Memory cards supported NA NA NA NA NA NA
Built-in Speakers (Y/N) 0 O ] ] 0 ]
Sound Quality (So 10) NA 5.00 6.00 6.25 NA NA
VESA Wall Mount O O 0 ] O O
Swivel Base (V/H Axis) 0/o o/o 0/o o/o 0/o 0/o
Height Adjustment (Y/N) u] O ] ] 0 0
Portrait (Y/N) 0 O 0 ] 0 0
Power Consumption (Watts) 45 45 37 48 40 34
HDCP Support (Y/N) 0 O 0 ] 0 ]
Inputs (D-Sub/DVI) 0/0/0/0/0 0/0/0/0/0 0/0/0/0/0 0/0/0/0/0 0/0/0/0/o 0/o/o/o/o
Extra Features ] ] u] ]
Design & Usability (So 10)
Bezel Thickness 7.25 6.50 7.50 6.75 7.00 7.75
Quality Of Moving Parts 7.00 6.25 7.50 7.50 7.00 7.50
0SD Usability 6.75 6.50 7.75 6.50 7.00 7.50
Performance (Out of 60) 39.26 37.34 38.96 39.60 39.24 39.39
Displaymate Video Edition (So 10)
Sharpness And Resolution Tests  6.70 5.65 6.65 6.20 6.60 6.55
Pixel Resolution Tests 6.63 6.00 6.50 6.63 6.50 6.63
Colour And Gray-Scale Tests 6.81 6.73 6.71 6.67 6.54 6.50
Miscellaneous Tests 6.69 6.63 6.69 6.63 6.63 6.81
Passmark MonTest (So 10)
Pixel Persistence Test 6.50 7.00 6.75 6.75 6.75 6.75
Multimedia Tests (So 10)
Movie Clip Pixel Persistence 6.75 6.50 6.50 6.50 6.50 6.75
Colour Rendition 6.50 6.50 6.50 6.75 6.75 6.50
Contrast 6.75 6.50 6.75 6.75 6.50 6.75
Overall Viewing Experience 6.75 6.50 6.75 6.75 6.50 6.75
Game Tests (So 10)
F.E.AR
Pixel Response 6.75 6.50 6.50 6.50 6.25 6.50
Bullet Time Effects 6.75 6.50 6.75 6.75 6.50 6.50
Shadows 6.25 6.25 6.50 6.50 6.50 6.25
Particle Effects 6.50 6.25 7.00 6.50 6.75 6.50
HDR and Contrast 6.50 6.50 6.50 6.75 6.50 6.75
Oblivion
Foilage, Scenery, Texturing On Grass 6.50 6.25 6.75 6.75 6.50 6.50
HDR Effects 6.50 6.25 6.50 6.50 6.25 6.50
Transparency Effects 6.25 6.25 6.50 6.50 6.50 6.50
Viewing Angles (So 10)
Viewable Angle Test (Text) 7.25 6.75 6.75 7.25 7.25 7
Viewable Angle Test (Movie) 6.50 6.00 6.50 6.50 6.75 6.75
Features (Out of 25) 4.87 7.05 8.38 8.14 4.88 5.17
Performance (Out of 60) 39.26 37.34 38.96 39.60 39.24 39.39
Price Index (Out of 15) 11.59 13.42 13.01 9.44 11.81 9.44
Final Scores (Out of 100) 55.71 57.81 60.34 57.19 55.92 54.00
Price 11,000 9,500 9,800 13,500 10,800 13,500

+Good looker + Price + Performance +Good performance + Decent +Superb build
- Slightly pricey - Performance - None in particular - Costly performance - price
and looks - Aesthetics

'-
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Intex Jetway LG NEC Samsung Samsung Viewsonic Viewsonic
1703 1741S L1732S LCD170V 713BM Plus 740N VA1703w VA703m
7.04 7.09 4.58 4.88 7.87 4.78 744 7.29
500:1 500:1 700:1 1000:1 600:1 500:1 700:1
™ N ™ N ™ N ™ N
1280x1024 1280X1024 1280X1024 1280x1024 1280x1024 1280x1024 1440x900 1280x1024
12 8 8 8 5 8 8 8
0 O 0 O 0 0 0 0
NA NA NA NA NA NA NA NA
O O O O O O O O
NA NA NA NA NA NA NA NA
O O O O O O O O
5.00 6.00 NA NA 5.75 NA 6.00 5.25
O O O O O O O O
0/o o/o 0/0 o/0 0/0 o/o 0/o o/o
0 O O O O 0 O 0
O O O O O O O O
36 38 35 37 42 34 21 35
O O O O O O O O
0/0/0/0/0 0/0/0/0/0 0/0/0/0/0 0/0/0/0/0 0/0/0/0/0 0/0/0/0/0 0/0/0/0/0 0/0/0/0/0
O o O o O O o O
6.00 6.00 6.25 6.50 6.75 7.25 6.25 6.25
6.00 6.00 6.50 7.25 6.50 6.50 7.00 7.00
7.25 6.25 6.50 7.00 7.00 7.00 6.75 6.75
37.37 38.03 39.23 39.06 39.50 37.40 39.26 39.17
6.35 6.40 6.50 6.69 6.45 6.25 6.65 6.65
6.25 6.25 6.50 6.63 6.75 6.38 6.38 6.50
6.46 6.71 6.58 6.54 6.65 6.15 6.71 6.75
6.63 6.38 6.50 6.63 6.56 6.44 6.69 6.56
6.25 6.50 6.75 6.50 5.75 6.75 6,75 6.50
6.75 6.25 6.50 6.50 6.25 6.75 6.50 6.50
6.50 6.50 6.75 6.75 7.00 6.50 6.50 6.50
6.50 6.50 6.50 6.50 7.00 6.50 6.75 7.00
6.50 6.50 6.50 6.50 6.75 6.50 6.75 6.50
6.50 6.50 6.75 6.50 7.00 6.75 6.50 6.25
6.50 6.50 6.50 6.50 6.50 6.50 6.75 6.50
6.50 6.50 6.50 6.25 6.75 6.50 6.25 6.50
6.75 6.75 6.75 6.25 6.50 6.50 6.75 6.75
6.25 6.25 6.50 6.25 6.75 6.50 6.50 6.25
6.50 6.25 6.50 6.50 6.75 6.50 6.75 6.50
6.25 6.25 6.50 6.25 6.25 6.25 6.25 6.25
6.50 6.50 6.50 6.50 6.50 6.50 6.50 6.50
6.25 6.5 6.75 6.5 75 7 7.25 7
5.75 6.25 6.25 6.00 6.00 6.25 6.50 6.50
7.04 7.09 4.58 4.88 7.87 4,78 744 7.29
37.37 38.03 39.23 39.06 39.50 37.40 39.26 39.17
13.86 12.76 12.14 8.50 6.71 12.75 12.75 12.09
58.26 57.88 55.95 52.44 54.07 54.93 59.45 58.54
9,200 9,990 10,500 15,000 19,000 9,999 9,999 10,550

) ) + Widescreen, + Decent
+ Very cheap + Well Priced + Well Priced, good + Good looks +good performer  +ultra narrow bhezel performance erformance
- lacks performance - Lower Contrast performer - Pricey - very pricey - performance R p 3 .
: . - None in - None in particular
Ratio - Lower Contrast ratio .
particular
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The Elite

There aren’t enough 22-inch and above LCDs in the market for us to pit against each
other, so we’ll look at each of these bhig ones individually

BenQ

RATINGS
Features

Performance
Build Quality

he FP241W is part of a small community of

large, 1080p supporting, widescreen LCDs
based on Samsung’s excellent S-PVA panel tech-
nology. Other members of this exclusive club
include Dell’s 2407WEFP; Samsung’s own 244T and
Acer’s AL2423Wdr.

The FP241W is a huge monitor, with an intim-
idating stand—well;in keeping with such a large
screen. It sports an ultra large resolution of
1920x1200 pixels, and a whopping luminance of
500 Cd/m”2. The contrast ratio of 1000:1 means
you won’t be missing out on any of the action—be
it movies or games. And that’s the kind of user
who will appreciate this kind of monitor—the
enthusiast.

It blazed through all our tests, shaming all other
monitors across all the other categories. While calibrat-
ing it using DisplayMate, we could see all the grey shad-
ed cards, despite the background being absolutely
black—only NEC’s 1990FX came that close—this speaks
volumes for the contrast ratio. The viewing [angles are
also excellent, with absolutely no colour distortion while
changing horizontal and vertical viewing angles—this is
a characteristic of PVA panels.
Watching movies was a pleasure on
this monitor, and it’s viewable from
quite a distance (courtesy its large
screen). Gaming buffs will drool at

okk ik
kK
Kk kk

Value for Money % % % %

Overall

b, €0 (b, ¢

.. the prospect of playing games on
o, “such a monitor—absolutely glori-
5% ous colour (native 8-bit) and

L excellent contrast—we tried our
|~ hands at FarCry, EEAR, Company
t of Heroes, Oblivion and S.T.A.LKE.R.
and were very impressed.

BenQ’s imbued the FP241W
with a lot of nifty features—
height adjustment, portrait mode
(goodbye to web page scrolling),

i and the regular horizontal and
vertical swivel. The build quality
of the moving parts is right up
with the best. The bezel is also

very slim for a monitor this size.

The FP241W features S-Video, Component and even
HDMI connectivity on the video front, besides the
mandatory DVI and D-Sub inputs—a host of connectivity
options, to be sure. Four USB ports are also provided.

At Rs 49,990 the BenQ FP241W isn’t cheap. In fact, it’s
nearly the price of a 32-inch LCD TV. You do get immense
functionality though, not to mention a huge resolution
advantage. If you happen to be one of those rich blokes
who’s LCD shopping, just close your|eyes and whip out
your cheque book!

Price (Rupees)—49,990

Dell E228WFP
Acres Of Fun

Dell’s E228WEP is one of their value series monitors,
(which in Dell-speak means it’s based on a budget
panel technology—TN). Nonetheless, it’s a very capable
LCD with a lot of screen area to offer.

At a resolution of 1680x1050 pixels the E228WEP is
all .about widescreen satisfaction. A contrast ratio of
800:1 and a luminance of 300 Cd/m”2 will see it

through most applications with ease.

The monitor comes with Dell’s usually exemplary 1

stand—we’ve been impressed by this before.
Featuring digital and analog inputs, the E228 WFP

—_

ran into some problems in DisplayMate’s 64-intensity
test for primary colours, where the first four intensities

RATINGS
Features

Performance
Build Quality

Value for Money % % %

Overall

looked identical!
Mysteriously, this problem
didn’t persist in the 16-
intensity test or the 256-
intensity ramp.
Movie-watching is good
on the E228WEP, with
none: of DisplayMate’s con-

Skik
Sokik Y
Sokkk S
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cerns rearing their
heads here, though
the contrast doesn’t
even begin to
approach the exem-
plary FP241W. It’s an
unfair comparison,
however—S-PVA is
definitely a superior
panel technology
than TN.
FEAR and
N Oblivion looked good
with crisp| colours
and good HDR

effects. The E228WFP makes a strong statement for a
gaming monitor for gamers who need the additional 2-
inches of real estate it offers.

Image and rendering professionals should look—at
the FP241W or NEC's 1990FX/1970NXp duo, or Dell’s
very own UltraSharp series, though—unfortunately, this
is a 6-bit panel and not suited for such tasks.

Price (Rupees)—26,000



ASUS Mw221u
The Fast Responder

SUS’ MW221u is a TN-panel based offering boasting a
esponse time of only 2 ms. A resolution of 1680x1050,

contrast ratio of 700:1, and a brightness of 300 Cd/m’\zr_ral:_e‘ _

all well in keeping with panels of this type and size.

While we couldn’t find any serious fault with/ the build N

quality, it’s not as good as some of the other ASUS moni-
tors we tested. The bezel is
reasonably narrow, and the
control buttons look really
nice with a metallic finish
and the way they fit flush
with the panel, though
they’re as hard as walnuts
to press! Another sore point

RATINGS

Features
Performance

Sokik Y
kikl Y

Build Quality Kok X 5
Value for Money * % % %

Overall
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nm——

Digital Tools | LCD Monitor Test

is the stand—circular just
isn’t hot anymore!

A good performer with
stable results throughout
DisplayMate, the MW221u is
a good monitor for movies
and games. Although the
contrast specifications put

\ it lower than Dell’s (on
paper) this isn’t particularly
~ noticeable.

At Rs 23, 500 the MWZZlu is 2,500 bucks cheaper than
Dell’s E228WEFP.'A better option as far as display quality
goes, the MW221u only looses out as far as looks and
ergonomics go.

Price (Rupees)—23,500

ViewSonic VX2235wm
The Finch Connection

iewSonic has been known for many things—looks,
build and great display quality. Exemplifying all this

is the VX2235 a 22-inch TN panel-based beauty, decked in i |

gorgeous piano-black finery. The build quality is good;-
and although the stand is quite bulky, it’s well sculpted
and looks cool.
The lack of'a higher brightness specification (280
~2) didn’t seem to affect this panel’s performance in
any way. Its contrast ratio,

Cd/m

RATINGS
Features
Performance
Build Quality

Sokik Y
ok k S
kA

the viewing angles were
slightly better than those
on the ASUS MW221u and
the Dell E228WEP.

This was also the only
22-incher to sport in-built

Value for Money * % %

Overall

ko 5

0f 700:1 is adequate, and .

speakers; speakers shouldn’t
bias an LCD decision, and
these were tinny enough to
cement that opinion.

There were no issues in
any of the tests—DisplayMate
and MonTest sailed through
with no alarms, if not flying
colours: FEE.A.R. looked good
on this monitor, though all
; three 22-inchers had issues
g 7 with shadow detail, which is

more of a contrast ratio
problem that typically plagues TN panels. That said, HDR
‘looked good in Oblivion, as did the scenery—easily on par
with, and perhaps better than the E228 WEFP.

At Rs|25,750 the VX2235wm is nearly as pricey as the
E228WEP, but loses out to the well priced MW221u.

Price (Rupees)—25,750

ASUS PW201
Show With The Go

he ASUS PW201 is a great looking monitor complete
with a heavy metal stand (lighter than the PG191

though) and an excellent piano-black finished body. While -
the bezel isn’t narrow, it contains a touchpad for the con-

trols, speakers that sound half decent (emphasis on half),
and a 1.3 megapixel webcam. The stand allows for height '
adjustment, and this panel can actually be oriented face-
up like a table! ASUS provides a plethora of connectivity |
options—D-Sub, DVI, S-Video and component. There are
three USB ports as well.

One sore point was the bulky power adapter (supplied). |

The BenQ FP241W uses an internal adapter and ASUS
should/incorporate one as well.

The panel is a P-MVA,
which means you can
expect great contrast ratios
as well as good colour
(native 8-bit). A contrast
ratio of 800:1 and |a bright-
ness of 350 Cd/m2 seem

RATINGS
Features
Performance
Build Quality

ok k)
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Value for Money * % Y %

Overall
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about|right for this sort
of panel. The PW201 had
excellent viewing angles—
very close to BenQ'’s
FP241W.

Gamers concerned
with the response time of
8 ms can rest easy—we
noticed absolutely no
ghosting or lag during
our gaming benchmarks.

Geometry and colours

| _were up to the mark, and this monitor places behind the

FP241W and 1990FX as far as DisplayMate goes. Movie-
watching is as panoramic and engaging as you’d expect
on a high quality widescreen such as this one.

With performance in the bag, looks covered and a fea-
ture list a mile long, the only way the PW201 could goof
up is in pricing—at Rs 36,000, it’s|quite costly. Despite the
features, the sheer performance, its looks and the connec-
tivity options, the PW201 still seems a bit overpriced—five-
odd thousand less and we’ll swallow it.

Price (Rupees)—36,000
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bar comparing the edges and the centre (this
should not be the case).

Intex’s 1904w performed even worse than
the JM1941DF. While calibrating using
DisplayMate, we were unable to get many grey
blocks on a black background. The purpose of
this particular screen is to check the monitors
black levels, and contrast ratio. Tuning the
monitor to make more invisible grey boxes
appear was only possible if we sacrificed back-
ground black levels. There were also issues with
colour intensity tests—especially for blue. We
don’t recommend this monitor for gamers, and
image editing professionals should avoid this
like the plague. However, the price (Rs 11,300)
makes it attractive for those working with doc-
uments and online content. It is aesthetic
enough for an office monitor, and casual home
users will be interested to note that many 17-
inch monitors cost as much as this one—you’re
virtually getting 2 inches free!

The ASUS VW192T suffered in the reverse
video and reverse text tests—green, yellow and
cyan weren’t visible on a grey background, and
that’s not the end of it. There is a contrast ratio
problem with the VW192T that’s a mile wide,
and quite noticeable with colour gradations in
movies. This panel also has slightly lower bright-
ness levels due to which the HDR effects in
Oblivion seemed a little less bloomy than we’re
used to. This last point however is not really a
contrast ratio problem as we mentioned, but a
luminance problem—not enough nits (lower
Cd/m?* spec).

Decision Time

The 19-inch category was closely fought, no quar-
ters taken and none given. AOC took home gold
with Digit’s Best Buy Gold Award—its performance
and the brilliant pricing saw it in good stead. The
Silver was bagged by the ViewSonic VG921M, as
it out-did its widescreen sibling (VA1912W) by
some margin. However, take a look at the raw
performance scores and you’ll see both the 8-bit
panels NEC’s far ahead in this regard. The
MultiSync 1990FX and 1970NXp are the only
options for discerning professionals with no
price constraints.

17-INCH LCDS

The 17-inch LCDs represent the new entry level
for anyone looking for flat-panel PC monitors.
They’ve successfully taken over the mantle from
the 15-inchers as the face of value in the Indian
market.

g Decision Maker

Your Usage What to Buy

Home, Internet, Basic Multimedia AOC 177V, VA1703w, AOC 197S

HDCP & LCD Monitors

H igh-Bandwidth Digital Content Protection (HDCP) is a data encrypting
system initiated by Intel Corporation and developed by Silicon Image.
As the name suggests, HDCP protects digital video and audio content by
encryption at every stage of transmission as it moves across digital
connects—namely DVI and HDMI—to, ultimately, your screen. This
protection is necessary to combat the oldest evil known to digital content—
piracy or unauthorised access and duplication.

A PC or a DVD player has to be licensed with HDCP controls before it
can play HDCP-protected content. All upcoming standards including Blu-
Ray and HD-DVD feature this form of content protection.

What you do need to know is HDCP is built into a few LCD monitors,
which you will need to invest in if using such High-Definition content—
especially on Windows Vista.

Do also note that when using analog connectivity i.e. D-Sub, it’s
possible to bypass encryption completely, and display HD content without
HDCP. Microsoft has an answer to this—drivers will either constrict
resolutions or disable output completely when HDCP content is routed
through analog sources instead of digital sources.

The 17-inch LCD is an ideal purchase for
home and office users. Better, in fact, than 19-
inch monitors if heavy multimedia usage is not
your cup of tea. In fact, 17-inch monitors offer
the same resolution as 19-inch—1280x1024 and
1440x900 in case of widescreens.

Don’t expect to see much of the costlier S-IPS,
MVA or PVA panels here—with value taking pri-
ority, regular 6-bit TN panels are used. You’ll still
get 24-bit colour however, courtesy Dithering
(see box Are 8-bit Panels Worth It?).

Features? What Are Those?

Any entry level product is mainly focused on
pricing, and features are a luxury most manu-
facturers decided they could do without. As tes-
tament to this, none of the 17-inchers sport
advanced features like height adjustment and
portrait mode. In terms of aspect ratios,
ViewSonic’s VA1703w was a shocker—the only 17-
- inch monitor sporting

\ BEST BUY  widescreen dimensions. It’s com-
pact and offers the same ultra wide

1440x900 pixel resolution that a 19-

inch widescreen offers—that’s a lot
MAY 2007

g

Office Use, Browsing

AOC 177V, AOC 197S, ViewSonic VG921M

Average Gaming

BenQ FP92W, Acer AL1916, BenQ FP71G+

Hardcore/Enthusiast Gamers

ASUS PW201, ASUS MW221u

Design Professionals

NEC MultiSync 1990FX,
NEC MultiSync 1970NXp

Multimedia Aficionados

BenQ FP241W, ASUS PW201

Large Screen, aesthetic conscious Dell E228WFP

AOC 177V
Value Performer
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of horizontal viewing space for your eyes!

However, the bright green power LED disturbs il Contact Sheet

LCD Monitors

Intex also makes attractive monitors and
their 1703 is no exception, but it sports a bulky
power adapter. This is an
unnecessary headache—why
bundle an adapter when it can
be built in? It certainly doesn’t
add too much bulk, as we’ve
seen from the other LCDs.
Samsung’s 713BM Plus has its
menu buttons positioned on
the bottom of the monitor’s
bezel, and accessing them is a
royal pain.

MAY 2007

The Numbers Game
When it came to pure perform-
ance, figures were close, but
two monitors fought harder
than the rest for pole position.
The position for top performer
jockeyed back and forth
between ASUS’ PM17TX and ~ ViewSonic VA1703w
Samsung’s 713BM Plus, !m17-inches wide!

T,'-' Are 8-bit Panels Worth It?

s we mentioned in Enter The Matrix, Digit March 2006, there are four types of

LCD panels being mass produced (though not in equal numbers) today—TN, S-IPS,
MVA and PVA. TN panels are by far the cheapest to produce and to buy. These are
typically 6-bit panels—6-bits for each colour, which translates to a total of 262,144
colours. However, by a method called dithering (basically interpolation)
manufacturers reach the magical figure of 24 bits i.e. 16.7 million colours.

S-IPS and PVA panels are native 8-bit panels, so colour rendition is always
superior. MVA panels are the middlemen—they can use dithering, or be native 24-bit.

We have already established that professionals working with images and
rendering should avoid 6-bit panels. Another problem inherent to TN panels is the
inferior viewing angles. Manufacturers’ quotes for viewing angles are not always
accurate, simply because the methods employed to measure viewing angles differ.

In our test, we noticed severe issues with viewing angles (vertical in particular)
with almost all the 6-bit TN panels.

As the adage goes, all major problems are solved by financial convenience. This is
true here as well-TN panels are available in abundance and cheaper by a fair amount
than MVA or PVA panels of the same size (S-IPS panels are the costliest). In India,
more than 90 percent of all LCD models available are 6-bit panels—8-bit panels are
mostly reserved for the 20.1-inch and larger categories. This means that anyone for a
17- or 19-inch LCD will have no option but to go 6-bit.

This said, the difference in price is worth the premium you pay for these higher-
quality panels, but if (and only if) you plan on using your monitor for digital
entertainment or for professional graphics work.
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especially when working in the dark—it’s simply | Brand Company Phone
too bright; thankfully, it’s not red or even blue! | Acer Acer India Pvt Ltd 08025219520 alankar_s@acer.co.in
This is common to neaﬂy all ViewSonics. AOC AOC India 1800 425 4318 info@in.aocmonitor.com
Acer’s ALL1706 attracted attention, and held ASUS ASUS Technology Pvt. Ltd 022 - 4005 8888  media_india@asus.com
it—it’s built on the same slim, ultra narrow bezel, BenQ BenQ India Pvt Ltd' 9312378705 Sales.Enquiryln@BenQ.com
. . . . Dell Dell Computers Asia Pte Ltd 080-2506-8026 NA
attrqut.lve lines as the AL1906 but unlike its larg- HP Rashi Peripherals 22-67090909 navinderc@rptechindia.com
er sibling, there weren’t as many show stoppers. Intex Intex Technologies 01130888919 sanjay@intextechnologies.com
Visually, Dell’s 1707FP has to get top honours— Jetway Rashi Peripherals 22-67090909 navinderc@rptechindia.com
the stands are absolutely amazing’ and we could- LG LG Electronics India Pvt Ltd 9899302074 avarshney@lgindia.com
n’t ﬁgure out how such a slim stand could hold NEC SHIBA COMIZPVTl.LTD ) 011-30822106 sales@:]shibacomp.com
N . S, g Samsung India Electronics Pvt Lt 011-41511234 rengith.nair@samsung.com
the monitor Stably' And S.table 1t was—even m(.)re ViewSonic Roop Electronics 022-26681921 umang@rooponline.com
so than some models with bases that occupied
double the surface area. Dell also has some of the
narrowest bezels around—and this makes for with Dell’s 1707FP watching from a close third.
great dual-monitor setups with hardly any gap Right on the 1707FP’s heels snapped Acer’s
between screens. Samsung’s 740N also has a nar- \ . > AL1706, BenQ’s FP71G+, LG 1732S and both the
row bezel, though the round stand is a bit ugly. BEST BUY ViewSonics. Despite its success, the PM17TX from

ASUS wasn’t without issues—there was moiré
present in the coarse grained tests. The Samsung
713BM Plus didn’t have any issues; unfortunately
the price (Rs 19,000) will scare away most cus-
tomers before they even switch it on! Considering
it’s a TN panel-based monitor, Samsung should
seriously consider revising its price.

Samsung’s other offering in this category—
the 740N—was way behind the leaders’ line of
sight. Though priced well, it has issues with
black levels and contrast ratio. This was notice-
able with improper transitions in shade intensi-
ty in the 256-colour test. Certain shades of gray
had some noise as well-minute, but noticeable.
We don’t recommend this monitor for anything
more than browsing and office work like docu-
ments and spreadsheets.

Both Acer’s AL1706 and BenQ’s FP71G+
caused us no concern throughout the tests.
While they weren’t the best monitors perform-
ance wise, they didn’t have any mentionable
issues, and if the price of the Samsung 713BM
Plus and the ASUS PM17TX is a cause for con-
cern, these two are for the frugal at heart—Rs
11,000 and Rs 10,800 respectively.

Shockingly, one of the cheapest monitors in
the test also performs quite well, closely tailing its
betters. We're talking about the AOC 177V, which
at Rs 9,800 breaks the 10,000-Rupee barrier. Other
sub-10,000 models weren’t so hot on perform-
ance—especially Jetway’s 1741S and Intex’s 1703.
ViewSonic’s VA1703W is sub-10,000 in the strictest
sense of the word (Rs 9,999), and also performed
commendably. In fact, it managed to out-distance
its non-widescreen sibling, the VA703M, reversing
the results of the 19-inch tests, where the non-
widescreen VG921M kayos its widescreen sibling
(the VA1912W) with no apparent effort.

Decision Time
If anything, the contest here was even more
fiercely fought than in the 19-inch category; vic-
tories weren’t clean, and all sides drew blood.
AOC made a clean sweep with top honours and
takes Digit’s Best Buy Gold in the 17-inch category
as well. Their champion, the 177V, is a winning
combination of price and performance. The
Silver goes to the sole widescreen in this catego-
ry—the ViewSonic VA1703. W
michael_browne@thinkdigit.com
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Getting New Furniture Made

Desks have this
annoying way of
collapsing the

Nimish Chandiramani (nimish_chandiramani@thinkdigit.com)

second they decide
that the world has
too many books for
them to handle.
There was also
other furniture
around the house
that needed
replacing, so it was
time to summon
the carpenters.

I describe the desk I want to the labourers. They
listen intently and seem to comprehend, so this
might go nice and smoothly like I'd hoped. Ah,
naiveté...

There had to be a better way to get the rest of the
furniture done, and the best way was to show them
visually. I have the drawing skills of an epileptic rat,
but I've been tinkering with Google SketchUp for a
few days. I wonder...

The frame of the desk starts to look more like an
oversized stool rather than the workstation I had
asked them to make. This is unacceptable, so I get
them to change it, explaining again exactly what I
want at the bottom, and where I want the drawers.

I start with SketchUp, thinking that it’ll take me just
a few minutes to design a new cabinet; no such luck.
I'm not limited by the software, but actually using
those features to create something that will become
real is a different ball-game.

»

The carpenters decide to use their own “creativity
to conjure up an abomination they call a footrest.
This is all very disappointing, and I tell them so.
Getting it re-done is going to take time, so I decide
to live with it.

I struggle with SketchUp for a couple of hours,
making sure that I use the exact measurements for
the cabinet—I don’t want to end up miscalculating
anything.

And then they botch up the drawer. Turns out they
miscalculated the length of the drawer, so now sitting
at the desk makes opening it impossible, unless I'm
willing to forgo some skin on my knee. Genius.

The cabinet’s done, and I've verified the
measurements and proportions a billion times.
When I show it to them, the carpenters seem to
realise that it’s a Formidable Force they’re dealing
with, and get to work.

Well, at least the top’s flat and the drawers open. I
have to deal with the bizarre frame, but it doesn’t
interfere with my life so much.

This way is so much better. I've got my cabinet just
the way I designed it!

Convenience Meter: 2 (Just short of
murderous rampage)

Convenience Meter: 4 (Learning new
skills takes time!)

f you’ve got the time, inclination and the skill, design

your furniture in Google SketchUp or similar software
like 3D Home Creator, and then have your carpenters
build it. If they have any snags on the way, you can

show them every detail in 3D, and they can’t even
come back at you with a “your instructions weren’t
clear” if things go wrong. Just make sure your
proportions are right.

DIGIT MAY 2007
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2.1 Speaker Sets

Altec Lansing ATP3

[ Great overall performance
E None in particular

Contact Rashi Peripherals Pvt Ltd

Phone 022-67090909

E-mail navinderc@
rptechindia.com

Price  Rs 3,400

5.1 Speaker Sets

Artis S6600R/FM

[ Good performance, radio
H None in particular

Contact Kunhar Peripherals Pvt Ltd
Phone 022-66345758

E-mail mail@kunhar.com

Price  Rs 8,500

Hard-Drive-Based MP3
Players
Apple iPod 80 GB

Large capacity; great
fidelity
Expensive

Contact Apple Computer
International Pvt Ltd

Phone 09886039424
E-mail avinash_ramchandra@
asia.apple.com

Price  Rs 23,900

Wi-Fi Access Points

Linksys WAP54G
Great performance

H None in particular

Contact Ingram Micro India Pvt
Ltd

Phone 9323112279

E-mail
sunil.z@ingrammicro.co.in

Price Rs 3,816

Digital Cameras

(High-End)

Sony Cybershot W50

[ Excellent image quality,
vibrant colours

= Trouble focusing in low light
Contact Macro Photo
Phone 022-22618639
E-mail macro.photo@gmail.com
Price  Rs 15,000

Digital Cameras

(Mid-Range )

Sony Cybershot DSC L1

[ Great image quality

=0nly 4 MP CCD
Contact Macro Photo
Phone 022-22618639

E-mail macro.photo@gmail.com
Price  Rs 9,000
Processors

Intel QX6700 Core 2 Extreme
[ Extreme performance
= Expensive
Contact Intel Corporation
Phone 080-25075000
E-mail saranya.rustagi@intel.com
Price  Rs 52,000

Projectors

Acer PD726W

[H Great overall performance
= No remote sensor at rear

Contact Acer India Pvt Ltd
Phone 9880544226
E-mail alankar s@acer.co.in
Price  Rs 1,50,000

LCD Monitors (19-inch)
AOC 197S

[ Good looks and performance
= Gloss finish catches smudges

Contact AOC India

Phone 1800 425 4318

E-mail info@in.aocmonitor.com
Price  Rs 12,000

LCD Monitors (17-inch)
AOC 177V

@ Good performance

= None in particular

Contact AOC India

Phone 1800 425 4318

E-mail info@in.aocmonitor.com
Price  Rs 9,800



Hardware:

Be A Big

Buy Or Lease?

Bad Boss

Tech Careers

The Silk In The Web

As online businesses increasingly realise the importance of their Web sites’ functionality, the Web

programmer flourishes

-
3
r
1
]

Samir Makwana

o , he face of the Web has changed over the
I past few years. If you remember what

H“’" L most Web pages were like a few years

Y m ago, youll vouch for that. Theyre getting

e L £ more complex, they're prettier, and they’re
ﬂ?ﬂ“ #* more functional, too. Of course, we’re gener-
- -, alising, but take just one example: what was

E- = Amazon.com like some years ago, and what is

E%up- bgcolor—"fongedytodar? Incaseyouiretooyoung fo remem;

u ber, trust us, it wasvery different—and lim-

R, g ited in comparisoen, in terms of just what

Y we've mentione‘ﬂ complexity, prettiness,
functionality, afid more.

Many fiew Web sites offer online

services-ilike word processing,

& s'ﬂreadsheets and image

hel editing, which we nor-

%n» mally do on our

ol

i$"/one of

‘go into the
a]dlng of what
i call” Web

2.0—Web sites offering applications that have
the functionality of Desktop applications.

The Web programmer is playing an
increasingly sophisticated role.

Hard Code

Web programming is different from Web
designing. The latter focuses on the look and
feel of the site, while Web programming has
to do with the functioning of the Web site as
a whole. But somewhere or the other, the
work of the Web designer does overlap with
that of the Web programmer: they may use
the same product for creating a page, or sim-
ilarly edit the code to impart a better look
and feel to a page.

A Snapshot Of The Field

Programming for Web sites involves both
Web authoring software such as Adobe
Dreamweaver, and programming languages
such as C, C++, Visual C++, etc. Code for Web
sites is written for performing specific

elemc‘-."i‘ﬂ;k~L functlons such as searches, access to databas-

e'§' -and any processing of text, graphics, ani-
mation, and other audio-visual content
for the user.
Programming for Web sites can be classi-
as basic or core programming, visual pro-
Tamm ng, and programming with data-
}'stems Specific languages are
for specific purposes.
Server-side programming
F%érs to creating code that
cutes —on . the servers
which send out Web pages.
- -On the server side, pro-
; ming results in Web
- software that
ds to requests sent by
ent-side) browser by

fied
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Good
mathematics
education at the
school level, and
an emphasis on
computer science
concepts rather
than solely on
programming
languages, are
necessary to meet
the demands of a
trained, quality
workforce”

Sudipto Majumdar
CTO
Zapak.com

On the other hand, client-side programming
consists of scripts that are designed to enable
user interaction in the Web browser. Client-side
programming includes verifying user data, mak-
ing graphics dynamic, and making navigation
easy. Actions performed within the browser, such
as the pressing of buttons or filling forms, are
responded to by sending a request for informa-
tion to the Web server and displaying the
received data. Client-side programming is respon-
sible for all such behaviour of the browser.

“Different markup and scripting languages
are used for server-side and client-side program-
ming. One has to choose which side one wants to
master, right from the beginning,” says Amit
Shah, software engineer with Directi Group,
which offers mass-market Web products and serv-
ices. Shah’s advice is the starting point for anyone
looking to Web programming as a career option.

HTML—HyperText Markup Language—forms
the base platform to define the layout and struc-
ture of a Web document. HTML is complemented
by various languages—PHP  (Hypertext
Preprocessor), ASP (Active Server Pages), XML
(eXtensible Markup Language), and more.

With PHP, for example, it is possible to create
levels of security against malicious attacks. Using
ASP can make Web pages dynamically editable.

Languages
Scripting languages are relatively simple pro-
gramming languages that are used to create
scripts that, when inserted into a Web page, con-
trol various elements of the page, such as the
user interface, styles, and HTML markup. The
scripting language interprets requests for HTML
documents and objects embedded in the HTML.
PHP and ASP are some of the widely-used
scripting languages. They can result in a code
base as much as ten times smaller for the solu-
tion for a problem (as compared to a “regular”
programming language), which increases the

w#programmer’s productivity by reducing the

number of bugs in the code.

Scripting languages are of two types—client-
side and server-side. Client-side scripting refers
to the use of scripting languages such as

_{]avaScript to automate applications that are exe-

The Languages
page development

Basic Programming
Visual Programming

Database Systems

Base platforms for Web HTML, XML, PHP, ASP

C, C++, PHP, Java, Perl, Python

Visual C++, Visual Basic, Java, ASP.NET,
Java Server Pages (JSP), AJAX
(Asynchronous JavaScript and XML)
SQL (Structured Query Language),
MySQL, Oracle, MSSQL (Microsoft
Structured Query Language)

cuted on the client side (within the user’s brows-
er). Server-side scripting involves executing

scripts on the Web server before any data is

passed on to the browser.

Server-side Or Client-side?

A person good at networking and with a ready
hand on hardware and Web protocols is best suit-
ed for server-side programming. Individuals with
good knowledge of data-
bases and servers can
opt to learn languages
like Perl and Python for
writing code for the
Web server to perform
object-oriented  func-
tions such as e-mail pro-
cessing, advanced con-
tent management sys-
tems, general-purpose
templates, and more.

Perl (Practical Extraction and Reporting
Language) is widely used for writing programs
for Web servers involving tasks such as generat-
ing reports, database synchronisation, auto-
updating of user accounts, etc. Python is used for
writing basic CGI (Common Gateway Interface)
scripts, advanced content management systems,
Web application frameworks, processing e-mail
and RSS feeds, etc.

Those who wish to be in client-side program-
ming need excellent knowledge of browser tech-
nology, operating systems, Internet protocols and
such, with the ability to format content received
from the Web server in the best possible manner.

The third option—that of working with data-
bases—can be taken up by those from a database
background. For more on careers in database,
refer to Digit, April 2007.

The Tools Of The Trade

An education with a specialisation in computer
science increases the chances of selection for a
Web programming job. Students with an engi-
neering, IT, or mathematics background are con-
sidered the best fit for Web programming by the
industry. Graduates and post-graduates having
majored in computer science (BE | ME in com-
puter science), or those with a degree (BSc | MSc)
in mathematics or statistics enjoy preference
over candidates from other backgrounds.

“The industry prefers BE candidates with
experience in development languages, and those
with a diploma from reputed computer insti-
tutes with a good academic background. Also,
candidates from a science background with com-
puting or mathematics as a major subject are
also given preference,” says Harish Sukhwal,
CEO, Hashtech Systems Pvt Ltd, which offers Web
services including hosting, business process out-
sourcing, and security solutions.

Sukhwal also says that the skill set of a good
programmer in today’s context should ideally be
one of the following:

[ PHP + MySQL + XML

[ ASP + MSSQL + XML

[ ASP.NET + MSSQL + XML + AJAX
[ JSP + Oracle + JavaBeans

Candidates from other disciplines such as
mechanical engineering, electrical engineering,
chemical engineering, and others streams are
also recruited, though.

“Information technology as a part of the cur-
riculum for varied disciplines, such as com-
merce and arts, will ensure professionals are bet-
ter prepared for the challenges of online busi-
ness,” says Venki Nishtala, CTO, Rediff.com.

The perfect destinations to get equipped with
the tools of the trade are universities and col-
leges approved by the All India Council of
Technical Education (AICTE).

There are also private institutes that offer a
number of short-term or one-year courses, which
can be pursued for an additional qualification.
They provide education and training in specific
products (such as Dreamweaver, Fireworks, and
FrontPage) and the syntax of languages like
HTML, PHP, ASP, and Java, to name a few.

The quality of education at a private insti-
tute, however, depends upon the teaching facul-
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ty, and is not standardised. One should assess the
quality of education and placement credibility
before enrolling in a private institution.

A decent demand for Web programmers lies
in the Web portals industry, which by and large
works in sync with educational institutions for
the development of up-to-date computer labs for
education in accordance with industry require-
ments, and for offering internships to students.

“The biggest challenge faced by program-
mers is obsolescence of their skill sets. The best
bet is to invest time and effort in understanding
the fundamental protocols and concepts well.
Once this is done, any new programming frame-
work or language can be very easily picked up,
since vendors may change the syntax of pro-
gramming, but they still need to fit it within the
fundamental protocols, which never change,”
says Sudipto Majumdar, CTO, Zapak.com, a lead-
ing Indian gaming portal.

Recruitment

Web portals recruit programmers on a large
basis for research and development on their
sites. A good programmer is expected to possess
networking and hardware knowledge—knowl-
edge of servers, routers, VPNs, and such. A blend
of excellent software skills and decent hardware
knowledge is a winning recipe for a fresher.

“On the software and programming skills
front, logic is more important than any coding
language. Programmers should select a language
and upgrade themselves in that area instead of
learning several languages and then become a
jack of all trades. A good Web programmer
should also understand the business logic behind
Web site development,” says Sukhwal.

Training
Training on the work process and development
parameters is imparted by the organisation itself.
“Depending upon the individual, training on net-
working concepts, Web protocol concepts, pro-
gramming language training, database design-
ing and conceptualisation, and Web site architec-
tural concepts are imparted,” informs Majumdar.
The training period is usually between one
and six months. During this period, the fresh
employee is placed under a senior programmer.

Levels And Remuneration

Promotions and appraisals depend more upon
the performance and individual contribution in
a project as compared to experience in the field.
The figures mentioned here are only indicative.

Language Sites

HTML www.htmlhelp.com, www.htmlgoodies.com, www.pageresource.com

PHP www.php.net, www.phpbuilder.com, www.php-resources.org, www.scripts.com,
www.phpfreaks.com

ASP & ASP.NET www.asp.net, www.worldofasp.net

Java, JSP java.sun.com/javascript/, www.javascriptworld.com, www.javascript.com

XML www.xml.org, www.topxml.com, www.xmlinfo.com, www.xmlpitstop.com

Perl www.perl.org, www.perlmonks.org, www.theperlreview.com, www.perlcast.com

Python www.python.org

All languages www.w3c.org, www.w3schools.com, www.webdeveloper.com,
www.programmersheaven.com, www.opendeveloper.org

e
Adding to the
demand for Web
programmers is
the advent of
mobile phones
that support
browsing. There is
a need for trained
and skilled people
who can build
sites for the
mobile platform”

Lincoln Gada
CTO
Hungama.com

Experience Required—And Remuneration

Level 1: At the entry level, most of the Web pro-
gramming activity is done by Junior
Programmers and Senior Programmers.

Junior Programmers | Software Engineers:
They need to understand their assigned modules,
and code and develop applications for particular
modules of the broader Web site architecture.

Senior Programmers | Engineers: They are
responsible for framing the site architecture
and develop the different Web page applica-
tions and functions. The modular functionali-
ty of the site programmed by the junior pro-
grammers are tested, debugged, and then
approved by them.

Level 2: A certain amount of management capac-
ity is demanded of a senior programmer advanc-
ing to this level.

Team Leader: He assesses the needs of the
team and designates work to the team members.
His job also involves some programming along
with testing and validation of the prototypes pre-
pared by his team. The team leader helps junior
and senior programmers to understand the
architecture and functionality of the project.

Assistant Project Manager: This designation
carries with it the tracking of the progress of the
project, documenting progress reports, and pass-
ing on these to the project leader. They give proj-
ect briefs to team leaders and maintain the proj-
ect documentation.

Level 3: After reaching the top level, one can
decide upon whether one wishes to be more on
the technological or management side. This level
is composed of the Project Managers and the
Solution Architects.

Project Managers: Getting business, main-
taining the design protocol standards of the
organisation, interacting with clients for details
about their requirements, and demonstration of
prototypes to clients form the major part of their
work profile.

Solution Architects: They focus on the archi-
tectural aspect of the site development projects.
Solutions for adoption of particular products or
software platforms for Web development are
designed by these individuals.

A Closing Note

“The sky is the limit for good Web programmers,
because slowly all programming is migrating
from the traditional client | server model or
Desktop-based programs to Web-based program-
ming. With Web 2.0 picking up fast, AJAX pro-
grammers are in demand,” says Majumdar.

Web programming is an exciting career for
those who can learn programming quickly and
also feel the itch to
make a better Web site

Designation Salary per annum Relevant when they see a poorly-
(Rs in lakhs) Experience (years)| made one. Learning the
Junior Programmer 0.6 - 2.4 2-3 languages comes first;
Senior Programmer 2.4 - 4.8 3-5 implementing that
Team Leader 5-10 =7 learning can be finan-
Asst. Project Manager 10 - 14 7-8 cially rewarding—and
Project Lead/Manager 15 - 25 8-12 fun as well! B
Solution Architect 15 and above 8-15 samir_makwana
@thinkdigit.com
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YOUR EMPLOYEES

Hate You...

...if they don’t already! Get them to stop wasting time...and be merciless about it!

Robert Sovereign-Smith

A quick quiz:

1. You’re watching Star Wars Episode 6 (Return Of The
Jedi). Darth Vader (Anakin Skywalker) has just thrown
the evil emperor into that bottomless pit. You...

a) Shed a tear. You actually liked that crazy old coot.

b) Rejoice. The dark side of the Force is vanquished.

2. You're watching the TV serial The Office.

a) You cannot understand what all the fuss is about, and
all the jokes are terrible. That poor boss chap...

b) It’s your favourite show. You swear there’s one of each
character of the series in your office.

afraid. If “a” is what you went with both

times... Warning: this article could cause
serious friction burns from vigorously rubbing
your hands together in glee, and make you burst
into hysterical laughter. Yes, you guessed it. You're
that dreaded and much-hated creature called The
Boss, whom no one understands. You're the Gollum
of Middle Earth, ugly, disgusting but very much
necessary if Frodo is to ever find his way.

OK, enough of the silly analogies; you're a boss,
and you have a job. It’s not pleasant, but it has to
be done. You just have to prevent your employees
from running amok. As of this century, however,
employees are much more tech-savvy. They're
always punctual, they’re always sitting quietly in
their little cubicles, and even avoid the regular
goofing-off waterholes. To the untrained eye,
they’re hard at work, silently toiling away at their
desks. Your latest sales figures and financial
reports tell you otherwise.

The Internet is one of the banes of every boss’
existence. Sure it’s informative, and even a neces-
sary enabler for a lot of existing business models,
butit’s also the world’s favourite goofing-off spot.
A couple of videos on YouTube, scrapping friends
on Orkut, checking useless forwards sent by

I fyou answered “b” to both, be afraid. Be very

s

friends | colleagues, IM-ing all day, and even vis-
iting adult dating and content sites can reduce the
amount of productive time spent in office per
employee to a fraction of what’s expected.

Boss Speak

None of the people we spoke to for this article
wished to be named, whether boss or minion. No
one wanted to ruin the work relationships they
have, and we understand that. We will quote
them, however, quite shamelessly, but will not
include their names.

The CEO of a BPO said, “I hate IMs. I have never
seen a worse technology invention. Nothing ham-
pers productivity as much as MSN and Yahoo! Mes-
senger. We blocked those chat protocols, and then
our employees started using browser-based serv-
ices like www.e-messenger.net. It was like an
addiction we had to break. Now after we’ve
blocked all the browser-based messenger sites,
they’re using local chat applications such as IP

Messenger to waste time chatting with the
person in the next bay!”
A system admin of an
e-learning company
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says, “Our company’s favourite pastimes seem to
be Orkut and blogging. We blocked them, but
they started using public proxy servers to get
access again. As for personal blogs, we had to send
out a memo telling our employees that their blogs
were being monitored, and warnings were issued.
Still, some people are so addicted to Orkut, Adult
Friend Finder, Yahoo! 360, or blogging that they
risk their jobs by trying to access them.”

A business manager in a small publication
house says, “We have various levels of computer
users, only one of which gets Net access. The rest,
designers for example, get only company e-mail
access. Our problem is not Net-based, it’s Win-
dows games that waste the most time. I am sure
we have at least a few Solitaire and Spider cham-
pions in our midst!”

Most of the other bosses we spoke to had the
same complaints. A few were more concerned
about company e-mail and what employees were
e-mailing out of the company (despite confiden-
tiality clauses), rather than what mails they were
receiving. Some even related incidents of virus
attacks that obviously originated from within
the office, because some employee thought it
would be fun to have some time off to watch
system admins battle the malware.

Overall, the Sith lords of the multi-verse... err...
we mean bosses, stood together and in unison
cried, “Foul!”

Smaller Solutions

Now, companies with computer strengths of more
than 100 PCs are generally well-organised. They've
been bitten by the time-wasting bug and have
mended their ways. It’s the smaller companies (at
least amongst the ones we spoke to) that didn’t
seem to realise how much of employee produc-
tivity they were losing. An HR manager for a small
services company (10 PCs) was shocked when we
told her what other bosses were saying. We
decided to sow the seeds of doubt in her head,
installed a monitoring software on a server,
enabled logging, and went back after three days.
“I can’t believe it, I can’t believe it,” she repeated,
when we showed her that her 10 PCs had sent |
received over 5,000 IMs in those three days. Taking
an average of 10 seconds wasted per message sent
| received (they have just a 256K connection), that
worked out to 5,000 x 10 = 50,000 seconds | 3,600
= almost 14 hours of productive time wasted.
Close to 30 minutes a day per PC!

With bills to make, payments to collect, and
accounts to be tallied, we’re betting she’s waiting
for this article to see how to stop her company’s
PCs from being misused thusly.

“As a smaller company, we have to work doubly
hard to compete with larger, richer companies. 'm
certainly not going to rock the boat and ban IMs,
butIwill send out a memo to the employees.” She
thanked us for the help and says she will make
sure all her employees read this article.

Enough of the reality bytes: time for some
problems and their solutions...

@; Unnecessary Browsing

-'!7,/’ The most common complaint we received
was that employees waste time surfing. Not only
is productivity affected, it’s also a complete waste

A proxy server
can even be used GB, so any savings is always welcome.
to block access to
sites, or even be
configured to
only allow access
to certain sites

of bandwidth. Here in India, whether at home or
at work, we still pay for bandwidth by the MB or

, Proxy Server
P~ A proxy server can do a lot more than
restricting employees to certain sites. If it has a
caching system, it can help cut your bandwidth
costs in half. Instead of fetching the same page 10
times for 10 PCs, it does so once, and serves the
same page to anyone who requests it.

Apart from bandwidth savings, a proxy
server also helps you identify who’s doing what,
and visiting what sites, for how long a day. No,
you don’t have to get all worried now and think
lawsuits: this is not spying, it’s merely called log-
ging. You have a right to know how your proxy
server is being used.

Apart from threatening your lackadaisical
employees with its logging capabilities, a proxy
server can even be used to block access to sites, or
even be configured to only allow access to certain
sites. Another boon is the fact that you can ban
many file extensions, such as .exe, .zip, .rar, etc.
to prevent your employees from downloading so
much. If you choose your proxy solution well
enough, you can even block all IM protocols.

Suggested Software
Squid (www.squid-cache.org): If you can
spare a server PC for Linux, this is the software
you should use. It supports caching (accelerated
surfing), SSL, and DNS caching, is very, very scal-
able—whether it’s 10 PCs or 10,000 accessing the
Net, it’s stable—and if that weren’t enough, it’s
open source and completely free! Though it does
run on Windows via emulators, you're better off
running it on Linux. It’s not newbie-friendly,
though, so if you haven’t a clue about Linux or
editing configuration files, steer clear.
FreeProxy (www.handcraftedsoftware.org):
All the features you’d want, including detailed
logging, complete access control, ban lists,
caching, authentication, and much more. In
short, it’s quite a well rounded proxy | caching |
Net access restriction software, it’s free, it’s scal-
able, and runs on Windows. For smaller setups,
this is a good choice because it just sits on a com-
puter, runs as a Windows service, and will bring
down bandwidth usage considerably.
WinGate (www.wingate.com): Medium-sized
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FreeProxy is good for safeguarding small businesses from the costs
associated with bandwidth wastage by employees goofing off
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businesses might want to look for something
more robust and secure, and this is a good alter-
native. It features authentication, detailed per-
user or per-service logging, a good firewall,
protocol specific restrictions, and much more.
Overall it will give any systems admin the control
he craves, while making sure your network is
secure and that your users are not up to mischief.
Implement this solution, and you’re sure to dis-
suade any goofing-off online because of its com-
prehensive logging and report-generating
capabilities. However, the feature you bosses will
love the most is its Al Filtering—just choose to
block adult, gambling, sports, chat, Web mail,
and even job sites, and WinGate will use a little
programmed Al and a rather large global data-
base to prevent your users from accessing such
content. No more feeding in individual sites to
block—just let WinGate block them automatically.
The bad news? You're going to have to cough up
considerable cash for this gem: the licenses are
priced by the amount of connected users, ranging
from as little as three to an unlimited amount.
Don’t confuse this with the number of PCs you
have, because if you have 100 PCs in your office,
you could consider buying a license for 25 or 50
users, since not all 100 will be accessing the Net
at the exact same time. Licenses available for
WinGate standard are 3 [ 6 | 12 concurrent users,
and for the Professional version, 6 [ 12 [ 25 [ 50 |
100 | 250 | 250+ concurrent users. Prices range
from $75 (Rs 3,375) for 3, $200 (Rs 9,000) for 12, to
$1700 (Rs 76,500) for 250+ concurrent users.

, Games

-'!__/" After the problem of e-goofing off, the
most popular complaint was games. A lot of
people have taken to playing games online
(Yahoo! Games anyone?), but since more and
more companies are filtering content and
blocking access to such sites, Windows games
have remained popular. Solitaire in particular is
infamous for being the game of bored secretaries
and employees, and most Windows games are
just too much to resist—they’re just sitting there
in the Start Menu, begging to be played!

Get Rid Of Them / Control Them

’ There are several ways you can prevent
access to Windows games. You could ]LlSt unin-
stall them from your PCs by going to
Add/Remove Programs (Start > Run >
“appwiz.cpl”) and then clicking on “Add/Remove
Windows Components” on the left. Select “Acces-
sories and Utilities” and then click Details.
Uncheck Games and press OK > Next > Finish.
Windows games will be uninstalled.

If you’re running a Domain Controller (see
Mayhem Management, Digit February 2007), you
can uninstall these games from all PCs, and then
prevent your employees from re-installing them.

If it’s not just Windows games, but all games
you want to prevent access to, you're going to
need some software help...

Suggested Software

StopGame (www.askmesoft.com): Now
here’s a must-have software for all bosses...
StopGame doesn’t just block games; it allows

People use IM to
make friends,
date, flirt, learn
about different
cultures...
problem is, so
many people are
doing so on
company time,
using company
bandwidth!

you to completely control if and when your
employees play them. This is the perfect retort
to those slackers who claim to need a little
relaxation at the fag end of a hectic day. If you
remove the games, you’ll get complaints; keep
them and your employees goof off; but what if
you could restrict access to games like Solitaire?
Half an hour a day, four hours per week, only
during official lunch hours... any sort of restric-
tion is possible. If the employee tries to break
the rules that you’'ve set and start a game,
poof—it just closes right down again. It’s like
you sitting there and pressing end-task time
and again, without the maniacal laughter or
evil giggling, of course! All you have to do is
install the software, follow the instructions in
the help files, add the games you want to block
| restrict (Windows games or otherwise),
and watch twitchy-fingered employees
with withdrawal symptoms order that extra
cup of coffee. You will need the StopGame
Office version of course, available at
www.askmesoft.com/stopgame_ office.htm. It
will cost you anywhere from $18 to $9 (Rs 800 to
400) per copy—depending on how many PCs you
want to install it on. For example, four licenses
will cost $18 each, 15 will cost $15 each, and 51
or more will cost $9 each. We’re sure our editor
would love to get something like this to prevent
us from playing Quake III Arena all the time, but
unfortunately, he knows we geeks will just find
a way around it! For most employees however,
this is quite a foolproof solution.

g Chat/IM

It’s just so easy now, isn’t it? We’re sit-
t1ng at our PCs chatting with people across the
world. We can even have voice conversations
for free, and see each other via webcams. Chat
is a beautiful technology, loved by every
mother and grandparent who has a child | rel-
ative abroad. It saves a bundle on phone calls as
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Use StopGame, of similar software to prevent employees from playing games

well. People use it to make friends, date, flirt,
learn about different cultures... problem is, so
many people are doing so on company time,
using company bandwidth! Most of the bosses
we spoke used words we cannot publish to
describe Instant Messengers (IMs).
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$© Block ‘em

" There are many ways to block IM traffic. You could just
block/disable the protocol ports from your proxy or NAT
server. A LAN Domain Controller can prevent IM software
from being installed or used. A really adamant systems | net-
work administrator can ensure that no employee connects to
any IM networks, ever! However, instant messaging has
become more a part of our lives than we realise. Many
employees use IMs to chat with clients—it’s free, instanta-
neous, and nowhere as close to invasive as a phone call. So the
new problem for both small | medium businesses and enter-
prises is not how to block IM access, but how to regulate it.

Suggested Software

Symantec IM Manager (www.symantec.com): What
was once a free software called IM Logic has been bought over
by security specialists Symantec and made into a security solu-
tion for any business. If you’re worried about IMs being a secu-
rity risk, or just a productivity killer, this is a solution you’ll
love as a boss and hate as an employee. The software sits on a
server and can log all IMs your employees send. It can block
IMs that contain certain phrases (in real-time), block file trans-
fers or just certain file types, it logs everything that’s said in
IM form, and generates reports as basic as who (user ID and IP)
chatted how long and to how many people, to reports that
will give you usage patterns and the exact messages sent. It
can connect to a SQL database and store all information there,
so admins can just search for keywords or users and get
detailed information. It is also very legally-aware, and informs
users and the people they speak to of its presence, so no law-
suits will ruin that sweet taste of victory over IMs. If anything
can stop your employees from goofing off and chatting all day,
IM Manager can. Just send your employees a mail informing
them of your decision to install this software (with a link to
the homepage) and your productivity should increase instan-
taneously. It’s not cheap, obviously, and you can expect to shell
out $40 (Rs 1,800) per license (per user) for small-sized organ-
isations, or $30 (Rs 1,350) for enterprises.

ﬁE’ P2P

' Here in India, a lot of employees take advantage of the
fat Net pipe that companies provide, and use it to download
illegal software and content using P2P networks. Apart from
increasing a company’s Internet bill, the illegal use can land
a company with a slew of lawsuits. P2P software are known to
tunnel (bypass restrictions by using another protocol’s ports),
and can even use normal HTTP ports (80) or POP ports (110 or
25). Basically, if you're connected to the Net, chances are your
employees can use P2P software and access networks to down-
load illegal content.

@ Stop Piracy

As mentioned, blocking P2P is a lot harder than any-
thing else mentioned before. Thankfully there’s software
available that will put your mind at ease. Such software is
rarely cheap, however.

Suggested Software

IM Lock Professional (Wwww.comvigo.com): Yes, we
know. This does fit into the category of an IM blocker, and
the name suggests that’s all it does... However, IM Lock is
much more than just an IM blocker. This software is a little
more expensive than Symantec’s IM Manager, but it’s pri-
marily a blocker, not a “Manager”. It can block access to all
known IM networks, Web-based IM services, streaming
media sites, and yes, almost every known P2P protocol and
related sites. So if BitTorrent is the bane of your existence, get
this and live peacefully, because it will block not just the
entire Torrent protocol, but also access to any site that has
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Torrent files on it. Apart from this, it will also
prevent access to other popular torrent clients
such as LimeWire, eDonkey, KaZaA, Bearshare,
eMule, Morpheus, and many more.

g_ Doing Nothing
-'!_ "~ With all the little cubicles and bays in
today’s office, it’s almost impossible to make
sure that everyone is working. Now there are a
lot of employees who don’t need to goof off in
any of the various ways we’ve described above.
Although rarer, this breed of employee is much
more prone to goofing off, because you’ve spent
all that money blocking things they never used
in the first place. How can you make sure that a
few employees are not sitting around reading
the sports headlines, or curled up in that plush
chair reading a book? Honestly, you may not
even be able to tell if they’re in their seats or not.
Let’s not even start thinking about what they’re
doing when you’re out of office at a meeting or
travelling abroad.

@-. Monitoring / Spying Software

~ ' Akeylogger or similar spying software can
help track employee productivity. Such software
can help you understand how each employee
utilises time, and what they’re doing in front of
their PCs. For example, an employee who falls
asleep will have the same screen in front of him
for a long period. In such a scenario, a screen
grabber spy software can show you that they
haven’t done anything for the past X number of
hours [ minutes.

Suggested Software

NetVisor (www.netvizor.net): The ulti-
mate tool for any boss, NetVisor sounds almost
too good to be true. This powerful software can
tell you anything you need to know about PC
usage of any employee in your company... seri-
ously! The list of features is so long that we’re
going to have to give you a URL so you can see for

yourself-www.netvizor.net/features.shtml.
We’ll list the few that will excite you the
most: per-PC logging of every keystroke typed,
site visited, files opened, chat conversations, e-
mail sent | received, applications run, software
installed, and much more. It can also create
reports and e-mail them to you, so even if you're
out of office, you can check your mail and see
who was doing what and for exactly how long.
It can take snapshots of every desktop and
upload it to a password-protected local or FTP
server, or just mail each snap. You can view any
computer’s Desktop at any time over the net-
work or the Internet. You can remotely run
applications on any PC, look at what’s stored on
their hard drive, use End Task to kill any appli-
cation you want, shut down | restart any com-
puter, send messages to any computer screen,
and freeze any mouse in the office (works great
if someone’s addicted to Minesweeper)! The soft-
ware can be run in stealth mode to hide from all
known anti-virus or anti-spyware solutions, and
will not show up in Task Manager, the Registry,
or even in startup. Of course, it also has the
ability to show splash screens to users, warning
them that they’re being monitored—good to pre-

: vent lawsuits. It encrypts all its log files, man-
Dependmg on the ages disk space and processor usage to make
laws of the Iand7 sure the PC doesn’t become sluggish, and is
the software easily configurable by even a novice.
solutions System admins will rejoice, because since it is
mentioned here basically an enterprise product, it can be deployed
mi ght constitute over the network from a single location, or over an

b ki he | entire domain. For all practical purposes, this soft-
reaking the law ware acts like a killer virus or worm, and puts

!f not every computer’s reins in your hands. Before you
m p|emented start swooning in the drunkenness of your imag-
correctly ined power, you should consider the prices: $295

(Rs 13,275) for up to five PCs, $495 (Rs 22,275) for
up to 10 PCs, $1095 (Rs 49,275) for 51 to 100 PCs,
etc., all the way up to $4,995 (Rs 2,24,775) for over
500 PCs! We warned you, such solutions are never
cheap!If you’re a paranoid boss however, you may
want the control this beauty of a software can
offer you. Incidentally, NetVisor runs on Windows
NT, 2000, XP and Vista.

Using software like NetVisor can give you detailed information on your employees

Take Heed

Warning: Depending on the laws of the land,
the software solutions mentioned here might
constitute breaking the law if not imple-
mented correctly. For example, installing a key-
logger or recording IM conversations could be
construed as illegal by courts, and even be a
violation of privacy. However, since it’s the
company’s furniture and PC, it can dictate the
way it is used. Usually, just being upfront about
the solutions you deploy, and getting
employees to sign a waiver or acknowledge-
ment that they are aware of the methods you
are employing to increase productivity and
security, is enough. Still, if you’re planning on
using any of these solutions, get in touch with
your legal counsel.

All this will obviously not make you very
popular, but it will certainly sit well with your
bosses. So go ahead, be evil, surrender yourself
to the Dark Side, and start making your
employees miserable! m

robert_smith@thinkdigit.com
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Illustration Shrikrishna Patkar

Outlook and Exchange Server team up to become a powerful collaboration
suite. If you’re worried about the price of Exchange, though, fret not—there
are many open source alternatives to consider

Nimish Chandiramani

e never get tired of broaching collab-
Woration-related topics in this section,

and for good reason. No matter how
much we streamline our work here at Digit,
there’s always some snag or the other that
comes up—the writer finished the article, but
the sub-editor didn’t find out, someone forgot
to tell the editor that the article was ready for
print, and so on.

You won’t face the exact same situations,
obviously, but unless everyone’s reading each
other’s minds in your organisation, there’s
scope for improvement.

Half The Client

What do you use Outlook for? If you’re con-
necting to a POP or IMAP server to get your e-
mail, then chances are you’re using it for the
same thing that the majority does—checking
your mail, managing your contacts, and per-
haps a bit of personal management. The bottom
line is that you’re using it as a personal tool, and
the only way it’s helping you interact with your
team is through e-mail.

We’ve touched on the benefits of pairing up
Outlook with Microsoft Exchange Server a
couple of times in these pages; read on now to
find out what those benefits really are.

Meeting At 10... er... 11... er...
Setting up meetings via e-mail can be painful.
Imagine this scenario: you've sent your team a
message to meet at 11.00 AM. While everyone’s
busy clearing and/or readjusting his or her
schedules, one person replies, saying that he’ll
be on an outdoor assignment at that time.
You now have to reschedule the meeting,
taking your own free time into account—
and what if you get the dreaded “I'm not free”
reply again?

Assuming you’ve got everyone to plan their
work day in Outlook’s calendar, having an
Exchange server at your office will enable you
to see everyone’s free and busy times, so you’ll
never have to encounter the above situation.

You don’t even need to hunt down atten-
dees’ schedules—just add them in the list and
tell Outlook to hunt for a date and time combi-
nation when everyone’s free!

You can also manage meeting rooms in
Exchange, to avoid those situations where
everyone’s ready but there’s nowhere to hold
the meeting.

Worried about what will happen to all your
important correspondence while you’re gone?

Call Upon Your Minions

One of the features that Outlook gives vaca-
tioning employees is the ability to add a dele-
gate for all their daily activities—someone who
will reply to your e-mail, ensure that all tasks
(discussed later) are either completed or fol-
lowed up, and so on.

You can decide which of your mail folders
delegates have access to (don’t let them near
your Personal folders, now), as well as whether
or not they can create new tasks for your team.
All these activities are tracked, so you can check
up on what your delegate was up to while you
were gone. Apart from being really convenient,
that last bit should feed your Big Brother
instincts quite well, too.

Remember the Tasks you can set yourselfin
Outlook? With an Exchange Server, you can set
tasks for not only yourself, but also anyone in
your team—complete with deadline and follow-
up reminder. Managing people just got so
much easier.

Another Outlook feature that Exchange
“unlocks” is the ability to create public folders
or mailboxes, where you can store important (or
unimportant) mails so that everyone has access

to them.
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Set up meetings when everyone’s free

But...

The problem with Exchange Server is that it’s
expensive. At $67 (Rs 3,000) per license, it seems
like more of a luxury for a small organisation,
unless everything has plunged into chaos. In
the past year or so, we’ve seen the emergence of
open source alternatives to Exchange, and
while they don’t mimic all the features, they
do get the essentials right.

Each of the suites you’ll encounter comes
with all the caveats of open source software—
specifically, iffy free support. If you do decide to
go in this direction, we recommend coughing
up the extra money for a supported version. In
fact, the developers have presented the prod-
ucts as paid software with an optional GPL
licensed version.

Open-Xchange Server
www.open-xchange.com

Open-Xchange is one of the more promising
Exchange alternatives available today. It works
in every situation that Exchange does,
including with Palm- and Windows Mobile-
based PDAs, and adds a few more features on
top. Depending on the size of your organisa-
tion, you’ll end up paying license fees starting
from $30 (Rs 1,350) per user to as little as $25
(Rs 1,125)—not exactly cheap, but less than half
the price of Exchange Server.

It also runs only on Linux, so you’ll have to
set up a Red Hat or SuSE Server to run it (other
distributions are fine, too, but Open-Xchange
officially supports the aforementioned two). If
you’re worried about the skills required, fret
not—Open-Xchange has a fairly easy-to-under-
stand administration interface.

To get Outlook and other devices or soft-
ware working with Open-Xchange, you’ll first
have to download the respective OXtender
plugin; not a particularly palatable act, butit’s
one of the compromises you have to make
when forsaking Microsoft Exchange.

Once you've got the OXtender, Outlook inte-
grates with Open-Xchange quite seamlessly,
even updating itself automatically. On the
other hand, you don’t get to keep your existing
Outlook folders—the OXtender creates its set of

Digital Business | Smart Businessé@i.‘

Open-Xchange inbox.

You can get yourself a live demo of the
Open-Xchange Web interface at www.open-
xchange.com/footer/downloads/openx-
change_onlinedemo.html (the server isn’t
always responsive, however); this will give you
an idea of the features it gives you. We’re quite
impressed with the project management part—
these solutions are usually made for software
developers, but the ability to add your own
custom fields to a project makes it easier to
adapt to your own specific needs. Finally, it fea-
tures Infostore—a knowledge base where you
can store documents for everyone to access.

The Community Angle

If you want to try out Open-Xchange, you can
download the Open-Xchange Community Edi-
tion free of cost. This open source edition is
mainly for developers who intend to contribute
to the project, but if you’'ve got the time and
skill, you can set it up as a long-term solution
in your office as well.

You’re not left to fend for yourself, thank-
fully—Open-Xchange has been extensively doc-
umented on the wiki (wiki.open-xchange.
com), and there are a bunch of step-by-step

bl |

Open-Xchange’s Web interface keeps you in touch with the office

&

guides to help you on your way. There’s also a
forum for you to share ideas and problems
with the community.

Plunge

Even for an organisation with as little as
twenty people, having this collaboration setup
will prove invaluable. Nearly everyone uses
Outlook at work, so the environment is as
friendly as can be. You can access your collab-
oration tools from anywhere as well, just as
long as you have Internet access.

For smaller organisations, even using the
open source edition is fine, but if you have luck
like ours, you’ll inevitably be faced with a
problem that befuddles both you and the rest
of the community. If you and/or a minion has
the skill to save the day in such a sce-
nario, well and good—if not, stick to
the paid version. m

nimish_chandiramani@thinkdigit.com
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Hardware: Buy Or Lease?

When is it feasible for a business to buy IT hardware, and when does it make
sense to get it on lease?

“Buying means economical benefits

and flexibility in operations”

Dr Agrawal’s Eye Hospital Ltd is a listed private hospital. It
has six branches in Chennai, and others in Jaipur,
Trivandrum, Trichy, and Salem. The Hospital provides eye
surgery along with ophthalmic services, and is also involved
in research on ophthalmic subjects. Through the Eye
Research Centre, free eye camps and free cataract surgeries
to the needy in rural areas of Tamil Nadu and Andhra
Pradesh are also conducted by the hospital.

(44 hen we just started off with the
Whospital, we considered two major
reasons for getting hardware for our
hospitals—affordability and the availability of

V Suresh

General Manager—Operations
Dr Agrawal’s Eye Hospital Ltd.

manpower to maintain it. Our services at all 11
branches are open 24 hours. Our daily use of
hardware includes computers, printers, and other
miscellaneous peripherals.

“We could not take the risk and afford to wait for
three to four hours for a service engineer to fix our
hardware: time was a major factor that made us
decide we should own our hardware and have a team
to manage it.

“Today, we buy our hardware—such as the latest
high-quality printers, cartridges, and more. We have
a team of IT engineers to provide us support services
for all of these.

“Since we own the hardware, we sell them and
buy new ones every two to three years. The payment
and tax benefits we used to get earlier when we
leased hardware are now covered, since we’re well
off with increased efficiency and prompt services.

“We definitely recommend buying hardware over
renting: it means economical benefits and flexibility
in business operations. You can have the latest
hardware and support round the clock. Small
enterprises who are just starting off, though, can
think about renting hardware.”

Y

:

“We're free from technological
obsolescence”

Vcare Call Centers India (P) Ltd is a wholly-owned subsidiary
of Call Centers India Inc., Seattle, which provides voice servic-
es with technical support to small, medium, and large organ-
isations. They offer inbound services for Direct Responsive
Television Marketing (DRTV) advertisements, outbound cold
calling and telemarketing services, online research services,
chat services including SMS chat, and e-mail support. The
company currently serves 15 clients.

(44 e’ve leased IT hardware in our premises
Wthrough CISCO Capital’s leasing pro-
grammes. We have over 250 employees

using the hardware with no trouble so far. We had esti-

“Before going with this
option, an organisation
has to plan their future

cash flow well”

Sandip Mehra
CEO
Vcare Call Centers India (P) Ltd

mated a number of benefits of getting hardware on
lease, amongst them the fact that we’d be free from
technological obsolescence.

“Upgrading any hardware is possible by incurring
upgrade fees as decided with the vendor, and the latest
hardware can be installed. Other financial benefits we
enjoy are that we could appropriate the lease expenses
as operational expenses, so they can now be skipped to
be represented in the balance sheet. Also, we could
convert our capital expenditure to other investments
in accordance with our requirements.

“The cost of ownership of hardware is lowered, as
we get different lease options. Regarding technologi-
cal obsolescence, you can buy the hardware at the end
of the lease period if you think it still suits your needs
at the lower price, or return it.

“Leasing of hardware is recommended for business
enterprises because they get the benefits of technolog-
ical obsolescence, and strategic planning for enter-
prise expansion can be done securely. Yet, before going
with this option, an organisation has to plan their
future cash flow well to cover the expenditure of the
lease. Other appropriate costing and minimal expendi-
ture benefits can be enjoyed along with tax benefits.”
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Touched By Tech

cribbling For All

How long can non-English-speaking Indians be forced to learn ridiculous key combinations to
type using a regular keyboard?

) Language Technicalities
Samir Makwana The major reasons for the low IT penetration rate

in India are accessibility, affordability, and usabil-
hat would you do if you discovered that
W the keys on your new keyboard had

Chinese-looking characters printed on
them? Get a replacement, of course. Or, if you're
curious to an unhealthy extent, you’d try and
figure how to use it—but as a pastime, for a few

ity. Computers and IT-Enabled Services are acces-
sible and affordable for the urban populace. Even
if they are made available to the rural population,
the usability factor prevails, due to lack of aware-
ness and knowledge. For now, think about the
lack of support for Indian languages on input

minutes at most. devices, which is a major impediment to the use
Think, for a moment, about the predicament of computers in rural and small-town India.
of those to whom English characters might as The primary reason behind this lack of
well be Chinese. Think about our rural masses. support in terms of keyboards is the diversity of
They don’t know English, and they’re forced to the character shapes of Indian alphabets. For
learn the alphabet if they want to use a regular instance, Hindi has 36 consonants and 12 vowels
keyboard. If you were forced to learn Chinese, that can modify the consonants. The shapes of the
you’d be outraged... yes? O consonants get modified when used
It’s a little like malaria. We’d certainly have with a vowel modifier: these can
already had a vaccine if the disease were preva- appear on the top, at the

il

%g lent in Western countries! Similarly, if Indians : Xz ol e ;ﬁ»@ bottom, or to the right of

§§ were to have developed the keyboard, it would x =5 ' the consonant to form a

£2 | have been much more functional for Indian - QS By EE #= " compound character.

£& | languages. But that’s not the case, and there’s not S . e B s Now, recognising each
much we can do about it. Or is there? g B s E y B (complex) shape of the

s, = newly-formed compound
h character becomes difficult
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Efforts are en
route to
eradicate the
requisite
knowledge of
English for using
computers and IT
all over India

when one is using a regular tablet for input. The
keyboard as an input solution for each of these
characters is inappropriate because to be able to
press the right combination, one needs to be
trained. And trainers are not easily available.

The Problem

The picture about future PC usage and IT pene-
tration in India looks rosy from the numbers
available: they’re on the upswing. But the
numbers are nowhere near what they could have
been if not for the language barrier. Indeed, one
of the key reasons for the relatively low IT pene-
tration rate in India is linguistic diversity.

Today, a number of solutions are available to
surmount the problem of computer use by non-
English-speaking people. The most common is
stickers imprinted with the alphabet of a partic-
ular Indian language to be overlaid on the
keyboard. But like we said, even with stickers,
training is necessary.

As an inelegant solution, some use Indian-
language translation software. A number of trans-
lation software are available on the Web: search
on the term “Hindi translation software”, and
you’ll get over a million results.

One Step Forward

A recent innovation is a gesture-based keyboard
designed by HP Labs India, Bangalore. This
keyboard was the runner-up
in the Consumer Electron-
ics category in the 2006

uRekha will make typing
in Hindi so much easier

Technology Innovation
Awards of The Wall Street Jour-
nal. The research team
behind the design of the
keyboard was led by
Shekhar Borgaonkar,
Department Manager—
Access Devices, HP Labs
India, who worked with
eight other engineers.

The Gesture-based
Keyboard is an electronic
tablet with pen-based input
on a touch-sensitive pad,
where letters of Indian
languages are entered by
gestures. The Gesture-based
Keyboard technology has been patented by HP,
and is test-marketed by Prodigy Labs India Pvt Ltd,
which offers solutions in the embedded technol-
ogy space. Prodigy Labs is marketing the keyboard
under the name uRekha.

How It Works
uRekha currently supports Hindi, Kannada, and
Malayalam. For support of other Indian languages,
it requires just about a month’s time, according
to Borgaonkar. We can soon expect the Gesture-
based Keyboard to support several languages.

The uRekha package has a graphics tablet, a
special pen, and the installation disc. It is priced
at Rs 2,500. The surface of the tablet has conso-
nants, vowels, and numbers imprinted.

Using the pen to stroke and tap on the char-
acters on the graphics tablet will display that
letter on the screen. Say you want to write an

Indian name, “Ashok”, in Hindi. The consonants
in “Ashok” are first tapped on the tablet.

In some detail, using the pen, after the “ v ”
in “Ashok”, the first consonant—*K "—is tapped on
the tablet. After adding “K”, you need to modify
itto “ K. For that, you draw the vowel modifier
“K S” on the consonant. The “d” does not need to
be modified, so the resultant word would contain
both non-modified and modified consonants.

When the gesture to input a vowel modifier
on a consonant is performed, the pen electron-
ically captures the gesture and the trajectory of
the gesture. The vowel modifier is rendered
using this information. Of course, for only
consonants or vowels, the pen is simply to be
tapped on the character.

To watch a demo of how uRekha works, take
a look at the Flash demo on this month’s DVD
under the Digital Leisure section. The device can be
used with Windows XP with Office 2002 or
higher, and on Linux as well.

Who's Using It

uRekha is currently being used in Karnataka,
Kerala, and also in the other south Indian states.
“We did a pilot study in certain areas and there-
after framed marketing strategies. We’re doing
road shows and demonstrations for promotion
and to inform people about uRekha. So far, we’ve
been successful in selling more than 500 units—
200 were sold to the government of Karnataka,
100 to the government of Tamil Nadu, and the
others to individual customers,” informs Harsha
KV, Managing Director, Prodigy Labs, an Embed-
ded technology company invovled in distrubu-
tion of uRekha.

Government employees are currently using it
as a data entry input tool for documents, files, and
reports. uRekha is also being used for filling forms
currently in Hindi, Kannada, and Malayalam).

There’s More...

There is more and more research and develop-
ment to break the language barrier in working
with computers being done. A sizable number of
organisations and academic institutions—CDAC
(Centre for Development of Advanced Computing),
to name one—are involved in the development of
products and services in Indian languages. For
instance, in the recent past, an Indian portal,
Guruji.com, announced a search engine in Hindi,
Kannada, and Telugu. Also, a number of OCR
(Optical Character Recognition) software are avail-
able for non-English languages as well.

The Department of Information Technology
has initiated the Technology Development for
Indian Languages (TDIL), which comes out with
interactive CDs and other information-process-
ing tools in Indian languages.

“Currently, a real-life study is being done on
the usage and popularity of the Gesture-based
Keyboard. We also have plans to bundle it with
our computers,” says Borgaonkar.

Language could very well no more be a barrier
for entry into the world of computing and infor-
mation technology. Progress towards the avail-
ability of the necessary tools has been slow, but
it’s happening. And that’s heartening. l

samir_makwana@thinkdigit.com
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Digital Leisure | Top 10 Console Accessories

Ten must-have accessories for your dearest consoles

Asfaq Tapia (asfaq_tapia@thinkdigit.com)

have changed too—from adolescents to teenagers to adults,

aming consoles have evolved greatly over the years—
from the early days of 8-bit to the modern era of Al-
intensive and resource-hungry games that have
become a part of our daily lives. The demographics

10. Electric Juicers

he Microsoft Xbox 360 Play and Charge Kit is a new product from the

Microsoft stables for the Xbox 360. It consists of a USB charging cable and a
battery pack, which lasts three weeks on an average charge. Since the kit uses
a USB cable to charge the batteries, it can be used both on a PC and while
you’re gaming. What’s disappointing, though, is the lack of a button to switch
off the charger when the batteries are fully charged.
Price: $20 (Rs 840) Available at: http://tinyurl.com/bn8y6

The Nyko Wii Charger is another innovative product. We all know that the
Wii-mote uses AA size batteries that run out before you can say, “Hail
Mugambo!”—this is where the Nyko Wii
i Charger steps in. It features 2 AA size battery
{:'1r l:j l_Ll Fj packs, 2 rubberised battery covers, and a
i ' charging dock for upto 2 Wii-motes. Unlike
@ ﬁ the Play and Charge Kit, though, this charger

may not last really long during marathon
i~ @ %1 gaming sessions—you need to remove the

s battery packs from the Wii
to charge them. The Good:
Well, they’re better than
swapping batteries
The Not-so-much: Nothing
in particular Price: $30 (Rs
1,200) Available at:
http://
. tinyurl.com/2fy2vp
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9. Keyboard Warrior

icrosoft recently announced the introduction of the all-new QWERTY
keypad-type attachment to their Xbox 360 controllers. This attachment
will eventually be integrated into the Xbox Live system online to be used while
chatting with buddies, blogging, and such. The QWERTY keyboard connects to
the headphone jack at the bottom of the controller and fits perfectly between
its shoulder blades. The Good: Fits
the controller like a glove
The Not-so-much: QWERTY
isn’t really a thumb-friendly
layout
Price: $30 (Rs 1,200)
T Available at:
L L http://tinyurl.com/2fy2vp

there is a variety of consoles and gaming accessories out there
that satisfy our needs.

So here are the coolest accessories for the latest consoles.
Now you can have fun while running yourself into debt too!

8. Chill Pills

n today’s age of resource-hungry consoles, more and
more components are being crammed into the same
space than ever before. And with gamers spending more
time with their consoles, it’s getting harder and harder

to keep these machines cool...

The Intercooler for PS3 was designed for the PS3
(duh). It keeps your system ice-cool during those intense
game moments—with five fans
located at the rear, top, bottom, =====x
left, and right of the PS3. The
fans at the left and right suck
the warm air out, while the one
at the bottom blows in cool air. i
The cooler increases the overall |
system sound by a notch or two
and looks downright hideous ;
stuck to the back of the PS3, but ““ge. £
that’s a good enough trade-off. B L

For extreme gamers, pro modders, and
engineering students alike, Koolance has launched its
custom water cooling kit modeled on its Exos LT product
line. The Koolance Xbox 360 Water-cooling Kit runs lig-
uid coolant over the CPU and GPU of the Xbox 360 mak-
ing it super cool. This kit is not for a newbie: Koolance
advises that it is not for inexperienced modders, and
provide no manual or technical support for it.

The Good: Keeps the Xhox cool, provides bragging rights!
The Not-so-much: Voids warranty, nowhere to go if you
get stuck while building it

Price: $290 (Rs 12,200)

Available at: http://tinyurl.com/36qwmj
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7. Pimp My Console

ooking at the same design and graphics on your console day-in and day-out can get pretty

tiresome. That’s why we have case modding—you can change the colours and looks of your
console. You could just take the correct paints and go berserk on your console, but if you're
not the DIY type, there are several options to choose from off the Internet. High-quality, vinyl
stickers can be stuck onto the console to change its colour and graphics. You get a wide range
of stickers at www.decalgirl.com, and they also offer to “skin” your controller with the same
design aesthetics!

On the other hand, if you want to completely change the design of your Xbox 360 or Wii, you
can do so with the I-Case provided by MCX. The I-Case comes in myriad colours from chrome to
semi-transparent blue, and has different case designs too!

The Good: Keeps the Xhox cool, provides bragging rights!

The Not-so-much: Voids warranty, nowhere to go if you get stuck while building it
Price: Varies depending on product

Available at: www.nyko.com, www.decalgirl.com

6. Yo-Yo Strap

e’re glad someone took those funny images of Wii-motes embedded in
TVs seriously enough to make the retractable Wii-mote Wrist Strap.
This contraption features a strong cord connected to a retractable device,
embedded into a wrist strap, which connects to your Wii-mote. The
retractable device will soon get loose, though, making it another plastic
projectile that people around you in the room should watch out for!
The Good: The wrist strap looks cool
The Not-so-much: You don’t want to be in the way when your Wiimote makes its
return journey
Price: $6 (Rs 250)
Available at: http://tinyurl.com/2tfwsa

5. Becoming Schumacher!

Over the years, racing games have evolved from those 8-bit one-race games to games with complex Al and near-realistic
simulations of real-world scenarios. Racing games become even more realistic and fun to play when they are accompanied by a
racing wheel and pedals.

The Ubisoft Thrustmaster for the Wii is just like any other Wii accessory—basic and functional. It comes bundled with GT Pro series and
4x4: World Circuit racing games. The entire focus here seems to be on gameplay and ease of use—like all
things Wii. The Ubisoft Thrustmaster steering wheel is made of foam, and has a slot in the middle
for docking the Wiimote, so the buttons are easily accessible during gameplay.

The Good: Cheapest steering accessory among all console steering wheels
The Not-so-much: Looks like the manufacturers are taking the “low development cost” of
the Wii a bit too seriously
Price: $45 (Rs 1,900) Available at: http://tinyurl.com/2sxdo9
Next in line is the Logicool GT Force FX steering wheel for the PS3, which is one
stunning wheel. With features like a 250-degree turning radius and 12 mappable buttons
on the wheel, it’s disappointing to note there’s no support for force feedback or the rumble
effect. The rubber padding on the wheel comes in handy during those extreme manoeuvring
moments. It also features accelerator and brake pedals.
The Good: Great looking design, good build, good turning radius The Not-so-much: No rumble,
expensive Price: $50 (Rs 2,050) Available at: Not yet available

The “wireless” tag on the Xbox 360 Wireless Steering Wheel is a bit of a misnomer—if you want
to experience the force-feedback and rumble effects, the pedals have to be plugged in. The
steering is completely wireless, though. Another amazing feature of the Xbox 360 Wireless
Racing Wheel is the F1-like styled gear shift paddles, located just behind the steering wheel
close to its shaft. This allows you to change gears without taking your hand off the steering
wheel, and change camera angles on the fly. It also supports wireless headphones for.

The Good: (Mostly) Wireless

The Not-so-much: Just “mostly”

Price: $130 (Rs 5,450) Available at: http://tinyurl.com/n9wdz
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4. Freeze Breeze

ver had to deal with sweaty palms after playing for
Eseven hours straight? Worry no more: Logitech has
launched the Chillstream Gamepad for the convenience
of PS3 folk. This one has air vents towards the bottom
on both sides of the controller, which have fans that
blow cool air onto your palms, so you are at your agile
best when fragging the enemy on a new map.

The “low” setting just\\
blows air onto your palms— -
what really makes it buzz is the
“high” setting, where it starts
to get a hit noisy too.

The Good: Keeps palms dry,

looks similar to the PS3

SIXAXIS controller

The Not-so-much: Not wireless; can get noisy
Price: $35 (Rs 1,400)

Available at: http://tinyurl.com/35ydd9

2. The Gaming Chair

ou’ll agree that it a bean bag is the most
Ycomfortable way to sit through a game. Now add a
2.1 Dolby setup to that bean bag, and you are in another
dimension altogether! The good part for us is that
Pyramat has just that (well, almost) with their S2000
range of gaming furniture.

The 52000 boasts of two 3-inch full-range 12-watt
speakers located on the shoulders of the chair just
behind your ears. It also has one 5.5-inch 20-watt sub-
woofer located around the mid area of the back rest.
This wizardry doesn’t end here—the S2000 has the
ability to accept radio-based stereo signals from any
audio device with stereo output, wirelessly. It can also
broadcast stereo audio via Bluetooth.

The dials and buttons are located on the right of the
chair, and can manipulate volume, bass, and input
selection. On the right is a headphone jack to which you
can connect your MP3 player!

The Good: Good speaker arrangement, Bluetooth
functionality, headphone jack The Not-so-much: No
tweeters Price: $130 (Rs 5,450)
Available at: http://
tinyurl.com/2rgj2x

Digital Leisure | Top 10 Console Accessories

3. Strum Your Way Through

he Gibson SG based Guitar Peripheral is one of those console

accessories you can spend hours with. You now not only have the
option of listening to your favourite songs, you can actually play it too!
This comes bundled with Guitar Hero on the Xbox 360 and PS3.

The mini SG comes across as being of the ideal size—not too big
and not too ridiculously small either. It has 5 buttons instead of the
fret bars, a strummer, and a whammy bar for those moments when
you just have to go electric!

Another aspect of the mini SG is the slightly elevated yellow button
right in the middle of all the buttons on the neck. This can be a real
lifesaver when you get lost between the buttons. A wonderful
peripheral to own.

The Good: Near-perfect size The Not-so-much: Button quality,
isn’t that great

Available at: www.redoctane.com/gh- i 3,‘:

Price: $40 (Rs 1,700)
sgcontroller.html
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1. Kung-Fu Fighting

he age of NES controllers was when arcade-style fighting games

flourished. It was also a time in which controller and control buttons
were simple, and you could just kick or punch your enemy. With the
advent of combination moves (combos), controllers got more and more
complex with more and more buttons on them. In such a scenario, a
gamer with small hands is an outcast, since it is difficult to quickly
reach a myriad buttons with small hands. This is where the Fighting
Stick 3, manufactured by Hori, comes into the picture. This arcade-style
controller will remind you of the NES controller era! Unfortunately for
us, it is still sold only in the US and Japan.

The Fighting Stick connects via USB to the console with a cord that
is 10 metres long. The designers put some thought into it: this is evident
from the rubber grounding used in the legs, and the metallic base
which makes sure the stick doesn’t move too much while playing.
Moreover, the stick has a plastic body with rounded corners which don’t
come in the way while you’re bashing demons. The buttons on the
fighting stick are convex for that old-school look. Most of the buttons on
the controller are mappable, and are super-sensitive, making for an
even better experience.

The joystick moves into four pre-defined corners, unfortunately, and
does not have.a L |
rounded base, which™ X
would have allowed it
to move freely.

The Good: Retro, old-
school looks

The Not-so-much:
Doesn’'t come ina
wireless variation

Price: $35 (Rs 1,450)
Available at: http://
tinyurl.com/274hom
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SHADOW OF CHERMNOBYL
Redefining “Immersive”, evoking real
trepidation, and upping the bar is this

gem—based loosely on
Andrei Tarkovsky’s 1979 classic

122 DIGIT MAY 2007

repare for ,something, -different..
something ‘disturbing.... something
frightening... something gritty and so
utterly realistic, it’ll have you barra-
cading yourself armed with the best
weapon you-can find and a thousand rounds of
ammo. Everylittle sound has you whipping
around frantically. Was that a mutant dog
whining in the distance, a trick of the wind, or
something else?

Suddenly the bushes some 30 yards away
move. You hear a bloodcurdling growl: Your
vision blurs'as something dark'leaps-at you,
tearing at yout body with deadly claws. You
open fire blindly, stumbling backwards. Just
as the creature’s about to go down, you see-a
flash of brown to your left...

That, comrade, is just another moment in
S.T.A.L.K.E.R.—one of the most atmospheric,
immersive shooters I’ve played.

You'play the “marked one,” and courtesy a
nasty case of amnesia, remember zilch:about
your whereabouts.or even who you are. First
up you’ll'be given a mission from the traderin
the bunker you wake up in, and armed with a
peashooter (at first), you’re off.

The “zone” as it’s called is huge, and you’ll
spend hours traversing it on foot. You can stick
to the roads and paths; or feel free to explore
the countryside. But remember the zone lives
and breathes (just like you) and you’ll. come




e A

Rating:
9/10

Publisher:

THQ

Devéloper;

GSC
System.Requirements:
Pentium 1V 3.GHz,

1 GB RAM,
256:MBDirect X 9.0¢
ready graphics-card,
6-GB hard drive space

across - hostile: mutants', of ' .various
kinds, heavily-armed stalkers who’ll be
either neutral or-hostile, and various
deadly things-not to mention equally
lethal, highly radioactive zones:

This is where S.T.A.L.K.E.R. really
comes into its own. A first person
shooter | RPG, this game is the first-of
its kind. Its not about upgrading char-
acter stats, but improving your own
gameplay skills. The storyline revolves
around the main missions, although
there’s a'goodly dose of side'missions
in S.T.A.L.K:E.R. enough for some 40+
hours of gameplay. What’s unique is
the sheer freedom the 'game allows
you in pursuing the missions. There’s
never a feeling of being forced into a
particular mission, nor anylimita-
tions'on how you achieve your objec-
tives.

It’s the sheer eerie beauty of the
zone 'that. will ‘grab. you though.
Gnarled - trees, Tumbling  thunder-
storms with intermittent lightning
bolts, junkyards of dead vehicles, and
abandoned buildings in various states
of disrepair are all part of the eerie
atmosphere you’ll experience. You
have no friends except your gear, and
death is only an empty magazine away.

With the right kind of hardware,
S.T.A.L.K.EER. looks  absolutely ' stun-
ning. It has one of the most immersive
soundtracks I've ever.experienced. The
growls from mutants, rustles in bush-
es, the constant moaning of the wind,
among other- indefinable :ambient
sounds through the trees will leave
you .constantly on edge, just as the
developers intended.

Skirmishes with mutants and
rival stalkers are common, and
you’ll need to watch. yourself:
The Al is extremely nasty, with
enemies using cover as'intelli-
gently as you, ditto the tactics.
Some of the mutants lack Al
for the most, part, but they
more than compensate with raw
speed and agility.

While I'won’t spoil any more of the
plot; I can tell you the game has seven
different  endings—open-endedness
unlimited!

Will absolutely realistic weaponry
and damage models, ST.A.L.KER.is as
close to the real thing as you can: get:
Need a verdict? Play it! Right after a
system upgrade, of course...

michael_browne@thinkdigit.com



Almost Infamous

Digital Leisure | Game On

0 game has endeared itself
Nto us the way the Burnout

series has. Perhaps it's the
insane speeds. Or the rewarding
feeling (and points) you get when
you ' introduce opponents to the
friendly pillar on the corner of the
road. There’s that' sweet taste of
revenge as you descend from the
skies onto the bonnet of the -unsus-
pecting fool who thought he could
get away with taking you down. Ah,
good times...

It never occurred to us that
Criterion would try.and mess with
the near-perfection that was
Burnout: Revenge—they’ve added
a bunch of new

game modes

SR
Rating: 7/10
Price: Rs 2,499

I peveloper: criterion
kPlatform: PS2

== ['Publisher: Electronic Arts
_,_‘q_\fﬂ Distributor: Milestone Interactive
Contact: sales@milestone-interactive.com

) in Burnout:

Dominator,
but one of the
best features
has now been
disowned.
Traffic check-
/ ingis gone,so

Simple Joys For Simple People

e wonder if IR Gurus con-
Wsciously decided to forego
any sort of depth when

they made Heatseeker. This
arcade-style flight simulator (we
use the term loosely) gives you no
story to live through—well, nothing
worth mentioning, anyway—and
strictly average voice acting. What
you do get, however, is good, solid
adrenaline-enriched dogfighting
action in an aircraft of your choice,
including the beautifully destruc-
tive F-22 Raptor.

Heatseeker proudly touts the
Impact Cam, which follows your
missile right to the aircraft it’s
headed for, showing you the fate of
your victim in all its up-close and
slow-motion glory. If you like
watching big explosions unfold in
slow motion, this should feed your
appetite like your first meal after a
day-long fast. Trouble is, while

Rating: 7/10

Developer: IR Gurus

Publisher: Codemasters
Distributor: E-Xpress Interactive

you’re watching the impact cam in
glee, your aircraft switches to go-
straight-without-thinking mode,
meaning that you may well find
your bird headed for the water
when you get back. This can get
annoying after a while, especially
the fact that you enter impact cam
when you hold down your fire key—
taking you out of the action for
those few precious moments.
Wherever else Heatseeker
might fail, it doesn’t disappoint in
terms of action. You'll be met by
barrages of enemy aircraft, and you
get but a few seconds to breathe
hetween waves. In-flight effects like
afterburn are well-styled, and you'll
be playing the Top Gun theme in
your head in no time. Sink your
money into this one for mindless
entertainment, seen after a long
time in a flight sim.
nimish_chandiramani@thinkdigit.com

Contact: sales@e-xpressindia.com
Price: Rs 2,499
Platform: PS2

you can’t use the hapless- public
as pawns in your game of death
and destruction .anymore. Worse,
you have to avoid them! The glori-
ously destructive Crash mode
is gone as well. On the plus side,
you can now chain burnouts—
drive like -a ' maniac while boost-
ing, and you’ll get an ‘instant
boost recharge that will let you go
even faster. This is all as fun as it
sounds, but definitely tougher,
what with the going boom every
time you hit traffic bit. The overall
gameplay hasn’t changed enough
to warrant comment, other than
that we’re glad it all feels
the same.

Dominator looks amazing, and
is-a testament to the fact that the
old PS2 still haslife. For-someone
new to the franchise, it’s an-excel-
lent game to have; Revenge own-
ers, buy this only if you're bored
with the same old locations—it’s no
quantum leap ahead.

nimish_chandiramani@thinkdigit.com




Rating: 6/10

Publisher: SCE
Platform: PS3

Interactive

Developer: Game Republic

Distributor: Milestone

Digital Leisure | Game On

Ancient Japan Never
Looked So Good...

enji is another of those save-ancientJapan-from-the-
Gevil—demon—lord games; this one is based on the old

legend of Gaimaru Yoshitsune, a Samurai warrior,
and his battle against the Heishi clan, who have solicited
an assortment of demons to help them go about their
evil deeds. Beyond that, Genji’s story is marvellously incom-
prehensible.

You start as Yoshitsune, and once you meet the rest of
the characters in the game, you can switch to any of them
when you feel like it. Each warrior has a different fighting
style, and they come with their own strengths and weak-
nesses. Yoshitsune has the best balance between agility
and destructive power; Benkei is slow and lumbering, but
dishes out fatal damage to many enemies with a single
blow; Shizuka (the mandatory scantily-clad-butt-kicking-
babe) is weak, but her grappling-hooklike weapon can
attack enemies from a distance.

Aside from the beautifully rendered environments
and brilliant sound, the game is generally unremarkable,
but the combat won’t disappoint. Combo moves can be
devastating when done right, and you’ll be kept on your
toes with swarms of enemies, none of whom respect the
“attack one by one” rule that they do in movies.

When you’re not doing battle, you’ll have environ-
mental puzzles to solve, and this is the most frustrating
part of the game. The camera angle is fixed, so you can’t
survey your surroundings properly, which makes it that
much harder to find important hints or items.

In the end, Genji isn’t a must-have game, but it does
serve as an example of a well-executed one.

Fun In The Mud

Monster Truck Madness, only much, much
better. Your sole duty is to race a variety of
vehicles—dirt buggies, big rigs, motorcycles, and
everything in between—around Monument
Valley in the US, and try to enjoy the scenery
while you're at it. The game’s graphics are amaz-
ing—vehicles are immaculately detailed, and
damage modelling is quite impressive. While you
drive around the dirt tracks, your car | truck |
whatever will continuously get plastered with
mud and muck, and the overall effect is far
better than what we’ve seen in off-road titles
thus far. Locations are wonderfully rendered,
and it’s worth taking a plunge over the side just
to admire the scenery. When you’re not dropping
off the side, the tracks are quite challenging, too.
MotorStorm’s arcade-style gameplay is pure
fun, and we love the number of ways you can
blow up your vehicle. Bouncing around the track
too much? Kablooey. Take a cliff-side corner too
fast? Soar... (whee!)... kablooey. Run into the
wreckage of a kablooey-ed opponent? Kablooey.
Too much boost? Kablooey! It almost makes it
worth not winning a race. The game’s concept is
much like any other—win races to unlock new

Think of MotorStorm as something like

vehicles and
tracks, and
eventually
collect them
all. You don’t,
however, get to
choose your class
of vehicle—this is
probably the game’s
way of ensuring that
you’re either (a) not going
to stick to classes you’'re good

at, or (b) forced try out Rating: 7/10
every vehicle type—take Developer:
your pick based on Evolution Studios
whether you like this Publisher:
feature or not. SCE

One of the more inter- Distributor: Milestone
esting parts of MotorStorm Interactive

is the ability to use the
SIXAXIS controller as a steering
wheel in the air. While fun, it was a little raw in
the preview copy we were playing, with no
sensitivity adjustment, but the retail version
will let you tweak this. We expect it to be much
better then.
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Viruses—Literally!
Many Afghans switched off their mobiles as rumours
spread that a deadly virus could be caught by answering

calls from strange numbers. Supposedly, answering a
call from a strange number would cause blood to ooze
from the nose and ears, and one would die!

ARE PRESENTATIONS WORTH IT?

Less Power To The Point

f course Microsoft
O and Google rule the

world, but little
things here and there keep
reinforcing the fact. Take
this for instance: a not-overly-
famous researcher at the
University of New South
Wales publishes a not-so-
groundbreaking paper on
cognition, and it gets heavily
publicised. Just because
Professor Sweller said, “The
use of the PowerPoint
presentation has been a
disaster. It should be
ditched.” Note the use of the
word “PowerPoint”; he didn’t
use the generic
“presentation application.”
He did what’s not done:
criticise the use of a
Microsoft product.

To begin at the
beginning: Prof John
Sweller—who specialises in
cognitive research—
theorised and discovered
that people cannot digest
information properly when

i My Desktop

Last month’s winner is
Dr Shivam Maini, Kanpur
How he did it:

1. Hack uxtheme.dll to change the start menu

2. Crystal XP icons
3. Classic window view for explorer

4. Bluecurve 4.3 theme from Belchfire
5. Digital Timepiece 3.0.94 for the clock

6. Bash and Vim for Windows

...and this completes his uncanny Linux

obsession. Congratulations!

Participate in this contest
and win next month
Amazon.com MASHUPS
by Francis Shanahan

Published by

WILEY-INDIA

it comes in two different
forms, spoken and written.
To quote the professor, “It is
effective to speak to a
diagram, because it presents
information in a different
form. But it is not effective
to speak the same words
that are written, because it
is putting too much load on
the mind and decreases
your ability to understand
what is being presented.”
Come to think of it, why
do people present something
on a projected screen and
reiterate it by saying the
same thing? What’s the Point
(pun very much intended)?
It’s probably (to the best of
our understanding) what is
known in educational circles
as a pedagogical device that
relies on reinforcement.
Sweller is now saying that it
doesn’t work, and that it
should be done away with.
It’s been done for so long
now, preparing neat
PowerPoint slides and
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Free Cab Rides For Londoners

Microsoft is running a scheme for London workers
who live in Tube zones 1 and 2; commuters will be
able to catch any cabs—for free—that are labelled
with the Microsoft Office logo between 7:30 and 9:30

in the morning. Go figure!

delivering spiel. Think of
that oft-repeated phrase, “I
need to deliver this
presentation”. Nice, bulleted
points. Fonts. Heading styles.
Borders. Etc. And all for
naught? That’s exactly what
Sweller is saying. Imagine all
the (implied) lost
productivity; and imagine
the idea that there’s not
much Power in the Point
after all. (We couldn’t resist.)
OK, so this is just one
professor’s work, but what if
the idea were to gain
momentum... would it mean
the end of all those fonts
and bulleted points? The end
of the way execs and their
minions do things every
boring business day?
Perhaps we’re putting
our feet in our mouths,
because we’re toying with
the idea of a Fast Track to
PowerPoint... OK, so we’ll tell
you the trick: do use the
fancy fonts and all! They’ll
get the Point across! Just
don’t bother speaking when
the slide is on! Save your
breath and don’t mess with
the cognitive faculties of
your captive audience...

Send in your Desktop with a description of how you
made it to mydesktop@thinkdigit.com with the subject
“My Desktop”, and tell us your postal address, too.

Whatever
Happened To...

iSmell

ew products literally

stink, but this one did—
or at least it would have,
had it progressed beyond
the prototype stage.

In 1999, DigiScents Inc.
developed a concept called
iSmell, which allowed
folks to get their
noses as involved in
their Web
experience as their
eyes and ears.

The iSmell
Personal Scent
Synthesizer
was a
shark-
fin-
shaped
gizmo that
plugged
into a USB Scent Synthesizer
port and
wafted appropriate scents
as you browsed smell-
enabled Web sites—like
Flowers.com, as a typical
example. But sceptical users
turned up their noses at the
idea, making the iSmell the
ultimate in vapourware.

The idea is just plain
silly: imagine being not
only assaulted by horrible
MIDI files and pop-up ads,
but also wafting aromas on
the Web!

If you know the Web at
all, you'd know this was a
frightening prospect.
Imagine going to the Jockey
underwear site and... well,
you get the drift!

We're also not sure what
DigiScents was thinking (or
smoking) when they came
up with the name: no-one
would want to say “iSmell”
out loud...

The iSmell Personal
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DigiPick

“A different CRT lamp”

Last month’s winner is

Harshdeep Singh
Punjab

Participate and win next month

Web Design
A Complete
Introduction
by Nigel
Chapman and
Jenny Chapman

Published by
FWILEY-INDIA

WIN!

Send in your entry and you could win an exciting gift just by sharing an amusing picture with a tech angle
to it. The picture should have been shot by you, and should not have been published anywhere earlier. E-
mail your picture with the subject “DigiPick” and your postal address on or before the 20t of this month
to digipick@thinkdigit.com. One prize-winning picture will be published each month.

MAN-TO-MAN

Bots To
Target Bots

efense technology—we
Dspell it with an “s”

because it’s mostly
about America—is
ridiculously advanced.
Blame it on American
paranoia. We learn from
http;://tinyurl.com/2pw3fv
that “Arleigh Burke” AEGIS
ships can track aircraft to
about 180 km, and can shoot
them down even when
they’re up to 4,000 km away,
with remote ship-based
missiles. That’s much more
than the north-south spread
of this country. The AEGIS
system, if we understand it
properly, targets things that
come at them too fast.
Google “AEGIS defense ship”.

We’ve veered off topic a

little: our point is, more and
more people in diverse
countries—the UK and South
Korea, for instance, and now
America—are preparing
papers on how robots (and
automated systems) should
behave with flesh-based
beings. At http://tinyurl
.com/32b6wm is a PDF

called “Concept of
Operations for Armed
Autonomous Systems,” the
latest. John S Canning, an
engineer at the Naval
Surface Warfare Centre,
Dahlgren Division, a
weapons research and test
establishment, is aiming
there to dictate how possibly
robots could be told to only
target their ilk.

You saw this coming:
how did Asimov’s Three
Laws of Robotics get
expanded into an entire
PDF? Well, for one, the Laws
are simplistic. Not suitable
when you have systems as
advanced as today’s.

The upshot of the
proposal—refer the PDF if
you have the patience—is
that robots should decide for
themselves when to
annihilate the enemy, only if
that enemy consists of
robots. Flesh, blood and
bones should be spared—or
at least, a human should be
consulted when it comes to
that. Quoting Canning, “Let
machines target other
machines, and let men
target men.” Problem is, how
can the bots distinguish?

Another proposal: “We
can equip our machines
with non-lethal

technologies for the
purpose of convincing the
enemy to abandon their
weapons prior to our
machines destroying the
weapons, and lethal
weapons to kill their
weapons.” Kill their
weapons? Canning is
referring to the bots, we
presume. A related proposal
is that only machines
should be targeted, and if
humans are killed in the
process, it’s collateral
damage. Meaning that,
faced with a man wielding
an AK74, a bot should only
target the weapon and try
to spare the soldier.

It’s all very idealistic, and
the problem remains: how
can a bot distinguish? Not
conceptually difficult:
analyse the target for the
presence of DNA and RNA.
But are we there yet? Or, can
we throw Al at the problem?

Seen from a different
angle, why would one even
want to distinguish? Doesn’t
the military want to kill
gun-wielding soldiers?
Canning’s proposals are
probably trying to push us
towards the ideal of pure
machine warfare, with no
destruction of the stuff that
life is made of.

People Who

Changed
Computing

Dan Bricklin

VisiCalc was

the first ever

spreadsheet

program,

developed by []

ayoung man rr’?

named Dan b M e o
Bricklin. The Dan Bricklin
importance

of this development cannot
be overstated: VisiCalc is
considered by many to be
the killer app that turned
the computer from a
hobbyist thing into
something that could
actually be used for
something productive! The
program was created in
1979 by Personal Software
(renamed VisiCorp) for the
Apple II, fuelling the use of
the Apple II as a useful tool
for business.

Bricklin toyed with the
idea of creating a program
with keyboard calculator to
punch in a few numbers
and circle them with the
then-new invention called
the mouse to derive their
sum. The first version of
the program had rows and
columns and some
arithmetic, but didn’t
scroll. It became an instant
success for its usability
both in businesses and
households to automate
financial management.

He was born to a family
of printers, graduated from
MIT in 1973, and joined
Digital to create programs
for typesetting systems—a
fitting profession for a
printer’s son! He joined the
MBA programme in
Harvard to get the
necessary training to set up
his own small business.
During his first year, he
decided to sell his new
calculating program door-
to-door for people to make
financial forecasts!

Over time, Bricklin has
come to be considered a
revolutionary figure. Excel
is something we take for
granted, but now you know
how it began.
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Connectors

There’s quite a bit of hype on
about CAS, digital TV, and
such. With these coming into
the picture, TV companies
are pushing for better
connectivity standards.
Things can get pretty blurry
with the new lingo they’re
throwing at you. So go ahead,
mug up the following, and
you’ll sound reasonably
intelligent...

Composite: This connectivity
standard was the most basic
analogue link between a
video signal source and a
display.

S-Video: Better than
composite video, because it
separates the white level and
colour information.

Y-Pr-Ph: A standard that was
used on most DVD players;
they had red, green, and blue
colour-coded connectors
capable of very high
resolutions. However, these
are slowly being phased out
in favour of digital
connectors.

DVI: This can either be a digital-
only connection or a
combination digital and
analogue connection capable of
high-resolution 8-bit RGB video.

S/PDIF: An interface for
transferring digital audio
from CD and DVD players to,
say, amplifiers or TV sets.

HDMI: A connectivity
standard that features high-
resolution digital video and
digital audio capabilities,
used in many DVD players
with upward conversion to
HD resolution.

Usage: Watching Rang De
Basanti on my new plasma TV
is fantastic, thanks to HDMI.
Things are now so much
better than with the DV/ or Y-
Pr-Pb used in older-
generation DVD and VHS
players! And, of course, S-
Video and Composite are so
last decade!

Wild Wild Wi

The Waste Pipe

t's a little late in the day to be

telling you about Google’s
annual April Fools’ joke, but
they—like this one—are timeless
(in the sense of the link always
being there), so here goes. This
one isn’t timeless in the sense
of “priceless”: we thought it
was more than a tad lame. On
The First Day of April appeared
a link on the Google homepage
leading to a site claiming to
offer consumers high-speed
wireless Internet service
through their home plumbing
systems.

The “service” was named
“Toilet Internet Service
Provider,” and there was also a
“press release” with statements
attributed to Ubergoogler Larry
Page. To mention one: “And

SPRING CLEANIN

O’Really?

an the Web be cleaned
‘ up, made more

structured, made a
better place?

Mid-April, Tim O’Reilly,
book publisher and one of
the coiners of the term
“Web 2.0”, and Jimmy
Wales, Wikipedia creator,
met up and began working
on creating guidelines that
would make online
discussions more civil. One
of their recommendations
is that bloggers be allowed—
without being blamed of
censoring things—to delete
offensive comments on
their blogs. This is just after
a rather freakish incident:
Kathy Sierra, a technology
book author received death
threats as comments on her
blog. The threats were
partly triggered by a dispute
over precisely what Wales
and O’Reilly are discussing—
whether it’s OK to delete
blog visitor comments. “F**
off, you boring slut”—or
something along those
lines—was one of the
comments. (Would you feel
you had the right to delete
such a reply?) This was

today our Toilet ISP team is
pleased to be leading the way
through the sewers, up out of
your toilet and—splat—right
onto your PC.” Splat?

Then there’s a silly picture
of a mother with a baby and a
commode in the background,
with a silly caption to boot:
“Want WiFi around? Just flush it
down.” www.google.com/tisp
has an installation guide for
installing TiSP through the
sanitation system of a
bathroom.

Pigeon Rank was amusing,
but this one falls as splat as
this silly joke.

Sniff ’em If You Can...
he tech reporters at the BBC
were a little more creative—
refer previous item—but only

followed by stuff about
wanting to see a noose
around her neck.

Right now, O’Reilly and
Mr Wales are talking about
segregating blogs into
categories, signified by
logos. Bloggers who do not
want comments would be
in one category; tech
bloggers who always cite
sources (as opposed to
writing random, rambling
posts) would be in another
category, and so forth.

Robert Scoble,
technology blogger of
Scobleizer fame, said the
rules “make (him) feel
uncomfortable”. He
followed with “As a writer,
it makes me feel like I live
in Iran.”

Apparently, they’re not
talking censorship. To
quote O’Reilly: “That is one
of the mistakes a lot of
people make—believing
that uncensored speech is
the most free, when in
fact, managed civil
dialogue is actually the
freer speech. Free speech is
enhanced by civility.”

But this is an
overreaction. One woman
blogger receives death-
threats, and they’re talking
guidelines for blog
behaviour?

just. Remember the forward
about using your monitor as a
webcam? This one didn’t go
much further than that. “Sniff-
Screen Technology,” they called
it, on April Fools’ Day: the
“BREAKING NEWS” (the caps
were on the BBC homepage)
was the launch of that
technology, which would let you
smell stuff on the screen.

It was a slideshow: a
picture of fetid-looking
(probably Greek) cheese, roses,
and Parisian perfume. Visitors
were asked to put their noses
close to the screen if they
couldn’t already smell the
aforementioned strong-
smelling things.

The thing is archived at
http://tinyurl.com/276c6j. Show
it to your grandmother.

Naturally, the words
“free speech” come to mind.
If it’s OK to write what you
want on a blog, why not the
same principle for replies?
Also, we think the proposed
idea of “categorisation” will
meet with nothing short of
hostility.

It’s not clear what
Wales and O’Reilly are
thinking in terms of
implementation. The Web
cannot be policed, or even
“formalised,” as it were.
Sure we’d all like a cleaner
Web, but it’s just not
happening. Then, forget
about blogs and think
about forums, and you’ll
get the drift. Wales cannot
properly police his own
Wikipedia, and he’s talking
about slapping rules on
the Web...

ENHANCED REALITY

Games Like
Movies?

here’s a little Flash-
Tbased game on the

Net right now called
Flow In Games
(http://intihuatani
.usc.edu/cloud/flowing)).
Here’s what one blogger
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Escape

has to say about it: “Flow In
Games has no real point.
There is no score, and there
doesn’t seem to be an end.
You control a deep-sea
aquatic type creature and
your mission is to eat stuff,
gracefully and for as long
as you can stand moving
your mouse. For a game
without goals, Flow In
Games is incredibly
addictive.” Why we’re
talking about it is that it’s
been created by Jenova
Chen and Kellee Santiago,
two independent
developers, who claim to be
“tapping new emotions
with their games.” They’'re
trying to give games the
range of emotions that
movies involve.

Chen says, “Right now,
video games are focused on
releasing anger and stress...
that’s really limited. If you
want a deeper
understanding of life, you
aren’t going to get it from a
video game.” Chen thinks
games should get down to
the business of “probing the
light and dark sides of
human emotion.”

Along similar lines,
Danny Ledonne, creator of
the controversial Super
Columbine Massacre—where

April, Come She Will

jjay “The Wag” Padaya got hitched

this month. Normally we would have
ribbed him in this space a few months
earlier, but he only told us after the deed
was done. He just disappeared for a
week—only Ed knew why, apparently—
and returned sans sweets, bearing news
and photographs of his nuptials. All of us
are sorry for him, because as is the custom
(which reflects life), the bride wears White

and the groom wears Black.

April is the beginning of the new
financial year, and naturally, we were all
thinking about our own finances. (Read: the
Annual Appraisal.) For the students
amongst you, an appraisal is where the
boss-man tells his boss-men how

his team had performed in

the past year (which he then

players take on the roles of
the Columbine shooters—
says, “I do not believe the
medium of interactive
electronic media should be
excluded from exploring
the sorrows and challenges
of the human experience.”
The phrase “Emotions in
games” sounds suspiciously
like something meant for
female gamers, but what
Chen and Santiago and
Ledonne are trying to say is
current games hardly

frowned.

also conveys to us, the lesser employees). So
there we were, each of us entering and then
exiting Ed’s office one by one, with either a
smile or a frown gracing the face,
depending upon whether Ed had smiled or

Asfaq (please don’t pronounce it wrong)
took the plunge and installed Ubuntu on
his computer, so you guys can now send us
more Linux questions. Actually, don’t—the

rest of us think he’s recompiling his kernel

DIGIT OIARY

encompass the spectrum of
the life-experience that
movies do. Sure, you have
FPSs, strategy games, role-
playing games, and more.
FPSs, for example, provide
outlets for emotions,
primarily those of the
violent kind. The others do
involve creativity of some
sort. But the point here is,
do they imitate life?

In some ways, yes. But
think of a movie like
American Beauty, or Requiem

more than he’s working.

And finally, in anticipation of next
month’s “Sixth Sense” issue, many of us are
sporting glassy-eyed looks—wondering
whether we have a third eye, wondering
whether we can do justice to the

task. But we’re sure we’ll pull
it off in the end.

for a Dream, and you’ll get
the drift of what they’re
talking about. Many
current games aim entirely
to remove you from reality.
Even simulation games put
you in a different world.
That might just change, if
Chen and Santiago have
gotten it right.

It’s difficult to imagine
what games of the future
will be like, but think about
the world of Second Life and
you might get an idea. H

A lot of people are
talking about the
Leopard release
delay, but does it
matter?

David Chartier doesn’t like the idea that Apple first delays a
release, then rushes on to release unfinished products.
David Chartier
http://tinyurl.com/2bpv69
Apple announces Leopard delays due to the iPhone
Apple has just issued a statement announcing that
Mac 0S X 10.5 Leopard has been delayed until
October. The reason? iPhone: “we had to borrow
some key software engineering and QA resources
from our Mac OS X team, and as a result we will not
be able to release Leopard at our Worldwide
Developers Conference in early June as planned.”
However, Apple will still be displaying a “feature
complete” version of Leopard at June’s WWDC event,
and will be giving beta versions for developers to
take home and help put the finishing touches on.
This is a pretty significant announcement,
especially considering that Apple has fallen under
criticism for... shifting their focus from computers to
consumer devices.

Is Leopard’s delay causing any extent of technological
difference to us?

lljitsch van Beijnum

http://tinyurl.com/2blgsk

Why the Leopard delay is a (somewhat) big deal
I always tell people that getting a Mac buys you much
more than just a computing device. Since | joined the

club nearly four years ago, Apple’s standard operating
procedure has been fairly consistent: don’t talk about
plans, and release products when they’re available, or
at least ready to be ordered. This strategy has two
important advantages: Apple gets to make a much
bigger splash in the media when it has something new,
and it avoids the Osbourne effect as much as possible,
as customers keep buying the old products blissfully
unaware that newer, better ones are on the way.

RSS is changing the rules of information distribution on the
Web. What’s the future?

Alex Iskold

http://tinyurl.com/2x9upz

The Future of RSS

...RSS usage has since spread beyond simple news
delivery. Companies like de.licio.us, Flickr and
YouTube added another dimension to RSS—i.e. they
made it an integral part of the Social Web (social
networking, photos, video, etc). Also, Google built
Google Base, its Craigslist competitor, entirely on RSS.
Other companies too are beginning to extend RSS,
sometimes with proprietary extensions.

In short, because of RSS ubiquity it is now a very
attractive delivery medium for all kinds of content.
However because the basic format is simple and
primitive, there is no way to encode semantics
without building an extension...
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Modder’s Delight

Dear Team Digit,

Wonderful work in your April issue:
building a Monster PC with scrap
materials. When I first saw the cover
page of the magazine, I thought it was
a just a picture; I noticed the word
“Mod-ify”, but couldn’t figure it out.
But when I turned to the page, I was
amazed.

Please correct me if I am wrong,
but I think the Monster PC is a SFF
(Small Form Factor) computer. The
whole CPU had been packed just inside
the monitor shell. I think there is very
little space for air vents, and working
for long hours won’t be possible, unless
with air conditioning.

I too had the idea of building SFF
computers, but not like yours. Your
Monster PC rocks!

S Pandian
Chennai

Dear Mr Pandian

We knew a lot of people would like the idea
of a case mod with all the components in a
CRT, and you're one of those proving us right!
Thanks very much for the compliments.

Our components were all stripped off a
normal ATX form factor PC (not SFF), and
cooling is not a problem because CRT
monitors have a lot of holes for air flow. We
found that one fan is enough to get the air
circulating. Dust, however, is another matter
altogether. Still, our modded PC runs cool, as
we knew it would, even before attempting the
mod. We're very particular about airflow and
cooling here at Digit.

— Executive Editor

Piracy Woes, Again

It’s really good to see people at Digit
influencing people against piracy.
Many are now shifting to freeware or
are buying the products. But I
sometimes feel that Digit and other
such tech magazines are somewhat

spreading piracy, when you people
provide us software like Adobe
Photoshop; it’s really easy for people to
download cracks for them—these are
barely 1 to 2 MB large—and the person
gets a Rs 42,000 software for free. It’s
really good on your part to provide all
those trials, but can’t something be
done about it?

Ketan Gupta

Via e-mail

Should you stop production of gold because
there’s been a burglary in a jewellery shop?
Should all countries stop producing guns
because they also lead to terrorists killing
innocent humans?

Let’s accept reality, Ketan: evil of all
kinds is here to stay—we need to make our
efforts to minimise it. We cannot stop giving
free trials on our discs. Our sole attempt is to
give people a flavour for the software, so that
people get to know what it’s all about. Our
intention is genuine, though, of course, some
people take undue advantage and thus abuse
the system.

Besides, even if we stop giving out trial
versions, the pirated software is all available
on the Net, round the corner in every
market—there are many options available to a
pirate. The only way to beat piracy is, first, to
have a conscience and value the efforts of
those who work to produce the software—and
second, to try and spread that point of view,
educating as many people as one can.

— Executive Editor

Gamerz Ahoy
You guys at Digit are awesome! The
quality of your magazine is
incomparable. Your Fast Tracks, CDs,
DVDs, and not to forget the magazine,
are the best in the world. I've got to
praise you for the exceptional hard
work you do in testing and reviewing
all those products within a month.
Could you include some more game
reviews in your mag? I'm an avid gamer...
Praveen Prakash
Via e-mail

We strive to be #1, Praveen, and thanks for
your kind remarks.

As for more game reviews—we’re going to
have to disappoint you here. We carry as
much as is feasible, considering what
proportion of our readership consists of
gamers like yourself. If you need more
reviews, all you need to do is pick up a copy
of SKOAR!, our sister publication—we're sure
you’'ll love it. Cheers, and game on!

— Executive Editor

The Omniscient Agent!

I bought my first Digit on the 17th of
September 2001 as a birthday present
for myself. Ever since then, I've been a
die-hard fan. Not only did you teach me
how to use technology to my benefit,
you’ve also taught me how to be safe
from its evil effects. It really hurts to
see all those MMS scandals floating
around the Net. Why can’t these
perverts/voyeurs realize that someone
else might be prying on them too?!
Putting up pics of unsuspecting people
doing their daily stuff is just insane!
Well, we can’t help it, but I know that
someone out there will always be there
to teach us ways to protect ourselves.
And that someone is You...

Who is Agent 001? I mean, what’s
his real name? Whatever it is, just tell
him that he’s mind-blowingly
awesome!! You know, I kind of envy
him a bit. (How does he manage to
know everything?!)

Anyway, someday I'll personally
come down to your office and thank
you guys—each and every one. You
won’t have any problems recognising
me. If a guy comes in shouting “Digit
Zindabad!!”, you’ll know it’s me!

Lots of Love, Respect, Appreciation,
Good Wishes, and more...

Kaushik Sinha
Silchar
Assam
Dear Kaushik,
We can’t tell you Agent 001’s real name—
that’s company policy! Just kidding—but in
any case, we’ll be waiting for you to come
and wish us a happy sixth anniversary. You
can then see him in person and ask him his
name, too! As for how he manages to know
everything, well, that’s why he’s special...
— Executive Editor

What About Me?

I must admit that Digit has indeed
increased my understanding about
technology to a very large extent, over
the two years that I've been reading it.
It has kept me informed enough about
the latest gadgets in the market.
However, I have a complaint. It’s about
the reader’s participation. Almost all
your articles are by different members
of your team. I would like to suggest
you to please increase reader
participation and reserve a few slots
(pages) in your motherboard (magazine)
for your readers where they can send
their own articles, tips, etc.
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Write to the Editor
E-mail: editor@thinkdigit.com

snail Mail: The Editor, Digit, D-222/2, Om Sagar Building,

MIDC, TTC Industrial Estate, Nerul
Navi Mumbai 400 706

Also, please include 3D designing
and programming in your super-hit
Fast Track series. Also, can you please
provide the latest Final Fantasy demo
on your DVD?

Anwesh Satpathy
Angul, Orissa

Dear Anwesh,

You’'re not the first to have hit upon the
suggestion of devoting a few pages to
readers—and looking at how many readers
are saying this, we just might create a
readers’ section. For now, you can use our
Forum (www.thinkdigit. com/forum) to
express yourself.

As for 3D designing and programming—
we will certainly be looking at programming
topics for the Fast Track series in the very
near future. Final Fantasy has many
versions, most of them for consoles. The
latest one, FFXIII, is still to be released, and
is being developed for the PS3.

— Executive Editor

The Next Level?
I'm a 2™ Semester BCA student from
Shillong. Last September was when I
began reading Digit. I used to read PC
World, and though Digit is higher in
price, I find it better. One thing I want
to request is, more FAQs, like how to
install Red Hat Linux or even Unix,
and so on. All of us readers aim to
develop our skills rather than just
enjoying what we know.

Maruata

Mizoram

We appreciate your feedback, Maruata—
thanks for the kind remarks! As for how to
install Linux distros, refer to our Fast Track
edition on Linux—if you don’t have that issue,
you’ll find the PDF on our December 2006
DVD. If you have a particular question or
issue, do e-mail sos@jasubhai.com.

— Executive Editor

The Other Side Of The Fence

Congratulations to all of you for giving
us the best IT magazine around! Now,
much attention has been given to
piracy and pornography, and little
attention is given to the backbone of
these ill tasks. The cyber cafe from
where [ am writing this mail costs me
Rs 40 an hour, only for looking at

the display screen and waiting for
minutes for the search engine and
browser to open a Web page, and then
writing a mail is the task of finding a

Digit will publish the best letters on these pages. Letters may be edited for clarity.

Please include your complete address in all communication.

For subscription queries, call the help desk at
022-27629191/9200, fax 022-27629164, or
send an e-mail to help@jasubhai.com

shadow in a treeless desert. Why so
much price for a speed of 56 Kbps,
or it may be less than this.

But unfortunately, students like me
can do nothing, but only wish for a
better future.

In metropolitan areas, even if
people are not able to access the Net
on broadband, they are still getting
a speed 60 times more than we rural
(Kashmiri) people are getting. I want
to know when will Internet be a
reality and not a dream. Digit is my
guardian!

I have lot to say, but
unfortunately, I've got only Rs 50 in
my pocket and I have been sitting
here for 65 minutes, and to defend
my respect I need to go...

Sayad Rashid
Anantnag, Kashmir

Dear Sayad,
It’s heart-warming to see the effort you've
put into reaching out to us.

People in the metros who have 2
Mbps connections want unlimited
connections; those with dial-up would
settle for 512 Kbps. People who get less
than 56 Kbps—like yourself—want speeds
to improve too, of course. Then, there are
those who would be grateful to have Rs 50
to spend in a cyber cafe, and others still
who would love to just have Rs 50, period.
It’s human nature to want more.

I'm not saying it’s a pretty situation,
but the fact is, you have access to a
computer, which many people can only
dream of... and | personally have this
dream of a wired India. We are an IT force
to reckon with in the global arena, and
the connectivity situation has got to
improve. Think about the cell phone
revolution that’s happened over the last
decade. Let’s hope the same happens for
Net access and PC literacy.

— Executive Editor

Corrigendum

In our March review of mid-range
mono laser printers, in the Digital
Tools section on page 72, what we
incorrectly referred to as the Xerox
Phaser 3120 is actually the Xerox
Phaser 3150. All other details are
correct. Any inconvenience this may
have caused is regretted.

Suggestions Galore

Dear Ed,

Hats off to your great

magazine, one that

covers chip-level
electronics to software
reviews, PlayStation games
to Photoshop, and all aspects
of IT, electronics and computer
science. I would like to share some
ideas with you:

[ We have not yet seen Fast Tracks to
Flash or 3ds Max. We would be
delighted with that.

[F A number of useful utilities and
software come with Digit every month.
But most of us don’t know how to start
with them. So I think it would be a
great idea to give a “Getting Started”
video with some of them, which your
team would easily make with screen
capturing software.

[} It would be great to see the Digit
Encyclopaedia again.

[} The starting interface of your DVDs
and CDs are brilliant, but it would be
very useful if you add a “Copy To”
Button to your pop-up menus.

[©] We do not know much about HD-DVD,
Blu-ray & HVD. If you publish a
detailed article (specially on their
writing technologies), it would provide
great knowledge to us.

[} Please include the e-mail IDs of whom
you publish letters.

[} More articles on robotics with pictures
of robots.

Thank you very much once again for
Digit, which teaches us the most of the
cyber world.

Arghya Chatterjee
Howrah

Dear Arghya,

Thanks for the suggestions. I'll address them

all. First, do expect a Fast Track on either

Flash or 3ds Max or hoth, in the near future.

About the videos on how to get started with

software, we would love to, time permitting.

We will try and have a few videos though.

Digit Encyclopaedia part 2? Let us mull
over that.

You can copy selected text by right-
clicking on it in the interface.

We have written articles on new-
generation discs—we’ll do more as and when
the topics become relevant. Ditto for robotics.

Finally, about e-mail addresses, we don’t
publish them because most readers wouldn’t
want them published.

In any case, I'm glad so many of our
readers—yourself included—have suggestions
for the improvement of our magazine.

—Executive Editor

DIGIT MAY 2007

137



Married... To The Console?

1. What

percentage { o b
of video game :
console owners i
in the US are
married?

a) 22 b) 46
c) 59 d) 71

Got an
interesting
question?

Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

Which popular band won
“Most Creative” in the first
YouTube Video Awards last
month?
a) Ask A Ninja
b) OK Go
¢) Kiwi!
d) Lonelygirl15

Which of the following is not
a two-way digital radio
standard for wireless networking?

a) ZigBee

b) Wi-Fi

) Bluetooth
d) GSM

Intel has named its add-in
Flash cache for notebooks
“Turbo Memory”. What was its
code-name?
a) Gibson
b) Santa Rosa
¢) Robson
d) Woodcrest

Which MS Office alternative
application is not offered in
Google Apps Premier Edition?
a) Start Page
b) Page Creator
c) SheetMaker
d) Docs & Spreadsheets

The number of iPods sold
recently reached what mark
(in millions)?
a) 75
b) 100
c) 550
d) 22

The UMD is the medium of
choice for the Sony PSP. Which
of the following is not true?
a) Blank UMD media is available
as consumable
b) No UMD writers are available to
the public
¢) A UMD can hold up to 1.8 GB
(dual-layer)
d) UMD media can hold games,
movies, as well as music

What is/are Netiquette(s)?
a) An unruly, explicit chat
session
b) Rules for polite behaviour on the
Internet
c) Styles and rules for making
Web pages
d) Tennis-like computer games

Which one of these games
was ranked the best selling
in 2006?
a) Elder Scrolls IV: Oblivion
b) New Super Mario Bros
¢) Fight Night Round 3
d) Madden NFL ‘07

What is the estimated
number of lines of code in
Windows Vista?
a) 1 trillion
¢) 1.9 billion

b) 15 million
d) 50 million

GUI-based WWW
browser and Gopher
client. It was developed in
1993 by Eric Bina and Marc
Andreessen (co-founder of
Netscape) at the National
Center for Supercomputing
Applications.
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ACROSS

Tomb Raider game (5)
8. Company founded by
Murthy (7)

used for navigation (5)

11.Short for Camera (3)

1. Lara------ —main character in the

4,------ capital-source of funding for
risk-oriented business (7)

9, -----| Map- SGML or XML document

10.Graphic or audio file used to change
the appearance of the user interface to
a program or for a game character (4)

12.Frame Reject (abbr) (4)
15.-----text- transmitted or stored text
and can be read by a word processor (5) (4)

16. Wall-hung, flat display screen 4, ----- Basic- Microsoft’s
television (6) programming language
19.Non-broadcast Multiple Access (6)

(abbr) (4) 5.----book- type of

that receives alert signals
and short messages (5)

DOWN

1. Small pieces of silicon
on which an integrated
circuit is embedded (5)
2.Condition of being
capable of but currently
not connected to a
network of computers or
other devices (7)

3. ----Bar-bar at the
bottom of the screen that
contains the Start Button

N. R.Narayana

April’'s Winner:
Sreenidhi B. S.
Basvangudi,Bangalore

Send in your entries to
TQ@thinkdigit.com on B
or by 20th of this month. ¥
One lucky participant will

By Thiru Thangarathinam
Published by

#WILEY-INDIA

Last Month’s Solution

osaic was the first Did \(0},1
Know

17.South Korean electronics
conglomerate(7)

18.Graphical interface for managing
files-synonymous with a directory(6)
20.Input pointing device that helps to
move the cursor on the computer
screen(5)

23. File Allocation Table(abbr)(3)
24.To make changes in a file(4)
25.Internet Fibre Channel
Protocol(abbr)(4)

21.X ----360- video game console (3) personal computer (4)

22.Desktop Management Task 6.-----case—capital letters (5)
Force(abbr) (4) 7. Microsoft’s digital multimedia
26,------| robin- taking turns in the encyclopedia(7)

arrangement of choosing all elements  13. Uniform Resource Locator(abbr)(3)
in a group in some order (5) 14. Ctrl- — -Delete- combination of
27.Instruction that a computer keyboard keys that helps to terminate
assumes, unless the user gives it other an application(3)

instructions (7) 15.0ne or a pair of modifier keys found
28. Same as Return key (5) on a keyboard- does not generate any
29.Small telecommunica-tions device  character(7)

Crossword by Nitta Jaggi
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People And Events That Grabbed The Headlines—For Better Or For Worse

Stomp, Stomp!

ichael Jackson—of “Black then White”
Mfame—is toying with the idea of a 50-foot
robotic replica of himself. The mega-
android could be used to promote M]J concerts
in Las Vegas.

“It would be in the desert sands,” said
Mike Luckman of Luckman Van Pier, a
consultant company to large entertainment
firms. “Laser beams would shoot out of it...
Michael’s looked at the sketches and likes
them.” Laser beams. Wowie. Cool. Super!

50 feet is tall. Come to really think of it,
it’s a horrifying thought—as if MJ’s face
weren’t horrific enough, they in Vegas will
now have this abominable creature

meandering through their desert sands?
And now, the ramifications: what if Ozzy
Osbourne were to get inspired...?

Well, Jackson probably wanted something
as large as his ego, and the android should do
the trick for him. We promise we’ll post the
picture in this space as soon as it’s

constructed and ready to fire its laser beams.

You.Suck.Exe

don’t—you’ve heard about the

halfIndian Sanjaya Malakar,
who for a mess of reasons was
propelled to somewhere near the
top on American Idol. Many fans of
the show were outraged, the
extreme being a MySpace blogger
known only as “]”. She went on a
hunger strike just because
Malakar sings so horribly
(opinions may vary), vowing to
continue it until Malakar was off
the show. Malakar outlasted her
fast: 16 hungry days later, ] dug
into her fridge.

If you have not heard about
Malakar, the idea is, he’s goofy.
(Check out YouTube for some
videos.) His singing is goofy, his
hairdos are goofy, his
mannerisms are goofy. (Again,
opinions may vary.) And all this is
putting people off American Idol.
They’re crying foul—even as
Indians are trying to convince
their great-aunts and brothers-in-
law to vote for the bugger.

What we’re reporting here is
the “Sanjaya War Dialer,” a piece
of software that made it easy to
vote over and over for Malakar.
(All you need is a modem.) The
idea was quite obvious: “Make
Sanjaya win and help us ruin
American Idol,” according to the
creator of the Dialer. In fact,

If you watch TV—or if you

there’s a lot of “Will Sanjaya kill
American Idol?” on the Web.

17th April, Malakar was
voted off the show. The dialler
happens to be still there at www.
kingofallnerds.com/sanjaya.
Turns out you can use the dialler
for voting for anyone—nifty.

Here’s the last post we saw
there: “It was a fun ride. We were
all part of something great. Life
won’t be the same without
Sanjaya. I think we’ve learned
that no technology in the world
can overcome that level of suck.”

“Level of suck.” Well-coined.
Has a nice ring to it.

“Never Been Phished”

ou won’t learn too much about tech
i celebrities except from pages like
these. We thought we’d share a few
titbits with you.

Vinton Cerf—the primary Founding
Father of the Internet, that’s why his
name sounds the same as “surf’—recently
visited the University of South Carolina to
meet up with students and tell them

about the challenges in the future of
computing. He revealed what a lot of us
were dying to know: what does he do on
the Internet? Mostly checking the weather
and news sites, he said. And when he’s
travelling, he checks exchange rates. No
sites specified.

Cerf uses his BlackBerry to settle
dinner disputes, such as what grapes are
in the wine his companions are drinking,
and to check if certain Hollywood actors
have died or are still living. He also
happens to be a wine connoisseur: his
home is reasonably wired, so he receives
e-mail warnings if the temperature of his
cellar goes above 18 degrees C.

Here’s one about Berners-Lee, Sir Tim,
the inventor of the WWW. One day he
spent with reporters a while ago saw him
more than a little miffed: he couldn’t
really defend how his pet Semantic Web

could be prevented from being bogged
down by search engine spam the way
Google is. At some point towards the close
of the session, he happened to mention
that he’d never been phished.

So the Greatest Living Briton has
never been phished. Good. That’s all we
wanted to tell you. Get back to what you
were doing...
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